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Preface

The Sun Management Center 2.1 User’s Guide provides instructions on how to use the

Sun™ Management Center system management solution. These instructions are

designed for a system administrator with networking knowledge.

Note – In the Sun Management Center software, all alarm messages are displayed

in English.

Using UNIX Commands

This document may not contain information on basic UNIX® commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook™ online documentation for the Solaris™ software environment

■ Other software documentation that you received with your system
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Typographic Conventions

Shell Prompts

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Command-line variable; replace

with a real name or value

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

MS-DOS Microsoft Windows c:\
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Related Documentation

Ordering Sun Documentation

Fatbrain.com, an Internet professional bookstore, stocks select product

documentation from Sun Microsystems, Inc.

For a list of documents and how to order them, visit the Sun Documentation Center

on Fatbrain.com at:

http://wwwl.fatbrain.com/documentation/sun

TABLE P-3 Related Documentation

Product Family Title Part Number

Sun Management Center Sun Management Center 2.1 Software
Release Notes

806-3168

Midrange Servers Sun Management Center 2.1 Supplement
for Sun Enterprise Midrange Servers

806-3198

Workgroup Servers Sun Management Center 2.1 Supplement
for Workgroup Servers

806-3207

Workstations Sun Management Center 2.1 Supplement
for Workstations

806-3199

Sun Enterprise™ 10000 Sun Management Center 2.1 Supplement
for Starfire Servers

806-1581

Sun Management Center Sun Management Center 2.1 Developer
Environment Reference Manual

806-3167

Sun Management Center Sun Management Center 2.1 Developer
Environment Release Notes

806-3169

Tivoli TEC Adapter Sun Management Center Tivoli TEC
Adapter Installation Guide

806-2071
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Sun Documentation on the Web
The docs.sun.com sm web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number of your document in the subject line of your email.
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CHAPTER 1

Introduction

This chapter provides an overview of the Sun™ Management Center version 2.1

product, its component layers, and how they interact with one another.

This chapter includes the following topics:

■ Sun Management Center Overview

■ Sun Management Center Architecture

■ Sun Management Center Concepts

■ Sun Management Center Monitoring Features

■ Sun Management Center Software Environments

■ Getting Started With the Sun Management Center Software

Sun Management Center Overview

Sun Management Center software is an open, extensible system monitoring and

management solution that uses Java™ software protocol and Simple Network

Management Protocol (SNMP) to provide an integrated and comprehensive

enterprise-wide management of Sun products and their subsystems, components,

and peripheral devices.
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Sun Management Center technology provides a solution to extend and enhance the

management capability of Sun’s hardware and software solutions.

Sun Management Center Architecture

Sun Management Center software comprises three component layers: console,

server, and agent. It is based on the manager/agent architecture, in which:

■ The console is the user interface which interacts with you to initiate management

tasks.

■ The server (manager) executes management applications and sends requests to

agents in order to perform management tasks on your behalf.

■ The agents (that are executing on the managed nodes) access the management

information, monitor local resources, and respond to manager requests.

The three component layers are depicted in FIGURE 1-1.

TABLE 1-1 Sun Management Center Technology

Feature Description

System Management Monitors and manages the system at the hardware and operating

system levels. Monitored hardware includes boards, tapes, power

supplies, and disks.

Operating System

Management

Monitors and manages operating system parameters including load,

resource usage, disk space, and network statistics.

Application and

Business System

Management

Provides enabling technology to monitor business applications such

as trading systems, accounting systems, inventory systems, and

real-time control systems.

Scalability Provides an open, scalable, and flexible solution to configure and

manage multiple management administrative domains (consisting

of many systems) spanning across an enterprise. The software can

be configured and used in a centralized or distributed fashion by

multiple users.
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FIGURE 1-1 Sun Management Center Component Layers

The major Sun Management Center layers and their functionality are described

below.

Console Layer

You may have multiple consoles, serving multiple users, for the same Sun

Management Center server. The consoles provide you with:

■ Visual representations of the managed objects (for example, hosts and networks)

■ The ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm thresholds)

■ The ability to initiate management tasks (for example, dynamic reconfiguration)

The Sun Management Center console layer is the interface between you and the

other component layers of Sun Management Center software.

Server Layer

The server layer accepts requests from you through the console and passes these

requests to the appropriate agent. It then relays the response from the agent back to

you.

Console Console

Server

Agent Agent Agent
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For example, if you want information on the number of users accessing a host, the

server layer receives this request from the console, and sends it to the agent on that

host. The agent finds the answer, sends it back to the server, which passes on the

information to you (through the console)

Similarly, if an error condition is created on one of the hosts, the agent on that host

sends notification of this error (an event) to the server, which forwards the

information to you (through the console) as an alarm.

In addition, this layer provides the console with a secure entry point to interface

with the agents.

The server layer includes five components (FIGURE 1-2):

■ Sun Management Center server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

FIGURE 1-2 Sun Management Center Server Layer
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Remote
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SNMP SNMP

SNMP SNMP
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 Server

Sun Management Center
server layer
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The server component is the core of the server layer. It is based on Java technology

and is multi-threaded, and it handles multiple data requests from various Sun

Management Center users.

Sun Management Center Topology manager provides services including the

management of user administrative domains and the topology layout of managed

objects.

The Trap handler is a centralized SNMP trap receptor that performs logging and

forwarding of traps to interested components. It is this server layer component that

is responsible for receiving all alarm notifications.

The Sun Management Center Configuration manager provides security services to

the server and the agents.

The Sun Management Center Event manager sends and receives event information

from the agents. These events can trigger alarms, which are forwarded to the

console.

Agent Layer

The agent layer performs the actual information gathering, monitoring, and

management of objects on the nodes managed by the Sun Management Center

software. The server layer interacts with the agent layer to gain access to the

managed objects by using SNMP.

Sun Management Center agents are scalable, extensible, and SNMP-based. They

monitor and manage objects including hardware, operating systems, and

applications by loading modules that focus on a specific aspect of the system, as well

as application health and performance.

The agents use rules to determine the status of the managed objects. When the

conditions specified by a rule become true, the software automatically generates

alarms or performs actions as specified in the rules.

Server Context

A Sun Management Center server context is defined as the server layer and the

agent layers. When starting the console, you log into a particular server context. The

managed objects whose agents send information to that same server also belong to

the same server context.
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A managed object can belong to the same server context or a remote server context.

(A managed object in a remote server context sends information to a different server

while a managed object in the same server context sends information to the server

host that is connected to your console.)

By default, the Sun Management Center software manages an object in the same

server context but only monitors an object in a remote server context. For a precise

definition of manage and monitor, see the Glossary. For more information on the

server context, see Chapter 15.

FIGURE 1-3 Console Logs Into a Server Context

Sun Management Center Concepts

The following concepts are fundamental to understanding Sun Management Center

software:

■ Administrative domains

■ Modules

■ Alarms and Rules

Note – In this document, “domain” refers to a Sun Management Center

administrative domain, and should not be confused with uses of the term “domain”

related to other Sun products or documentation. See Chapter 4 for more information.

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
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Administrative Domains

An administrative domain is a hierarchical collection of resources that you want to

monitor and manage. The resources can include a complete campus, individual

buildings, hosts, networks, subnets, links, and so on. Each administrative domain

may consist of these resources, which can be combined with other resources to form

groups within a administrative domain. Each of these groups may contain additional

groups of resources, providing a multilevel, hierarchical administrative domain.

You should create administrative domains based on your business needs. You can

create one or more administrative domains. For example, you may create a lab

administrative domain that contains all the lab machines. Similarly, you may create

an accounting administrative domain that contains all the machines used for

accounting.

The Sun Management Center software displays the administrative domain and its

members in a visual representation (FIGURE 1-4).

In the following example, the host, Payroll2 , belongs to the Building B group,

which belongs to the Payroll Servers 1 administrative domain.

FIGURE 1-4 Sun Management Center Main Console Window Showing an Administrative
Domain and Its Members

Administrative
Domain

Domain
members
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Modules

Unlike most agents, the Management Information Base (MIB) provided by Sun

Management Center agents is not implemented in a monolithic code that contains a

wide variety of functionality in a single program. Instead, Sun Management Center

software uses several components, called modules, for each agent. Each module

implements its own MIB. Therefore, the Sun Management Center agent MIB is the

cumulative total of all the modules and their individual MIBs (FIGURE 1-5).

FIGURE 1-5 Sun Management Center Agent MIB

Sun Management Center modules monitor and manage the resources of systems,

applications, and network devices.

The modules serve two purposes:

■ To monitor and notify you (through alarms) when error conditions occur

■ To monitor and notify you (through alarms) when performance tuning is required

For more information on alarms, see“Alarms and Rules” on page 8.

Each module consists of one or more properties that can be monitored on your

system. For example, one of the default modules loaded during installation is the

Kernel Reader. This module monitors kernel properties. These properties include

user statistics, disk statistics, file system usage, and so on.

Note – You can add or remove modules dynamically. This feature enables you to

customize the modules loaded on each agent (object), based on your need.

Agent

Module
C

Module
B

Module
A

Module
C MIB

Module
B MIB

Module
A MIB

Cumulative
agent
MIB
8 Sun Management Center 2.1 Software User’s Guide • November 1999



Alarms and Rules

Sun Management Center software enables you to monitor your system with alarms

of differing severities. The thresholds that generate these alarms are defined in the

modules. The software enables you to set the thresholds that trigger simple alarms.

For example, one of the properties of the Kernel Reader module is the number of

user sessions. The software enables you to set the threshold that generates the alarm.

For example, you may tell Sun Management Center software to generate a critical

alarm when there are seven or greater user sessions. Similarly, you may also tell the

software to generate only a cautionary alarm when there are five-to-six user

sessions.

Although the software is configured with default alarm conditions, you can set and

define your own alarm thresholds for simple alarms such as those based on the

simple rCompare (comparison) rule.

Complex rules also generate alarms. For example, one complex rule states that when

a disk is over 75 percent busy, the average queue length is over 10 entries and the

wait queue is increasing, then an alert alarm is generated. This rule combines three

conditions:

■ Percentage of the disk that is busy

■ Average queue length

■ Wait queue

Unlike simple rules, these complex rules are predefined and cannot be modified.

Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, the software notifies you through the main console

window, and with a message sent to a specified e-mail address. You can also write a

customized program that will notify you in other ways that an alarm condition has

occurred, such as sending a message to your pager.

For more information on alarms, see Chapter 13. For more information on rules, see

Appendix E.

Sun Management Center Monitoring
Features

Sun Management Center software includes the following monitoring features:

■ Autonomous Agents

■ Main Console Window

■ Hierarchy and Topology Views
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■ View Log

■ Applications

■ Hardware

■ Graph

■ Security

These are graphical user interface or GUI-based features, except for autonomous

agents. Security is both a GUI-based and command-line feature.

Autonomous Agents

Sun Management Center agents work autonomously by actively sampling key data

on host systems. These agents can be polled through SNMP get requests for the

current status of the monitored data.

When an agent gathers data for a monitored resource, it checks the data against the

alarm threshold set for the resource and determines whether the data values

constitute an alarm condition. If the monitored data meets the alarm threshold, the

agent performs the action associated with the alarm condition. Agents send

asynchronous messages (SNMP traps) to the server, which delivers notification of

the change in the status of the monitored data.

Main Console Window

Sun Management Center software provides a main console window to depict,

monitor, and interact with your system. You can monitor multiple administrative

domains, spanning different locations, through multiple console windows.

Hierarchy and Topology Views

Sun Management Center software offers both hierarchy and topology views (for

every administrative domain) and hierarchy and contents views (for every object).

The hierarchy enables you to navigate through the administrative domain or host to

find the object of interest. The topology view or contents view displays the members

of the object that is selected in the hierarchy.

For an administrative domain, the hierarchy and topology views are displayed in the

main console window. In addition, you may customize the administrative domain

topology view by adding a background or creating a connection between objects in

the administrative domain.
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For an object, the hierarchy and contents views are displayed in the Details window.

The Details window consists of a series of tabs; the tabs are dependent on the type of

object. For example, a typical host object contains the following tabs: Info, Browser,

Alarms, View Log, Applications, and Hardware. The View Log, Applications View,

and Hardware tabs are described briefly below.

View Log

The view log tab button enables you to view informational messages, including error

messages, about your host.

Applications

This tab enables you to view and select detailed information about processes

running on the selected host or node. If you have any custom or third-party

applications installed, this tab also enables you to view detailed information about

processes running in the selected custom applications or third-party applications.

The displays are continually updated.

Hardware

The physical view available from the hardware tab provides you with photo-realistic

front, back, and side views of the host. With your mouse button, you can click on

individual components of the host and see detailed information about that

component. For example, you can click on a board in a server, and see detailed

information about that board, such as CPUs, memory, and board temperature.

Note – Physical views are only available for some hardware platforms.

Sun Management Center software also provides a logical view of the overall

hardware configuration of the host. Like the physical view, you can click on a single

component and obtain detailed information about that hardware component.

Note – Logical views are only available for some hardware platforms.
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Graph

Sun Management Center software enables you to create a two-dimensional graph of

any monitored data property that has a numerical value.

Security

The Sun Management Center security feature authenticates user login and access

control privileges for users and groups. It enables users to set security permissions at

the administrative domain, group, host, and module levels.

You can restrict access by setting different permissions. For example, one group of

users can see and modify properties on a host while a second group of users can

only see the host (with no modification privileges).

You can access Sun Management Center security features from the Attribute Editor

within the software.

Sun Management Center Software
Environments

Sun Management Center software may be deployed in two different environments:

■ production environment

■ developer environment

The production environment is an “active” or “real” environment in which you

manage and monitor your hardware, including subsystems, components, and

peripheral devices.

In contrast, the developer environment is a “test” or “demonstration” environment in

which developers can test customized modules designed to work with the Sun

Management Center software. While the developer environment may appear to be a

production environment, its sole purpose is to serve as a “demo” environment for

developers to create Sun Management Center modules. For more information on

developer environments, refer to the Sun Management Center 2.1 Developer
Environment Reference Manual.
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Getting Started With the Sun
Management Center Software

Note – For additional documentation describing new functionality, refer to the Sun
Management Center Software Release Notes, which is located on the Sun Management

Center web site: http://www.sun.com/sunmanagementcenter and on the Sun

Management Center 2.1 CD.

Sun Management Center supports multiple hardware platforms. Refer to the Sun
Management Center Configuration and Deployment Guide on the Sun Management

Center web site for more information on the supported hardware platforms: http:/
/www.sun.com/sunmanagementcenter .

This Sun Management Center 2.1 Software User’s Guide describes the software

functionality that is common to all the supported hardware platforms while

platform-specific information is included in the supplements. For example, Sun

Management Center functionality specific to the SPARCserver™ 1000 and 1000E, the

SPARCcenter™ 2000 and 2000E, and the Sun Enterprise™ 6x00/5x00/4x00/3x00 is

contained in the Sun Management Center 2.1 Supplement for Sun Enterprise Midrange
Servers. This supplement is located on the Sun Management Center web site: http:/
/www.sun.com/sunmanagementcenter and in the Sun Management Center 2.1

CD.

Note – For complete information on how you can use the Sun Management Center

software to manage and monitor your machines, read both this user’s guide and the

hardware supplement applicable to your machines.

After installing Sun Management Center software, spend some time navigating

through the various windows and testing their functionality. By exploring and

testing the software, you will have a better understanding of how you can customize

Sun Management Center software to aid in your system monitoring. See

Appendix A for more information.

If you prefer to set up your monitoring environment now, see Chapter 15 for

information on security.
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CHAPTER 2

Preparing to Install the Sun
Management Center 2.1 Software

This chapter describes the requirements your system must meet prior to installation

of the Sun Management Center version 2.1 product on your system.

The following topics are discussed in this chapter:

■ System Requirements

■ Sun Management Center Agent Supported Systems

■ Supported Operating Environments

■ Sun Management Center Compatibility

■ Installation Packages for Solaris Environments

■ Pre-Install Information

■ To Resolve the SNMP Port Conflict

■ Uninstalling the Sun Management Center Software

■ To Remove Sun Management Center Software From a Solaris Environment

Note – Sun Management Center software limitations and bugs are listed on the web

at http://www.sun.com/sunmanagementcenter .

System Requirements

Note – You must have at least 128 MBytes of RAM available to run the Sun

Management Center console on your system. The default maximum heap size for the

console and server is 64 MBytes each. You can customize the maximum heap size for

either the console or server as described in “Starting the Sun Management Center

Software” on page 44.
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The Sun Management Center installation script enables you to install the console

layer, the server layer, and the agent layer separately or together. TABLE 2-1 lists the

minimum disk space requirements for the three layers.

Note – If you are installing all three layers on one machine, you must have a

minimum of 50 Mbytes of disk space available. This is not the sum total of the disk

space requirements for the individual layers, as the layers share some common

packages.

Note – Depending upon your system, disk space requirements may be different.

Refer to the Sun Management Center Configuration and Deployment Guide on the

following web site for more information on Sun Management Center disk space

requirements: http://www.sun.com/sunmanagementcenter .

Protecting Customized Scripts

If you customized the email.sh script that Sun Enterprise SyMON™ software uses

to send email notification of alarm conditions, that script will be overwritten when

you upgrade Sun Management Center software to version 2.1.

To avoid overwriting the custom modified email script, rename the script. Here is an

example with the name “Edith.”

TABLE 2-1 Minimum Disk Space Required for the Sun Management Center Installation

Layer Minimum Disk Space Required (Mbytes)

Server 45

Agent 25

Console 25

# mv /var/opt/SUNWsymon/bin/email.sh /var/opt/SUNWsymon/bin \
/edithemail.sh
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Sun Management Center Agent
Supported Systems

For the latest information on supported hardware platforms, go to the following web

site: http://www.sun.com/sunmanagementcenter . The Config-Reader module

is required for hardware configuration information.

The Config-Reader and the Dynamic Reconfiguration modules are not supported on

all Sun hardware platforms. All the other core Sun Management Center modules are

supported on Sun hardware platforms. For more information on core modules, see

Appendix C and Appendix D. For more information on supported hardware

platforms, go to the Sun Management Center web site and read the Sun Management
Center Configuration and Deployment Guide.

Supported Operating Environments

For supported Sun Management Center 2.1 operating environments, refer to the Sun
Management Center Software Release Notes.

Sun Management Center Compatibility

Version 2.1 of Sun Management Center software is compatible with:

■ Any simple network management protocol SNMP V1, V2c, and V2usec entities,

regardless of the operating environment and architecture

■ Solstice Enterprise Agents™ of Solaris 2.6 and 7 software can be converted to

subagents of the Sun Management Center agent

■ Version 2.x of Sun Enterprise SyMON software

Sun Management Center software does not offer:

■ Backward compatibility with the Solstice SyMON™ 1.x software

■ SunVTS™ support in the Sun Management Center 2.1 software
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Sun Management Center Component Layer

Compatibility

There are three supported combinations of the Sun Management Center and Sun

Enterprise SyMON component layers, as shown below:

Installation Packages for Solaris
Environments

By design, Sun Management Center software is an open and extensible system

management tool, and the packaging and installing of this product reflects this

extensibility. The Sun Management Center product is divided into a core set of

packages, and a set of add-on components. Although this distinction exists, the

installation and setup of all Sun Management Center software (including add-on

components) is done with a single command as described in the following sections.

Note – Sun Management Center software can be installed in any location on your

system where the minimum required disk space is available. The default location for

package installation is /opt .

Core Packages

The core packages provide the fundamental layers, such as console, server, and

agent. In addition, the core packages provide architecture-specific support for the

SPARCserver™ 1000 and 1000E, the SPARCcenter™ 2000 and 2000E, and the Sun

Enterprise™ 6x00/5x00/4x00/3x00 systems.

TABLE 2-2 Supported Combinations of the Sun Management Center and Sun
Enterprise SyMON Component Layers1

1. 2.0 and 2.0.1 refer to Sun Enterprise SyMON software. 2.1 refers to Sun Manage-
ment Center software.

Console Server Agent

2.0 2.0 2.0

2.0.1 2.0.1 2.0/2.0.1

2.0.1/2.1 2.1 2.0/2.0.1/2.1
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TABLE 2-3 describes the core packages provided with the Sun Management Center 2.1

software.

These packages are located on the Sun Management Center 2.1 Software CD or the

Sun Management Center web site :

http://www.sun.com/sunmanagementcenter

To install these packages, see “Pre-Install Information” on page 20” and “Installing

the Software on Your System” on page 28.

TABLE 2-3 Sun Management Center 2.1 Core Packages

Package Name Description

SUNWescon Console package

SUNWesagt Agents package

SUNWesmod Agent modules

SUNWsycfd Config-Reader module for the core Sun Management Center product1

1. The Config-Reader module for the core Sun Management Center product supports the SPARCserver 1000 and
1000E, the SPARCcenter 2000 and 2000E, and the Sun Enterprise 6x00/5x00/4x00/3x00 systems. Config-Reader
modules for other hardware platforms are included in the platform-specific add-on components.

SUNWesdb Database

SUNWescom Common Components

SUNWenesh English help

SUNWfresh French help

SUNWdeesh German help

SUNWitesh Italian help

SUNWesesh Spanish help

SUNWjaesh Japanese help

SUNWkoesh Korean help

SUNWhesh Traditional Chinese help

SUNWcesh Simplified Chinese help

SUNWesjp Additional Components

SUNWessrv Server

SUNWessa Server/Agent

SUNWesae /etc files needed by the Agent

SUNWesse /etc files needed by the Server
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Add-on Components

Depending on the hardware platform on which you are installing Sun Management

Center software, your system may require additional add-on platform-specific

components. These add-on components, described in the Sun Management Center 2.1
Supplement for your hardware platform, provide additional functionality such as

support for other Sun hardware architectures or new agent management.

Note – Always read your Sun Management Center 2.1 Supplement for

architecture-specific installation instructions before installing Sun Management

Center software on a particular hardware platform. Refer to the Sun Management

Center 2.1 CD or go to the following web site:

http://www.sun.com/sunmanagementcenter

and click on Documentation for the supplement.

Add-on components are released in one of two ways:

■ as part of the Sun Management Center distribution (CD or web download image)

■ separately (add-on component only)

If the add-on components are part of the Sun Management Center distribution, the

add-on components are installed during the installation process. The core

components are installed first, followed by installation of the add-on components

that are part of the distribution.

Many add-on components offer architecture-specific support. Because of this, the

installation checks your hardware. For example, if an add-on component package

supports workstation systems, the workstation package is automatically added

when Sun Management Center is installed on a workstation host. In some cases, user

confirmation is required prior to installing an add-on component package.

If the add-on component is released separately, the add-on component will include

installation instructions.

Note – Refer to your supplement for more information.
20 Sun Management Center 2.1 Software User’s Guide • November 1999



Pre-Install Information

The following table briefly lists some of the pre-requisite information that you

should have before installing version 2.1 of Sun Management Center software.

Note – Sun Management Center software can be installed in any location on your

system where the minimum required disk space is available. The default location for

package installation is /opt .

TABLE 2-4 Issues to Consider Before Installing Sun Management Center Software

Issue Description

Removing old packages Make sure to remove all the Solstice SyMON 1.x packages. For

example, the following packages must be removed: SUNWsye,
SUNWsym, SUNWsyrt , SUNWsys, SUNWsyu, SUNWsyua, SUNWsyub,
SUNWsyuc, SUNWsyud, SUNWsyue, and SUNWsyuf. For more

information, see “Uninstalling the Sun Management Center

Software” on page 24.

Component layers you

want to install

Decide which component layers you want to install - Server,

Agent, Console, and Help.

Space needed in

/opt
Make sure you have enough space available in /opt . If not, make

more space or make a soft link to an area with more space from

/opt/SUNWsymon . For more information, see “Where to Install

Sun Management Center Software” on page 29.

Permissions Make sure you have permissions to write into the /var/opt (or

/opt/SUNWsymon ) directory as superuser. You also need

privileges to type commands, such as chmod, in that directory.

Set up Component layer(s) you want to set up are: Server, Agent,

Console. Component layers that have been installed must be set

up.

Information needed for

server

Note that when you install the server, you do not need to have the

console on the same machine. Also, it helps if you have

information on the following items: license key for the software,

ports to be used, and password to be used (referred to as a seed).

Information needed for

agent

Seed (password) to be used. Sun Management Center server host

if server is not installed on agent machine.
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Port Conflicts with SNMP Legacy Agents

Sun Management Center software may conflict with port numbers that are used by

legacy subagents. Systems with Solaris 2.6 or Solaris 7 operating environments have

two potential conflicting processes in the following areas: snmpdx and mibiisa .

If you install the software using standard defaults, you may run into port conflicts

with these processes and be unable to start the agent. The setup process notifies you

if there is a problem. Here is an example:

If you choose to use a different port number, the following prompt is displayed:

Information needed for

console

None.

Information needed for

add-on components

Add-on dependent data. For more information, refer to your

supplement.

Online help Decide whether to set up Sun Management Center online help on

a remote machine.

-------------- WARNING -------------------
It appears that agent.snmpPort 161 is already is use.
Sun Management Center agent may not be able to run due to this
conflict.
There are two ways to correct this conflict:
1. Reconfigure the port that Sun Management Center uses.
2. Stop the process that is using the port.
You are currently running snmpdx, which may be causing the
conflict.
Do you want to use a different port number for agent.snmpPort?
[y|n|q]

Please enter any port greater or equal to 1100: x
Updating /var/opt/SUNWsymon/cfg/domain-config.x with new port
number.

TABLE 2-4 Issues to Consider Before Installing Sun Management Center Software

Issue Description
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Caution – If you choose to correct the port conflict by stopping the process that is

using the port, remember to do so before the Sun Management Center agent is

started. If the Sun Management Center agent fails to start correctly, refer to the

agent.log file to see if there is a port conflict.

Note – View the log file with the command:

/opt/SUNWsymon/sbin/es-run ccat /var/opt/SUNWsymon/log/agent.log .

The log file displays error messages similar to the following:

▼ To Resolve the SNMP Port Conflict

● Make one of the following changes.

■ Change the port numbers used by the Sun Management Center software, as

described in“Port Conflicts with SNMP Legacy Agents” on page 22 or

“Configuring Sun Management Center Software to Use Different Port Addresses”

on page 330.

■ Turn off snmpdx and mibiisa by completing the following two steps:

a. Turn off snmpdx and mibiisa by using the following command:

b. Prevent snmpdx and mibiisa from starting the next time the machine is booted
to avoid conflicts. Rename the start-up script with the following command to
prevent the snmpdx and mibiisa daemons from starting the next time the
machine is rebooted:

In addition to these two processes (snmpdx and mibiisa) , your system may

have other legacy SNMP agents utilizing port 161. Therefore, you need to take

action to resolve this port conflict with the Sun Management Center agent.

error Nov 05 13:24:59 agent parsing error in base-agent.x(132):
error creating interface: inet://:161/udp: address already in use
error Nov 05 13:24:59 agent *** aborting execution ***

# /etc/rc3.d/S76snmpdx stop

# mv /etc/rc3.d/S76snmpdx /etc/rc3.d/s76snmpdx
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Note – For more information, see “Configuring a Legacy SNMP Agent as a

Subagent of a Sun Management Center Agent” on page 326 and “Configuring Sun

Management Center Software to Use Different Port Addresses” on page 330.

Uninstalling the Sun Management
Center Software

We suggest that you delete previous versions of Sun Management Center software

from your system before you install a newer version on the same server. In some

cases, previous versions are un-installed for you. Refer to the following table to see

how this might affect your site:

If you must manually remove previous versions, the uninstall program

(es-uninst ) removes all packages that are part of the Sun Management Center

software, including the add-on packages.

Note – If the Sun Management Center software already replaced an earlier

independent installation of the configd package SUNwsycfd , then this package

will not be uninstalled by the es-uninst script.

TABLE 2-5 When to Uninstall Sun Management Center Software

Current version of Solstice
SyMON or Sun Enterprise
SyMON software: Method of installation: How to uninstall previous versions:

1.x Any See your Solstice SyMON 1.0

documentation for information on

removing Solstice SyMON 1.0

software

2.0 Installation script from the

CD or the web

Sun Management Center 2.1

software removes the previous

version

2.0.1 Installation script from the

CD or the web

Sun Management Center 2.1

software removes the previous

version
24 Sun Management Center 2.1 Software User’s Guide • November 1999



▼ To Remove Sun Management Center Software

From a Solaris Environment

Note – Sun Management Center software can be installed in any location on your

system where the minimum required disk space is available. The following

procedure reflects the default location for package installation in /opt .

1. Type the following command.

2. Type y to uninstall Sun Management Center software, or n to cancel your request.

Caution – This utility does not enable you to remove Sun Management Center

packages selectively. Once you type y, all the packages are removed. There is no

additional warning before package removal begins.

The contents of the /var/opt/SUNWsymon directory remain and are unaltered by

the uninstall script. The state of the administrative domain configuration is retained

for subsequent installations or upgrades.

Note – To verify if there are packages that are left, type the following command:

pkginfo -c symon .

▼ To Remove Sun Management Center Software

From a Microsoft Windows Environment

1. From the Start menu, select Settings ➤ Control Panel.

2. Select Add/Remove Programs.

3. Select Enterprise SyMON 2.0.1.

4. Click the Add/Remove button.

# /opt/SUNWsymon/sbin/es-uninst
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CHAPTER 3

Installing the Sun Management
Center 2.1 Software

This chapter explains how to install the Sun Management Center version 2.1 product

on your system.

The following topics are discussed in this chapter:

■ To Upgrade from 2.x to 2.1 Software

■ To Install the Sun Management Center Packages From the CD

■ To Install the Sun Management Center Packages From the Web

■ Installing Separately Released Add-on Components

■ To Set Up Sun Management Center Online Help on a Remote Machine

■ To Set Up Sun Management Center Component Layers

■ To Add Sun Management Center Users

■ To Start the Sun Management Center Software

■ To Exit the Sun Management Center Console

■ To Stop the Sun Management Center Server and Agents

Note – Sun Management Center software known limitations and bugs are listed on

the web at http://www.sun.com/sunmanagementcenter .

Upgrading from Sun Enterprise SyMON
2.x to Sun Management Center 2.1
Software

When you are upgrading from Sun Enterprise SyMON 2.x to Sun Management

Center 2.1 software, follow these steps:
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▼ To Upgrade from 2.x to 2.1 Software

1. Install the new Sun Management Center 2.1 server and console packages first.

You can install these at the same time, or if you want to install them separately,

install the server first, and then the console.

2. Upgrade the agent(s).

Install the agent component layer when prompted by the installation script.

Installing the Software on Your System

This section describes how to install, set up, and run your Sun Management Center

2.1 software. Read this section for general information about your Sun Management

Center installation then follow the steps in the appropriate procedure, based on your

delivery method (CD or the web).

Install Sun Management Center software using the inst-es script. During

installation, you may install the console, server, agent, and help layers separately or

in combination.

Note – The coexistence of the Solstice SyMON 1.x and Sun Management Center 2.x
software is not supported on the same server. In addition, you may have Sun

Management Center sessions running on different servers or server contexts. For

more information on server context, see Chapter 1 and Chapter 15.

What to Do About Files or Component Layers

from Earlier Versions of Solstice SyMON Software

If you have Solstice SyMON 1.x packages installed on your system, the installation

script fails. You must remove all Solstice SyMON 1.x packages before installing Sun

Management Center 2.1 software.
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Caution – The Sun Management Center 2.1 installation script may overwrite

Solstice SyMON 1.x files. Consequently, you may lose your customized event rules.

If you have modified Solstice SyMON 1.x rules, then you must back up these rules

before installing Sun Management Center 2.1 software. Depending on where you

modified your event rules, back up the /etc/opt/SUNWsymon directory or the

/opt/SUNWsymon/etc directory.

If you have Sun Enterprise SyMON 2.x or Sun Management Center 2.1 component

layers already installed on your system, the install script prompts you to uninstall

the previously installed packages. You can either:

■ Uninstall immediately and proceed with a fresh installation, or

■ Quit the current session and uninstall the necessary packages automatically by

using the es-uninst command, and then proceed with the installation.

Caution – Be aware that when you answer y to the uninstall prompt, your current

Sun Enterprise SyMON 2.x or Sun Management Center 2.1 packages will be

uninstalled. However, the administrative domain information, custom alarm

settings, and so on are retained in the /var/opt/SUNWsymon directory and may be

used by the new installation.

Caution – If you are reinstalling the Sun Management Center software and would

like to restore it to a “new” state, do the following:

- Make sure to move any custom configuration files that may have been created

within the /opt/SUNWsymon directory during the previous sessions.

- Remove all subdirectories and files within the /var/opt/SUNWsymon directory by

using the following command: rm -rf /var/opt/SUNWsymon .

- Complete the installation and setup as described in this chapter.

- Then restore the moved files back to the /opt/SUNWsymon directory.

The result of this process is that previous database entries are cleared, as well as

your topology. Be sure this is what you want to do before proceeding.

Where to Install Sun Management Center

Software

Note – Sun Management Center software can be installed in any location on your

system where the minimum required disk space is available. The default location for

package installation is /opt .

!
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If there is not enough disk space in the /opt/SUNWsymon directory to accommodate

the Sun Management Center packages, then do the following:

● Create a symbolic link to any other file system in which enough space is available.

Caution – Install the Sun Management Center agent on every monitored or

managed host. In addition, you must install a Sun Management Center agent on your

Sun Management Center server host (even if you choose not to run this agent).

When the server is installed, the Sun Management Center installation program

displays a message that it is installing the agent as well.

Note – You can get a listing of all packages related to Sun Management Center

software that are currently installed with the following command:

pkginfo -c symon .

▼ To Install the Sun Management Center Packages

From the CD

Note – Familiarize yourself with the READMEfile on the CD before beginning your

installation. For Solaris operating environments:

/cdrom/cdrom0/INSTALL.README .

Any late-breaking news that develops concerning this software installation

procedure is placed at the Sun Management Center web site:

http://www.sun.com/sunmanagementcenter .

Installing in a Solaris Environment

1. Place the Sun Management Center 2.1 CD in the CD-ROM drive.

2. Open a command window and (if you are not already superuser) become
superuser by using the su command.

# mkdir / directory/SUNWsymon
# ln -s / directory/SUNWsymon /opt/SUNWsymon
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3. If you are running the Sun Management Center server for the first time, edit the
/etc/nsswitch.conf file. Be sure the groups entry has files as the first token.

4. Change to the CD-ROM directory.

■ If you are using the Volume Manager (vold ), type:

■ If the CD-ROM drive is not already mounted, mount the drive by typing:

5. List the files in the cdrom0 directory and read the READMEfile(s) that are
appropriate for your hardware platform.

6. Launch the Sun Management Center installation script by typing the following
command:

The script presents an interactive list of questions that guides you through the

installation procedure.

If you have Sun Enterprise SyMON 2.x or Sun Management Center 2.1 component

layers already installed on your system, the install script prompts you to uninstall

the previously installed packages. You can either:

■ Uninstall immediately and proceed with a fresh installation, or

■ Quit the current session and uninstall the necessary packages automatically by

using the es-uninst command, and then proceed with the installation.

groups:files nis

# cd /cdrom/cdrom0

# mkdir /cdrom/cdrom0
# mount -o ro -F hsfs /dev/dsk/c Xt YdZs0 /cdrom/cdrom0
# cd /cdrom/cdrom0

# ./inst-es
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Caution – Be aware that when you answer y to the uninstall prompt, your current

Sun Enterprise SyMON 2.x or Sun Management Center 2.1 packages will be

uninstalled. However, the administrative domain information, custom alarm

settings, and so on are retained in the /var/opt/SUNWsymon directory and may be

used by the new installation.

Sun Management Center software can be installed in any location on your system

where the minimum required disk space is available. The default location for

package installation is /opt .

7. Select the Sun Management Center component layers (agent, server, console, or
help) you want to install.

Note – Be sure to read “Sun Management Center Online Help” on page 35 before

installing the online help. After you have installed online help, it is launched and

viewed in your web browser.

Note – The inst-es script enables you to set up your Sun Management Center

component layers. A set of questions guides you through the setup procedures.

Note – The installation process installs the Sun Management Center packages

(including any applicable hardware add-on component packages) for your system.

In some cases, user confirmation is required prior to installing an add-on

component. Refer to your hardware platform supplement for more information.

Installing in a Microsoft Windows Environment

1. Place the Sun Management Center 2.1 CD in the CD-ROM drive.

2. Run the SunManagementCenter.exe file from:
your_CD-ROM_drive\Sun_Management_Center_2_1\Windows\

3. Follow the instructions in the wizard for setup.
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▼ To Install the Sun Management Center Packages

From the Web

Note – Before installing Sun Management Center on your system, read the

INSTALL.READMEfile in the downloaded packages. This file provides additional

information that helps you during the installation process.

Installing in a Solaris Environment

1. Using your web browser, go to the Sun Management Center web site.

2. Click the mouse button on Download Software.

Note – Prior to downloading the Sun Management Center software, you must

determine which OS versions you will be installing Sun Management Center on.

There is a separate Sun Management Center download file for each OS version.

3. Follow the instructions on the web page and download your Sun Management
Center packages. Store the software in a location that is accessible by superuser.

4. Open a command window and (if you are not already superuser) become
superuser by using the su command.

5. After you have downloaded the Sun Management Center packages, connect to the
directory where you want the packages located. Use the following command:

6. Extract the Sun Management Center packages with the following command:

If you downloaded multiple OS (operating system) versions of the Sun Management

Center packages, you may extract all OS versions into a single directory. Simply

execute the above command for all downloaded package files without changing the

current directory.

http://www.sun.com/sunmanagementcenter/

 cd / download_directory

# zcat downloaded_filename | tar xvf -
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Note – Place only packages of the same Sun Management Center software version

in the same directory.

7. If you are running the Sun Management Center server for the first time, edit the
/etc/nsswitch.conf file. Be sure the groups entry has files as the first token.

8. List the files in the directory and read the READMEfile(s) that are appropriate for
your hardware platform.

9. Become superuser (if you are not already) and launch the Sun Management
Center installation script as follows:

The script presents an interactive list of questions that guides you through the

installation procedure.

If you have Sun Enterprise SyMON 2.x or Sun Management Center 2.1 component

layers already installed on your system, the install script prompts you to uninstall

the previously installed packages. You can either:

■ Uninstall immediately and proceed with a fresh installation, or

■ Quit the current session and uninstall the necessary packages automatically by

using the es-uninst command, and then proceed with the installation.

Caution – Be aware that when you answer y to the uninstall prompt, your current

Sun Enterprise SyMON 2.x or Sun Management Center 2.1 packages will be

uninstalled. However, the administrative domain information, custom alarm

settings, and so on are retained in the /var/opt/SUNWsymon directory and may be

used by the new installation.

Sun Management Center software can be installed in any location on your system

where the minimum required disk space is available. The default location for

package installation is /opt .

10. Select the Sun Management Center component layers (agent, server, console, or
help) you want to install.

groups:files nis

# cd / download_directory
# ./inst-es
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Note – Be sure to read “Sun Management Center Online Help” on page 35 before

installing the online help. After you have installed online help, it is launched and

viewed in your web browser.

Note – The inst-es script enables you to set up your Sun Management Center

component layers. A set of questions guides you through the setup procedures.

Note – The installation process installs the Sun Management Center packages

(including any applicable add-on component) for your system. In some cases, user

confirmation is required prior to installing an add-on component. Refer to your

hardware platform supplement for more information.

Installing in a Microsoft Windows Environment

1. Using your web browser, go to the Sun Management Center web site.

2. Click the mouse button on Download Software.

3. Follow the instructions on the web page and download your Sun Management
Center packages.

4. Run the SunManagementCenter.exe file from:
your_download_directory\Windows\

Sun Management Center Directories

Note – Sun Management Center software can be installed in any location on your

system where the minimum required disk space is available. The default location for

package installation is /opt .

http://www.sun.com/sunmanagementcenter/
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After a successful installation and setup, the following directories are created.

Installing Separately Released Add-on
Components

If you have separately released add-on components you want to install, refer to your

hardware platform supplement for installation information.

Sun Management Center Online Help

The Sun Management Center online help, based on the Sun Management Center 2.1
Software User’s Guide, is designed to be a quick reference. Once your software

installation is complete, you can use your browser to view the English online help

files in the /opt/SUNWsymon/lib/locale/C/help directory, where C represents

the English version. Refer to the Sun Management Center online help for detailed

information about windows or procedures.

For heterogeneous console installations (that is, an environment which has the Sun

Management Center console component layer installed on both Solaris operating

environment workstations and personal computers [PCs]), the Sun Management

Center help file Uniform Resource Locator (URL) should be of the type http:// .

The console component layer for PCs does not include the online help packages.

Instead, the httpd daemon should be installed on the Sun Management Center help

server where the help packages are loaded.

This help server has the Sun Management Center help packages installed and is

http-accessible. All consoles can connect to this help server for online help.

TABLE 3-1 Sun Management Center Directories

Directory Description

/opt/SUNWsymon Root directory or softlink directory that contains the

infrastructure and applications of Sun Management Center

/etc/opt/SUNWsymon Contains the init scripts for Sun Management Center

software applications

/var/opt/SUNWsymon Contains the Sun Management Center configuration files

for your system
36 Sun Management Center 2.1 Software User’s Guide • November 1999



Installing Online Help

Caution – Complete the following procedure only if you are installing Sun

Management Center online help on a remote machine (not on your console host) or

if you are running the Sun Management Center console on a PC.

Note – A Netscape® web browser must be installed to access Sun Management

Center online help. Be sure to specify the location in your PATHenvironment

variable.

▼ To Set Up Sun Management Center Online Help

on a Remote Machine

Note – The following example procedure sets up a Sun Management Center help

server so that the online help package is web-accessible for a Sun WebServer™ 1.0

system. If you are using another type of web server, modify the corresponding

configuration file.

1. If it has not already been installed, install the httpd daemon on the Sun
Management Center help server.

2. Modify the /etc/http/httpd.conf file to specify doc_root as
/opt/SUNWsymon/lib/locale/C/help , where C represents the English version.
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For example:

3. Start the httpd daemon on the Sun Management Center help server.

4. During the installation and set up of your Sun Management Center server
component layer, specify the base URL for Sun Management Center online help.

Caution – Do not click Return. Instead, type http://< online-help-server-host>.

Note – The word “local” in the last line of the above message refers to the console,

not a local server.

# Host Parameters
url {
doc_root           " /opt/SUNWsymon/lib/locale/C/help "
user_doc_enable"yes"
  user_doc_root"public_html"
  cgi_enable"yes"
  cgi_dns_enable"no"
  cgi_suffix_enable"no"
  cgi_user"nobody"
  log_type"clf"
  log_prefix"/var/http/logs/http"
  log_max_files7# number of log files
  log_cycle_time1440# minutes i.e. 1 day
  log_max_file_size1048576# bytes i.e. 1 MB
  ssi_enable"no"
  ssi_exec"no"
}

The Sun Management Center base URL is relative to the Sun
Management Center Console. The Sun Management Center Console is
able to request help documentation via the network. If you have
installed Sun Management Center help documentation in an http-
accessible location within your network, you may specify this
location. If Sun Management Center help is installed on the console
host, simply accept the default value.
Please enter base URL to Sun Management Center help [local]:
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Setting Up Sun Management Center
Component Layers

Complete the following procedure:

■ when you change your setup configuration, such as changing the server context

■ when asked to do so in your supplement

(If your installation was unsuccessful, see “Uninstalling the Sun Management Center

Software” on page 24.)

Note – You may need to complete the following procedure when you change your

setup configuration, such as changing the server context or changing the security

seed, after you have successfully installed the software. For more information, see

“Sun Management Center Remote Server Access” on page 309 and “Security Seeds”

on page 39.

Note – If there is a potential conflict for port addresses, see “Configuring Sun

Management Center Software to Use Different Port Addresses” on page 330 before

completing the steps in this section.

▼ To Set Up Sun Management Center Component

Layers

1. Open a command window and (if you are not already superuser), become
superuser.

2. Change to the directory that contains the Sun Management Center setup script by
typing the following command:

3. Run the setup script to set up the component layers.

# cd /opt/SUNWsymon/sbin

# ./es-setup
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4. The setup script finds the installed component layers on your system with set up
requirements and enables you to select the components to set up. A set of
questions guides you through the setup procedures.

Note – See the supplement for more information about set up of add-on

components.

Sun Management Center Groups

Sun Management Center assigns users to groups. Three groups are created by

default during the installation process. They are:

■ esops

■ esadm

■ esdomadm

See “Access Control (ACL) Categories” on page 304 in Chapter 15 for more

information.

Security Seeds

Sun Management Center software generates a security key used for communications

between processes. A seed (or password) must be provided to initialize the keys.

You can choose your own seed, an alphanumeric string of up to eight characters, or

use the standard Sun Management Center default (maplesyr) . Here is the prompt

from the setup script:

The seed can be changed at a later time using the procedure described in “Setting

Up Sun Management Center Component Layers” on page 38. Also see

“Regenerating Security Keys” on page 323 for more information.

Do you want to generate these keys using the Sun Management Center
default seed?
[y|n|q]
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Note – If you choose to enter a seed of your own rather than accept the default, be

sure to keep a record of the seed for use at a later time.

Sun Management Center Licensing

Sun Management Center software is free-of-charge to manage or monitor an

individual object or host.

The software creates a default administrative domain consisting of one managed

object, the host where the Sun Management Center server resides. You may

manually configure the software to change the managed host to another system;

however, this is the limit of free-of-charge use.

A Sun Management Center right-to-use license is required to create more than one

administrative domain and to manage or monitor more than one object. If you do

not purchase a license, you will be operating in violation of your license agreement.

For information on purchasing a license, see the following web site:

http://www.sun.com/sunmanagementcenter

If you exceed the allowed number of objects, or if you exceed the time period

allowed for your demonstration license, a message is displayed during login, to alert

you that you have exceeded the limits of your license.

If you have exceeded your license limit, contact your Sun service representative or

authorized Sun service provider for more information.

During the setup of the server component, you are given the opportunity to specify

a license token.

■ If you have a license token, you may enter it during setup.

--------------------------------------
      Exceed License Limit!!!
      Authenticated: XXX
      Used:  YYY

      Invalid licenses!!
      Error(s) occurs in your license(s)
      Please verify your license(s)
      -------------------------------------
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■ If you do not have a license token, you may run the software without one as

described above. When you get a license token, you can install it using the

es-lic script.

Sun Management Center Users

Sun Management Center users are valid UNIX users on the Sun Management Center

server. As such, the system administrator has to add valid users into the following

file; /var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into Sun Management Center

software. (See the following section for more information.)

Public and Private Users

During the Sun Management Center server setup, the file /var/opt/SUNWsymon/
cfg/esusers is created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to have “general” privileges. For example, when a user tries to access

information from a session running in a different Sun Management Center server

from their own, they are given access as espublic and are able to view the

information as a guest only.

■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the software.

# cd /opt/SUNWsymon/sbin
# ./es-lic

  --------------------------------
Sun Management Center License Program
  --------------------------------

Please enter license key:
#

42 Sun Management Center 2.1 Software User’s Guide • November 1999



The administrator has to add the additional list of user IDs for all other users who

need to log into Sun Management Center software. All users in this file have

“general” access privileges, by default, unless they are given additional privileges

using the procedures described in “Using Access Control (ACL)” on page 311.

Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

▼ To Add Sun Management Center Users

1. Become superuser (on the Sun Management Center server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.

Note – By adding a user to the users list, the user has default privileges. See

“Default Privileges” on page 317 and “Overriding the Default Privileges” on

page 318 for more information.

For more information on setting up users, see Chapter 15.

▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid Sun Management Center user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.
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Starting the Sun Management Center
Software

Sun Management Center components are started with the es-start utility. The

syntax for this utility is:

Note – The Sun Management Center processes are generally started in the

background unless you specify the -i option (valid for only one process in the

interactive mode). The console process is run in the foreground so it can be killed

easily using Control-C.

The choices for option(s) are listed in TABLE 3-2.

# /opt/SUNWsymon/sbin/es-start  - option(s)

TABLE 3-2 Options for es-start Choices

Option Definition

a Starts agent

c Starts console

e Starts Event manager

f Starts Configuration manager

h Lists the options for the es-start utility

i Starts agent in interactive mode; valid only for one of the a, t,
f, l, p, and e options

l Starts Platform agent

p Starts Topology manager

q Starts quiet mode

s Starts server

t Starts Trap handler

A Starts all components except the console. Equivalent to es-start
-aefpst

S Starts server and all the server subcomponents. Equivalent to

es-start -efpst
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For example, to start the agents and server, use the es-start -A option. To start the

agent on a monitored host, use the es-start -a option.

Note – You must be superuser to start any of the Sun Management Center

components except the console.

Here are commonly used start commands:

After starting other processes, there may be a delay of several seconds before the

console is able to respond.

Note – You can start more than one process at a time. For example, to start both the

console and the server + agent, enter es-start -Ac .

Console and Server Options

You can pass certain arguments to the console and server processes being started by

listing those arguments after the options. For example:

If you want to start the console and specify the maximum heap size as 100 MBytes,

use the following command.

Similarly, if you want to start the server and specify the maximum heap size as 100

MBytes, use the following command.

TABLE 3-3 Common Start Commands

To start: Command

Server-only es-start -S

Agent-only es-start -a

Server + agent es-start -A

Console es-start -c

# es-start -c -- -Xmx100m

# es-start -s -- -Xmx100m
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If you want to start the console and specify a particular port (such as port 2090), use

the following command.

▼ To Start the Sun Management Center Software

Starting in a Solaris Environment

1. Change directory to the /opt/SUNWsymon/sbin directory.

2. If applicable, start the Sun Management Center server by typing:

3. If applicable, start the Sun Management Center agent by typing:

4. Type es-start -c at the prompt to start the console.

Starting in a Microsoft Windows Environment

● Double-click the icon labeled Sun Management Center to start the console.

# es-start -c -- -p 2090

# cd /opt/SUNWsymon/sbin

# ./es-start -S

# ./es-start -a

# ./es-start -c
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Note – You do not need to be superuser to run the Sun Management Center console.

The Sun Management Center login panel (FIGURE 3-1) is displayed. See TABLE 3-4 for

more information on the login panel buttons.

FIGURE 3-1 Sun Management Center Login Panel

TABLE 3-4 lists the buttons in the login panel and their corresponding functions.

5. Log in using a valid UNIX user account. This account must be listed in the
/var/opt/SUNWsymon/cfg/esusers file in the Sun Management Center server
machine.

Note – The user accounts, espublic and esmaster , should not be used.

6. Type the host name of the Sun Management Center server in the Server Host field.

TABLE 3-4 Sun Management Center Login Panel Buttons

Button Function

Login Enables users to open the Sun Management Center application.

Help Displays the online help for this panel.

Options Displays a dialog box which enables you to specify the port number of the

Sun Management Center server and the security scheme for console to Sun

Management Center server messages.

Exit Exits the software.
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7. If you are not using the Sun Management Center server default port addresses or
want to set the console to Sun Management Center server message security:

a. Click the Options button.

b. Type the Sun Management Center server RMI host port number in the Server
Port Number field.

See “To Reconfigure Sun Management Center RMI Port Address” on page 332 for

more information.

c. Click the circle next to the appropriate security message option (FIGURE 3-2).

FIGURE 3-2 Sun Management Center Login Options Dialog

These options allow you to choose among the following:

■ No Message Authentication: If you select this, only the user login is

authenticated. Messages between the console and the server are not verified for

authentication.

■ Console-to-Server Message Authentication: If you select this, the server verifies

the authenticity of the messages coming from the console. However, the

console does not verify the messages from the server.

■ Console-Server-Console Message Authentication: If you select this, both the

console and the server authenticate the messages coming from the other.

d. Click the OK button.

8. Check that you typed in all the information correctly in the Sun Management
Center Login window (FIGURE 3-1).
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9. Click the Login button in the Sun Management Center Login window to log into
the Sun Management Center console.

The message is displayed on the Current status line:

“Login successful. Launching console. ”

The main console window is displayed (FIGURE 3-3).

Note – You may see a warning dialog box before the main console window is

displayed if: the console software version does not match the server version, or you

have exceeded the limits of your license.

FIGURE 3-3 Sun Management Center Main Console Window

Exiting and Stopping the Sun
Management Center Software

You exit the console through the main console window, and the server and agent

components through a shell window.

Sun Management Center server and agent components are stopped with the

es-stop utility. The syntax is:

# /opt/SUNWsymon/sbin/es-stop  - option(s)
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The choices for option(s) are listed in TABLE 3-5.

Note – You must be superuser to stop the Sun Management Center server and

agents.

▼ To Exit the Sun Management Center Console

1. Select File ➤ Exit from the menu bar on the main console window.

The Exit Sun Management Center dialog is displayed (FIGURE 3-4).

2. Click the Exit button to exit the application or the Cancel button to cancel your
request.

FIGURE 3-4 Exit Sun Management Center Dialog

TABLE 3-5 Options for es-stop Choices

Option Definition

a Stops the agent

e Stops the Event manager

f Stops the Configuration manager

h Lists the options for the es-stop utility

l Stops the Platform agent

p Stops the Topology manager

s Stops the server

t Stops the Trap handler

A Stops all the components except the console

S Stops the server and all the server subcomponents (Trap handler,

Topology manager, Configuration manager, and Event manager)
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▼ To Stop the Sun Management Center Server and

Agents

● Stop the Sun Management Center agents and the server subcomponents by
typing:

# /opt/SUNWsymon/sbin/es-stop -A
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CHAPTER 4

Using Sun Management Center
Administrative Domains

A Sun Management Center administrative domain is an arbitrary collection of

resources that can include a complete campus, individual buildings, hosts, networks,

subnets, links, and so on. The organization of an administrative domain collection is

in a hierarchy.

Note – In this document, “administrative domain” refers to a Sun Management

Center administrative domain, and should not be confused with other uses of the

term “domain” related to other Sun products or documentation.

This chapter covers the following topics:

■ To Set a Home Administrative Domain

■ To Select Domain Manager

■ To Create Administrative Domains

■ Populating Administrative Domains

■ To Select an Administrative Domain

■ To Delete an Administrative Domain

■ To Set a Remote Administrative Domain

■ To Set Security for an Administrative Domain

Sun Management Center software can monitor a multitude of hosts. To enable you

to perform your monitoring tasks in an efficient manner, Sun Management Center

software organizes hosts into groups. The biggest (highest level) grouping is a

administrative domain. An administrative domain is an arbitrary grouping of hosts,

subnets, networks, buildings, and so on.

You can create one or multiple administrative domains, each with an unique name.

Each administrative domain consists of one or more members, arranged in a

hierarchy. For example, you may decide that an administrative domain consists of all

the hosts in one building. Or, you may decide that an administrative domain consists

of all the hosts in a campus.
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Note – Spend some time planning how you want to organize your hosts into

different administrative domains.

Decide if you need additional groups below the administrative domain to organize

your hosts. For example, if there are several hundred hosts, it is impractical to place

your hosts individually in one administrative domain.

You may decide to break the administrative domain into a set of smaller groups; for

example, campuses. The Headquarters administrative domain might consist of

several campus locations (FIGURE 4-1).

FIGURE 4-1 Example Administrative Domain

Each of these campus locations may be broken into smaller groups; for example,

buildings. Similarly, each building may be broken into smaller groups; for example,

networks, subnets, and groups. Finally, each group comprises individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level,

is administrative domain, campus, building, network, subnet, group, and individual

host. For detailed information on creating administrative domains, see “To Create

Administrative Domains” on page 60.
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Starting Sun Management Center
Software

When starting the software for the first time, a dialog is displayed (FIGURE 4-2)

prompting you to set a Sun Management Center home administrative domain. The

home domain is the administrative domain that is displayed whenever the console is

started.

FIGURE 4-2 Set Home Domain Dialog

During installation, a default administrative domain (named after your server host)

is automatically created for you.

● Proceed with one of the following:

■ Select the default administrative domain and click on the Set Home button. Your

default administrative domain is set as your home administrative domain and is

displayed. For more information, see “To Set a Home Administrative Domain” on

page 56.

■ Select the default administrative domain and click on the Go To button. The main

console window is displayed with this default domain.

The default administrative domain consists of one object, your server host.

The name of
your default
administrative
domain dis-
plays here.
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■ If you want to explore the main console window, see Chapter 7.

■ If you want to explore monitoring features, see Chapter 8.

■ If you want to create additional administrative domains, see “To Create

Administrative Domains” on page 60.

■ If you want to create additional objects in your administrative domain, see

“Populating Administrative Domains” on page 60.

▼ To Set a Home Administrative Domain

1. Proceed with one of the following:

■ Click the Set Home button (FIGURE 4-2) in the Set Home Domain dialog.

■ Select File ➤ Set Home Domain in the Sun Management Center main console

window (FIGURE 4-3).

FIGURE 4-3 Sun Management Center File Menu

The Set Home Domain dialog (FIGURE 4-4) is displayed.

File menu
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FIGURE 4-4 Set Home Domain Dialog

2. Select the administrative domain you want to set as your home administrative
domain.

The selected administrative domain is highlighted.

3. Click the Set Home button.

You see the following message at the bottom of the Set Home Domain dialog.

When the home administrative domain has been set, the message changes.

4. Click the Close button.

The main console window is updated and the home administrative domain is

displayed (FIGURE 4-5).

At this time, you may want to populate your administrative domain. See

“Populating Administrative Domains” on page 60 for more information.

Setting Home Domain...Please wait

Home domain successfully set.
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FIGURE 4-5 Home Domain

Creating Administrative Domains

The Sun Management Center software enables you to create Sun Management

Center administrative domains with the Domain Manager window.

▼ To Select Domain Manager

● In the main console window, select File ➤ Domain Manager (FIGURE 4-3).

The Domain Manager is displayed (FIGURE 4-6).
58 Sun Management Center 2.1 Software User’s Guide • November 1999



FIGURE 4-6 Domain Manager

Note – In the Domain Manager, some of the buttons are grayed out until you select

an administrative domain.

TABLE 4-1 Domain Manager Buttons

Button Description

Add Displays the Create Domain dialog.

Security Displays the Attribute Editor with the security tab selected for the

highlighted administrative domain.

Delete Deletes the selected administrative domain and all its members.
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▼ To Create Administrative Domains

1. Select File ➤ Domain Manager (FIGURE 4-3) from the main console window.

The Domain Manager is displayed (FIGURE 4-6).

2. In the Domain Manager, click the left mouse button on Add.

The Create Domain dialog is displayed (FIGURE 4-7).

FIGURE 4-7 Create Domain Dialog

3. Type in the name of the new administrative domain in the Domain Name field.

4. If you do not want your administrative domain populated now, be sure the
Populate Now check box is turned off.

The default choice is for Sun Management Center software to display a dialog

enabling you to start the Discovery Manager immediately after creating an

administrative domain. For more information about the Discovery Manager, see

Chapter 6.

5. Click the Create button.

Go To Updates the main console window to display the selected

administrative domain. You may also “go to” an administrative

domain by double-clicking on it.

Reference Inserts the selected administrative domain into the current

administrative domain.

Set Home Domain Sets the selected administrative domain as the administrative

domain that is always displayed whenever the console is started.

See “To Set a Home Administrative Domain” on page 56 for more

information.

TABLE 4-1 Domain Manager Buttons

Button Description
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6. Create additional administrative domains or populate your administrative domain
manually.

If you do not have the right security permissions to create an administrative domain,

an error message is displayed. See Chapter 15 for more information on security.

Populating Administrative Domains

Once you have created your administrative domain(s), you can begin to populate

these domains (and their subordinate groups). There are three methods to add hosts

and other resources to an administrative domain collection:

■ Populate with the Discovery Manager—see Chapter 6. Discovery Manager

searches the network for resources. This is the default method for populating a

newly created administrative domain. The search can be time-consuming, but you

can shorten the search by setting limits.

■ Populate with the Discovery Manager at scheduled intervals by using the

Scheduling feature—see “Starting the Discovery Requests Window” on page 102.

You can set the search to occur hourly, daily, weekly, or monthly. This feature

enables you to search periodically for new managed objects on the network.

■ Manually populate with the Create an Object menu—see Chapter 5. This method

enables you to add objects one at a time and is useful for adding a small number

of known resources. For example, if you have installed a new host, you can use

Create an Object to add the host to the local administrative domain immediately.

Managing Administrative Domains

Once you have created Sun Management Center administrative domains, you can

manage them.

Selecting Administrative Domains

You can list administrative domains through the Domain Manager window

(FIGURE 4-6) or the Sun Management Center main console window.
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▼ To Select an Administrative Domain

1. Proceed with one of the following:

■ Select File ➤ Domain Manager in the main console window (FIGURE 4-3).

■ In the main console window, click the left mouse button on the Sun Management

Center Administrative Domains pull-down menu (FIGURE 4-8).

The current list of administrative domains is displayed.

FIGURE 4-8 Sun Management Center Main Console Window with a List of Current
Administrative Domains

2. Click the left mouse button on the administrative domain you want to view.

The main console window is updated and displays the selected administrative

domain. The Sun Management Center Administrative Domains button changes to

display the name of the administrative domain you have selected.

Deleting Administrative Domains

You must have the appropriate security permission to delete an administrative

domain. For more information on Sun Management Center security, see Chapter 15.
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▼ To Delete an Administrative Domain

Caution – Deleting an administrative domain also deletes all the members of that

domain.

1. In the Domain Manager window, highlight the name of the administrative
domain you want to delete.

2. Click the Delete button.

The Confirm Domain Deletion dialog (FIGURE 4-9 or FIGURE 4-10) is displayed.

FIGURE 4-9 Confirm Domain Deletion Dialog
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FIGURE 4-10 Confirm Domain Deletion Dialog for Current Administrative Domain

3. Click Delete.

The Confirm Domain Deletion dialog displays the following message.

When the administrative domain has been successfully deleted, the dialog is

removed and the Domain Manager updates the list of administrative domains.

4. Click the Close button in the Domain Manager.

Deleting domain...Please wait.
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Monitoring Remote Administrative
Domains

Remote administrative domains are Sun Management Center administrative

domains created in a different Sun Management Center server context. See

Chapter 15 for a description of server context.

If you are interested in an object in a different server context, you can still monitor
the remote resource by referencing the remote administrative domain in your local

administrative domain. However, you are not able to manage the remote resource

unless you log out of your current Sun Management Center server context and log

into the remote server context. You can manage monitored properties on a resource

only if the agent on that resource sends event management information to the server

to which your console is connected. By default, Sun Management Center security

gives you “read-only” privileges for remote administrative domains. For more

information on security, see Chapter 15.

Note – You can reference a remote administrative domain to monitor resources in

that administrative domain. You cannot manage monitored properties on a remote

resource.

For example, your current Sun Management Center server context may be based in

the Headquarters administrative domain. A second, remote Sun Management Center

server context may be based in Regional Office 1. When workers are absent from

Regional Office 1, system administrators in Headquarters can monitor the regional

office administrative domains by referencing these remote administrative domains

in the Headquarters server context. If an emergency occurs, administrators in

Headquarters can notify a Regional Office 1 administrator immediately.

Note – Remote administrative domains enable you to monitor critical resources

continuously.

Here is an example of how remote monitoring works. In the following figure,

administrative Domain A is monitoring objects 1 and 2 (which are assigned to

Domain A) as well as remotely monitoring objects 3 and 4, which are assigned to

Domain B. Note that administrative Domain A cannot monitor objects 3 or 4 without

going through remote administrative Domain B.
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FIGURE 4-11 Remote Administrative Domain

Caution – Do not create an administrative domain with a circular reference (to

itself).

For example, do not create an administrative domain (Domain A) which references

another administrative domain (Domain B) which in turn, contains a reference to

Domain A.)

FIGURE 4-12 Remote Administrative Domain - Circular Domain Reference

If it is necessary for the two administrative domains to monitor each other, to avoid

creating a circular administrative domain reference, create a domain member (for

example, a group) under Domains A and B as shown below.

Domain A Domain B

Object 1 Object 2 Object 3 Object 4

Domain A Domain B

Object 1 Object 2 Object 3 Object 4
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FIGURE 4-13 Remote Administrative Domains - Setting Up for Successful Cross-
Monitoring

Now when making a remote reference, Domain A can reference Group 2 under

Domain B, while Domain B can reference Group 1 under Domain A.

▼ To Set a Remote Administrative Domain

1. In the main console window, select File ➤ Remote Domain Manager (FIGURE 4-3).

The Remote Domain Manager dialog is displayed (FIGURE 4-14).

Domain A Domain B

Object 1 Object 2 Object 3 Object 4

Group 1 Group 2
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FIGURE 4-14 Remote Domain Manager

2. Type the name of the remote server in the Host field. If applicable, also type the
appropriate number in the Port field.

By default, the Topology manager is installed on the server on port 164.

3. Click the List Domains button.

A list of administrative domains on the remote server is displayed.

4. Click the administrative domain you want to reference.

The selected administrative domain is highlighted.

5. Click the Reference button.

The selected administrative domain is created as a reference domain in the currently

selected administrative domain in the main console window (FIGURE 4-15).
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FIGURE 4-15 Referencing a Remote Administrative Domain

Attribute Editor for an Administrative Domain

The administrative domain Attribute Editor provides additional information about

the selected administrative domain and the rules governing its behavior. Use the

Attribute Editor to edit security information for the administrative domain.

Note – Each Attribute Editor displays one or more tab buttons, depending on the

type of Attribute Editor. The Attribute Editor that is displayed is dependent on the

selected object.

▼ To Set Security for an Administrative Domain

1. Proceed with one of the following:

■ Open the Attribute Editor for an administrative domain by clicking the right

mouse button on the domain icon and highlight Attribute Editor from the pop-up

menu in the hierarchy view.
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■ Select File ➤ Domain Manager in the main console window. Then select an

administrative domain and click the Security button.

2. If not already selected, click the Security tab (FIGURE 4-16).

3. Type the name(s) of user and administrator groups in the appropriate fields.

See Chapter 15 for more information.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 4-16 Attribute Editor for an Administrative Domain
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CHAPTER 5

Objects

This chapter describes how to create and monitor objects.

This chapter discusses how:

■ To Create a Node

■ To Create a Module Object

■ To Create a Group

■ To Create a Composite Object

■ To Create a Segment

■ To Connect Objects

■ To Copy an Object

■ To Copy a Group of Objects

■ To Modify an Object

■ To Cut and Paste Objects

■ To Delete Objects

Sun Management Center objects represent parts (or nodes) of a network and include

hardware and software components such as hosts (workstations and servers),

printers, routers, modules, and so on. A segment of the network itself can even be an

object.

Note – For additional information, refer to your supplement. The supplement

contains important hardware-specific information about creating an object.

To monitor or manage an object, you create a node to represent it in an

administrative domain or group. If the group does not yet exist, you must first create

the group.

You can create and monitor or manage one or more administrative domains

containing nodes for multiple objects (such as the workstations and other devices

connected to the server). For information about administrative domains, see

Chapter 4.
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Creating a Node

You create nodes through the Edit pull-down menu in the main console window.

▼ To Create a Node

Note – An administrative domain must exist before you can create a node. To create

an administrative domain, see “To Create Administrative Domains” on page 60.

1. In the hierarchy view of the main console window, select the administrative
domain in which you want to create the new object.

Select the lowest level group of the administrative domain where the new object

should be created.

For example, if you want to create a node in a building that is in one of the

campuses of a administrative domain, then select the building in the administrative

domain as the lowest level group.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed. By default the tab is set to Node

(FIGURE 5-1).
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FIGURE 5-1 Create Topology Object Window—Node Tab
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3. In the upper half of the Create Topology Object menu, set up the new node:

a. Click the Monitor Via button to see the pull-down menu, then select the
software or agent to monitor the new node.

There are seven categories of agents and monitors (TABLE 5-1). If an agent is not

available for your selected object, SNMP Ping usually works. If you do not select

an available agent or ping command, the creation fails.

TABLE 5-1 Types of Sun Management Center Monitoring

Type Description Effect

Agent – Host Monitor and manage a host that has an

active agent that is installed and

running.

The status of the agent on the host can be

monitored. The Details window of the Sun

Management Center agent host contains tabs

such as Info, Browser, Alarms, and so forth. The

Entity Polling Type in the Info tab is ahost .

Agent –

Module

Monitor and manage a module that has

an active Sun Management Center agent

that is installed and running.

The status of the Sun Management Center

Module on the agent host can be monitored. The

Details window contains Info and Browser tabs.

The Entity Polling Type in the Info tab is amod.

Agent -

Platform

For more information, see your

supplement.

SNMP Proxy Monitor and manage the device through

a Sun Management Center agent that is

running a Sun Management Center

proxy module for that device. (The

proxy module must have been

previously loaded into the agent by

using the Load Module dialog. See

Chapter 12.) Communication between

the Sun Management Center Topology

manager and the agent is SNMPv2 usec.

Communication between the Sun

Management Center agent and the

remote device is SNMPv1 or SNMPv2,

depending on the proxy module.

The Proxy Monitoring module data can be seen.

The Details window contains the Info and

Browser tabs. The Entity Polling Type in the

Info tab is aprox .
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b. If applicable, select a type from the pull-down menu in the Type field.

The list of choices varies widely according to the type of monitoring you selected

in the previous step.

Note – For information about creating an object for your specific platform, see the

supplement.

c. If applicable, scroll and select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object

window displays the set of icons for the object you have selected. The icons are

displayed in the hierarchy and topology views in the main console window when

the node is created.

SNMP Ping Monitor the device by using SNMP ping
command. The Sun Management Center

Topology manager communicates with

the device using SNMPv1. (There are no

management capabilities provided for

devices monitored by the SNMP ping
command.)

The availability of the SNMP agent on the

device can be monitored. The Details window

contains only the Info tab. The Entity Polling

Type in the Info tab is snmp.

ICMP Ping Monitor the device by using the Internet

Control Message Protocol (ICMP) ping
command. (There are no management

capabilities provided for devices

monitored by the ICMP ping
command.)

The accessibility of the device can be monitored.

The Details window contains only the Info tab.

The Entity Polling Type in the Info tab is ping .

Non-Monitored Created node is for display only. Its

status is not monitored.

No aspects of the device are monitored. The

Details window contains only the Info tab. The

Entity Polling Type in the Info tab is dummy.

TABLE 5-2 Choices Available in the Type Pull-Down Menu

Monitor by Agent - Host Agent - Module SNMP Proxy SNMP Ping ICMP Ping Non-monitored

Type Workstation,

Server,

Local Module Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

PC,

Server

Printer,

Workstation,

Router,

Concentrator,

Server,

PC

TABLE 5-1 Types of Sun Management Center Monitoring (Continued)

Type Description Effect
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d. (Optional) Create a unique new name in the Node Label field.

The default label is the host name.

e. (Optional) Type a description of the node.

4. In the lower half of the Create Topology Object window, type the requested
information.

The questions in the lower half of the window vary with the agent or monitor that

you selected in Step 4a, above. The Non-Monitored selection does not require further

information, but most agent or monitor selections ask you to enter:

■ Node host name

■ Node IP address

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

Other agent or monitor selections may also ask for one or more of the following:

■ Sun Management Center agent port number (the default is 161)

■ Proxy host name and IP address

■ Read/write SNMP communities

■ Module name

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new node is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have

permission to create this node, or that you must start a Sun Management Center

agent on the node.

Creating Node... Please Wait.
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Note – If you are connected to one Sun Management Center server context and

create a node on another Sun Management Center server context, ownership of the

new node on the second server context defaults to the espublic identity instead of

your login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Management Center server contexts. For more

information, see “Sun Management Center Remote Server Access” on page 309.

If you want to make any changes to the new node, see “Modifying Objects” on

page 94.

Creating a Monitored Module Object

If you want to monitor one or more module objects on a number of hosts, you may

find it useful to create module objects for each host and place all of the modules in a

common location (that is, in the same group or administrative domain). The

procedure for creating a module object is similar to that for creating a node.

▼ To Create a Module Object

1. In the hierarchy view of the main console window, select the administrative
domain in which you want to create the new object.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

3. Select the Node tab in the Create Topology Object window.

4. Select Sun Management Center Agent – Module in the Monitor Via field
(FIGURE 5-2).
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FIGURE 5-2 Create Topology Object Window for Sun Management Center Agent –
Module

5. (Optional) Type a node label.

6. (Optional) Type a description.
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7. Type a host name or IP address.

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. If necessary, change the port number.

9. Click the List Modules button to display a list of modules that are currently
loaded on the host.

If the module that you want to use is not loaded, see “To Load a Module” on

page 229. If the module that you want to use is not enabled, see “To Enable a

Module” on page 242.

The module list is displayed (FIGURE 5-3).

FIGURE 5-3 Module List

10. Select the module that you want to monitor and click OK.

The module list closes.

11. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.
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■ Click Cancel to cancel your request.

Creating Groups

You can create two types of groups, General and IP-based. General groups are based

on geography (campus or building). IP-based groups are based on networks or

subnets.

▼ To Create a Group

1. In the hierarchy view of the main console window, click the administrative
domain in which you want the new group.

Select (by clicking) a location in the administrative domain where the new group

should be created.

For example, if you want to create a group in a building that is in one of the

campuses of an administrative domain, then click the building icon in the

administrative domain.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).
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FIGURE 5-4 Creating an Object

The Create Topology Object window is displayed.
Chapter 5 Objects 83



FIGURE 5-5 Creating a Group in the Create Topology Object Window

3. In the Create Topology Object window:

a. Click the Group tab (FIGURE 5-5).

b. Change the Type field, if desired (General or IP-Based).
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c. Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object

type.

d. Create a new group Label.

e. (Optional) Type a description in the optional Description field.

f. For an IP-based group, specify the IP address and the subnet mask.

Note – The creation of an IP-based group results in the creation of an empty

network or subnet “container” which you can populate using the Create Topology

Object window.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

If you selected OK or Apply, this message is displayed at the bottom of the Create

Topology Object window:

If the request ends successfully, the main console window is updated and the group

is displayed.

If the request fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

right permission to create this group.

If you want to make any changes to the new group, see “Modifying Objects” on

page 94.

5. Add components to your group:

■ Use the Create Topology Object window. See “To Create a Node” on page 74.

■ Copy and paste objects from other groups into the new group. See “Copying

Objects” on page 92.

Creating group... Please Wait.
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Creating a Composite Object

A composite object is a group of related objects that you want to monitor together.

This term refers to hardware with multiple instances of the Solaris operating

environment running inside a single chassis.

You create composite objects through the Edit pull-down menu in the Create

Topology Object window.

▼ To Create a Composite Object

1. In the hierarchy view of the main console window, select the Sun Management
Center administrative domain in which you want to create the new composite
object.

Select the lowest level group of the administrative domain where the new composite

object should be created.

2. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed. By default the tab is set to Node.

3. Click the Composite tab in the Create Topology Object window.

The window changes to display settings available for composite objects (FIGURE 5-6).
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FIGURE 5-6 Create Topology Object Window—Composite Tab

4. Select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object window

displays the set of icons for the object you have selected. The icons are displayed in

the hierarchy and topology views in the main console window when the composite

object is created.
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5. Create a unique new name in the Label field.

6. (Optional) Type a description of the node.

7. In the lower half of the Create Topology Object window, type the requested
information.

■ SSP Hostname

■ SSP IP Address

■ Sun Management Center agent port number (the default is 161)

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the main console window is updated and

the new composite object is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

permission to create this object, or that you must start a Sun Management Center

agent on the object.

Note – If you are connected to one Sun Management Center server context and

create an object on another Sun Management Center server context, ownership of the

new object on the second server context defaults to the espublic identity instead of

your login identity. This situation is normal. The espublic identity is imposed for

security of transactions between Sun Management Center server contexts. For more

information, see “Sun Management Center Remote Server Access” on page 309.

If you want to make any changes to the new object, see “Modifying Objects” on

page 94.

Creating Composite Object... Please Wait.
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Creating Segments

To complete your view of an administrative domain, you can include segments of

the networks linking the nodes in the administrative domain. A segment object is a

line in the hierarchy of the topology view.

▼ To Create a Segment

1. In the main console window:

a. In the left window, select a location in the administrative domain where the
new segment should be created.

The segment is created at the selected (highlighted) level.

For example, if you want to create a segment in a building that is in one of the

campuses of an administrative domain, then select the building in the

administrative domain.

b. In the main console window, select Edit ➤ Create an Object (FIGURE 5-4).

The Create Topology Object window is displayed (FIGURE 5-1).

2. In the Create Topology Object window:

a. Click the Segment tab (FIGURE 5-7).
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FIGURE 5-7 Segment Tab in the Create Topology Object Window

b. Change the Type field, if desired (Bus or Ring).
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c. Select the object type.

The list of choices (Ethernet or IPX) changes with your selection in the Type field.

At the right in the Create Topology Object window is a window that displays

large and small icons corresponding to the type of object you have selected. The

icons are displayed in the topology view in the main console window when the

segment is created.

d. Type a new segment label.

e. (Optional) Type a description in the Description field.

f. Type the IP address for this segment.

g. Type a subnet mask for this segment.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

If the request is completed successfully, the Create Topology Object window closes.

The main console window is updated and the view is displayed.

If the request fails, an error message is displayed in the Create Topology Object

window.

If you want to make any changes to the new segment, see “Modifying Objects” on

page 94.

Connecting Objects

You can connect objects in the topology view.

▼ To Connect Objects

1. Select two objects in the topology view.

To select two objects, select the first object in the topology view. Hold down the Shift

key and click the second object using the mouse button.

Creating segment... Please Wait
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2. Select Edit ➤ Create a Connection.

A link is displayed between the objects.

Copying Objects

To move an object from one location in the topology view to another, use the Edit

commands, Cut and Paste .1 To copy an object into other topology views (leaving

the original object in its current location), use Copy instead of Cut .

For example, you can create an administrative domain that contains some of the

objects that already exist in another administrative domain. To do this, create a new

administrative domain (see Chapter 4), then copy existing objects into the new

administrative domain as described in the following procedure.

You can also copy a group (an object that contains other objects). In this case, the

software does not create an independent, completely new group. Rather, it creates a

symbolic link to the existing group. Thus every copy is a different “view” of the same
group.

Note – You can select multiple objects by using the mouse button while holding

down the Shift key.

For more information on the main console window, see Chapter 7.

Note – The copy, cut, and paste functions are available in the topology view. The

copy and cut functions are also available in a pop-up window by clicking your right

mouse button on the object.

▼ To Copy an Object

This procedure is for a single object. To copy a group, see “To Copy a Group of

Objects” on page 93.

1. In the main console window, select the existing object in the topology view.

1. Sun Management Center 2.1 software does not support drag and release as an operation for moving objects.
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2. At the top of the main console window, select Edit ➤ Copy in the pull-down
menu.

This message is displayed at the bottom of the main console window:

3. Open the destination group or administrative domain.

The destination group is displayed in the topology view.

4. At the top of the main console window, select Edit ➤ Paste.

The pasted object is displayed in the destination group or administrative domain,

and this message is displayed at the bottom of the main console window:

▼ To Copy a Group of Objects

To copy objects that are in one group and paste the copies into another group:

1. In the topology view, select the objects to be copied.

To copy all objects in the topology view, select Edit ➤ Select All in the main console

window menu bar.

To copy two or more objects selectively:

a. Click the first object to select it.

b. On the keyboard hold down the Shift key and click one or more additional
objects.

2. Select Edit ➤ Copy in the main console window menu bar.

When the objects are copied, this message is displayed at the bottom of the main

console window:

3. In the hierarchy view, select (highlight) the new group or administrative domain
where the group is to be copied.

Copy successful

Paste successful

Copy Successful
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4. Select Edit ➤ Paste Into in the main console window menu bar.

Alternatively, you can click with your right mouse button on the destination

administrative domain and select Paste Into from the pop-up menu.

Caution – If you select Edit ➤ Paste (instead of Edit ➤ Paste Into), the objects may

be pasted into the wrong group. If this occurs, highlight the duplicate objects and

select Edit ➤ Delete Object/Connection.

Caution – When you copy a group in the Sun Management Center software, the

new copy (a symbolic link) is labelled with italic font. The italic font is a reminder

that this is a link. If you add or remove objects from this group, the original group

and all copies of the group are affected.

Note – An object in the cut (pre-move) state remains visible—and selected with

dashed lines—until it has been successfully pasted. If you change your mind and no

longer want to paste the object, you can remove it from the cut state by clicking on it

a second time.

Modifying Objects

Once you have created or copied an object, you can change the object through the

Modify Object window. The changes affect only the description of the object (in the

Sun Management Center server database) and do not modify the object itself.

▼ To Modify an Object

1. Select the object in the main console window.

2. Select Edit ➤ Modify in the main console window.

The Modify Object window is displayed (FIGURE 5-8). (The appearance of the

window varies widely, depending on whether the object is a group, node, composite

object, or segment.) The following example shows how to modify a node.
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FIGURE 5-8 Modify Object Window—Example for a Node

3. Edit the characteristics as needed.

If you are modifying a group object, the available characteristics are:

■ Type: General or IP-Based

■ Object: Building, Campus, or General

■ Group Label
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■ Description

■ IP Address (for IP-Based only)

■ Subnet Mask (for IP-Based only)

For a node, the available characteristics are:

■ Monitor Via: Sun Management Center Agent - Host, Sun Management Center

Agent - Module, Sun Management Center Agent - Platform, SNMP Proxy, SNMP

Ping, ICMP Ping, or Non-Monitored

■ Node Label

■ Description

■ (Additional characteristics such as host name, IP address, or port may be listed,

depending on the type of node.)

For a segment, the available characteristics are:

■ Type: Bus or Ring

■ Object: Ethernet or IPX for bus type, or FDDI for ring type

■ Segment Label

■ Description

■ IP Address

■ Subnet Mask

For a composite object, the available characteristics are:

■ Object

■ Label

■ Description

■ SSP host name

■ SSP IP address

■ Port

See your supplement for more information.

4. Click OK to save your changes, or Cancel to leave the characteristics unchanged.
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Cutting and Pasting Objects

Objects can be cut (to be moved) or deleted (permanently) from the topology view in

the main console window. An object that is cut is temporarily saved in memory and

can be immediately pasted into one or more areas1. An object that is deleted cannot

be recalled. For instructions on deleting objects, see “Deleting Objects” on page 99.

For more information about the main console window, see Chapter 7.

Cut and paste functions work the same for all kinds of objects (hosts, modules, and

groups).

Caution – Do not use the cut function to delete objects. This function should only

be used to move objects. To delete an object, use Edit ➤ Delete in the main console

window. See “Deleting Objects” on page 99.

▼ To Cut and Paste Objects

1. Select an existing object in the topology view.

If you have not selected an object, the Cut and Delete functions are grayed out.

2. Select Edit ➤ Cut (FIGURE 5-9) in the main console window.

A dashed line is displayed around the selected object. (The object does not

immediately disappear. This allows objects, such as processes which should not be

interrupted, to continue running until they are pasted into a new location.) The

object remains visible until it has been successfully pasted.

Note – You can cancel a Cut operation by clicking on the object a second time.

1. Sun Management Center 2.1 software does not support drag and release as an operation for moving objects.
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FIGURE 5-9 Cut, Copy, and Paste Options

When the Cut operation succeeds, this message is displayed at the bottom of the

main console window:

3. Navigate to the destination location in the topology view.

4. Select Edit ➤ Paste. The object is displayed in this location and is removed from
the previous location.

Cut successful
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Deleting Objects

The Edit ➤ Delete command removes an object completely. To move an object to

another location, see “To Copy an Object” on page 92 or “To Cut and Paste Objects”

on page 97.

For more information on the main console window, see Chapter 7.

▼ To Delete Objects

Note – To delete an administrative domain, use the delete command in the Domain

Manager window; see “Deleting Administrative Domains” on page 62.

1. Select an existing object in the topology view.

If you have not selected an object, the Delete function is grayed out.

2. Select Edit ➤ Delete Object/Connection from the top of the main console window
(FIGURE 5-10).

You are prompted to confirm or cancel the deletion.

If the Delete operation succeeds, the object is removed, and this message is

displayed at the bottom of the main console window:

Delete successful
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FIGURE 5-10 Delete Option
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CHAPTER 6

Discovery Manager

You can use the Discovery Manager to populate administrative domains

automatically. For example, automatically populating administrative domains is

very useful if you have a large network. To add members manually with the Create

Topology Object window, see Chapter 5.

The following topics are covered in this chapter:

■ To Start the Discovery Requests Window

■ To Initiate a Discovery Request

■ To Customize a Discovery Request

■ To Modify a Discovery Request

■ To Start, Stop, or Delete a Discovery Request

The Discovery Manager can find or “discover” hosts, routers, networks, and subnets

(see “Overview of IP Addressing” on page 407) in a local server context. The

Discovery Manager cannot discover objects where a Sun Management Center agent

is configured to a different server context (see “Sun Management Center Server

Context” on page 309).

The Discovery Manager can also find and group topology objects which are related;

either to a single hardware platform/chassis or a group of cooperating hardware

platform/chassis. This discovery and grouping allows convenient management of

the related objects and is described in the add-on supplement for those machine

architectures which have this grouping requirement.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

You can create one or more discovery requests. Each request runs as a separate

process and populates the administrative domain with the objects that it has

discovered.

You can also schedule requests to run periodically and look for new hosts.
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Starting the Discovery Requests Window

To begin a Discovery Request, start the Discovery Requests Window.

▼ To Start the Discovery Requests Window

Start the Discovery Requests window in one of two ways:

■ When you create an administrative domain in the Create Domain dialog

(FIGURE 4-7) the Populate Now option is selected by default.

If you click Create in the Create Domain dialog while the Populate Now option is

selected, a dialog window enables you to start the discovery process immediately.

For more information on creating administrative domains, see Chapter 4.

■ Select the administrative domain in the Sun Management Center Administrative

Domains pull-down menu. then select Tools ➤ Discover in the main console

window (FIGURE 6-1).

FIGURE 6-1 Tools Pull-down Menu

The Discovery Requests window is displayed (FIGURE 6-2).

Pull-down menu
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FIGURE 6-2 Discovery Requests Window
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The Discovery Requests window displays information containing the fields in

TABLE 6-1.

The Discovery Requests window has the buttons listed in TABLE 6-2.

TABLE 6-1 Discovery Requests Window Fields

Field Description

Name A unique name which you create for the request

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discovery request. The states may

be:

1. New. A new request was added but has never been processed.

2. Queued. A request has been sent to the server but processing has

not yet started.

3. Running. The request is currently being processed.

4. Succeeded. The request has been successfully processed.

5. Failed. Processing of the request has failed.

6. Stopped. The user has stopped the process.

7. 0 Host found. The request did not find any hosts that passed the

filter limits.

TABLE 6-2 Discovery Requests Window Buttons

Button Description

Add Click this button to create a new Discovery Request through the

New Discovery Request window (FIGURE 6-2).

Modify Select a Discovery Request and click this button to make changes.

Duplicate Select a Discovery Request and click this button to create a copy of

the request.

Delete Select a Discovery Request and click this button to delete the

request.

Start Select a Discovery Request that is not running and is not scheduled

to run at a different time, and click this button to start the request.

Stop Select a Discovery Request that is running and click this button to

stop the request.

Log Select a Discovery Request and click this button to see a log of the

results generated from the selected discovery request runs.
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Initiating a Discovery Request

You can discover hosts by using the ping command or by using routing tables.

Note – Currently the Discovery feature is supported only for administrative

domains and not for any subordinate groups. You can add requests only for an

administrative domain.

Note – Read Appendix F before initiating a discovery request using routing tables.

Appendix F explains the basic concepts of routing, network classes, and netmasks.

Note – For additional information, refer to your supplement. The supplement

contains important platform-specific information about discovering objects.

▼ To Initiate a Discovery Request

1. Click the Add button in the Discovery Requests window.

The New Discover Request window is displayed (FIGURE 6-3). The Discover tab is

highlighted by default.

Tip – You can copy an existing discovery request by highlighting the existing

request and clicking the Duplicate button. To edit the settings for the new discovery

request, see “Modifying a Discovery Request” on page 115.
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FIGURE 6-3 New Discover Request Window

2. (Optional) Type a new name for your discovery request in the Request Name
field.

Multiple requests are listed in the Discovery Requests window, enabling you to

select a request and edit the related search pattern.
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3. In the Discover Using field, select the method that should be used for discovering
the network (Ping or Routing Table).

■ If you selected Ping, type the start and end IP addresses and netmask (FIGURE 6-3).

The discovery process uses the Ping command and searches for hosts and routers

in the specified IP address range. It then places the hosts in the appropriate

networks and subnets based on the netmask.

■ If you selected Routing Table, type the number of hops (the number of routers a

packet goes through before reaching its destination).

The discovery process starts from the Topology manager/ Sun Management

Center server host and goes through the specified number of hops to report

subnets and hosts n hops away. The number of hops limits the “distance” of

destination hosts from the host on which the Topology manager or Sun

Management Center server is running.

Note – Routing Table discovery requests require that you run an SNMP agent at

port 161. This can be a Sun Management Center agent, snmpdx , or any SNMP agent

provided by your network management package.

For more information on routing tables, see Appendix F.

4. Click the OK button to start the discovery process, or go to the other tabs in this
window to customize your discovery request. See “Customizing Your Discovery
Request” on page 108.

When you start the discovery process:

■ The discovery process discovers all nodes that are running the Sun Management

Center 2.1 agent, when the nodes are all located in the same Sun Management

Center server context. The discovery process does not include agent nodes that

belong to another Sun Management Center server context. That is, nodes that are

running Sun Management Center agents in a remote Sun Management Center

server context are ignored.

■ Nodes that are not running a Sun Management Center agent are listed as ping

hosts.

■ The discover process discovers all nodes running an SNMP agent, where the

nodes are not connected to any Sun Management Center server. The information

gathered for SNMP agents is very limited.

Note – Each discovery request is assigned a Request ID. This ID is an unique Sun

Management Center internal identifier of the request. Therefore, the Request IDs are

not in sequential order. The Request ID displays in the Request Details portion of the

Discovery Requests Window.
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Note – If a host is extremely busy, a discovery process that is gathering data for that

host may time out. If a timeout occurs for a host that is a Sun Management Center

agent, the host is reported as a ping host. If this happens, you may want to increase

the SNMP timeout period. See ““Customizing Your Discovery Request” on

page 108” for more information.

5. If a Sun Management Center server or agent is incorrectly reported to be a ping
host, create a new icon by re-running discovery with larger timeout and retry
values.

Customizing Your Discovery Request

You can customize your new discovery request by clicking on one of the four tabs on

the New Discover Request window. The tabs are labelled Discover, Preferences,

Filters, and Scheduling. TABLE 6-3 summarizes the tabs and the options for these tabs.

(If you want to change an existing Discovery Request, see “Modifying a Discovery

Request” on page 115).

TABLE 6-3 Summary of Discovery Variables

Variable Definition

Discover

Request Name Descriptive name for this request, for example, “My Lab.” This name is

optional.

Discover Using Ping: Sweeps all addresses within the range specified by Start IP Address

and End IP Address. Alternatively, you can supply the value of the

netmask and let the Discovery Manager calculate the end address, using

Start IP Address.

Routing Table: Discovery Manager consults the routing table of the Sun

Management Center server and determines its address, subnet address,

and router(s). It proceeds from there to discover more routers, networks,

and subnets.

Start IP Address

End IP Address

These parameters apply to ping discovery requests. They specify the

address range within which the Discovery Manager tries to find hosts and

routers.

Netmask This parameter applies to ping discovery requests. It is used to segment

networks into subnets.

To find out if your network is subnetted and the value of the netmask,

check the /etc/netmasks file or the name service maps if you are using

NIS (network information service) or DNS (domain name service).
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Port Port 161 is the default setting for Sun Management Center objects. The

Discovery Manager also tries an alternate port that you can specify in the

Also Check Port field. If neither port responds, the Discovery Manager

concludes that the object is not running a Sun Management Center agent.

Preferences

Logging

Log discover request progress? Setting this flag enables logging for that request. The discovery process

places the log files in the /var/opt/SUNWsymon/cfg/discover
directory. There is one log file per user-administrative domain. Currently,

this directory is used for debugging only.

Ping

Timeout (sec.) Amount of time (in seconds) that the Discovery Manager should wait for a

response to a ping request before timing out.

Retries Number of times the Discovery Manager should send a ping request

before giving up.

SNMP

Timeout (sec.) Amount of time that the Discovery Manager should wait for a response to

a SNMP request before timing out.

Retries Number of times the Discovery Manager should attempt a SNMP request.

Community String One or more strings separated by the pipe (|) character. The default value

is public.

General

Maximum Hosts Maximum number of hosts that should be discovered.

Maximum Time (sec.) Maximum amount of time (in seconds) of the discovery process in real

time.

TABLE 6-3 Summary of Discovery Variables (Continued)

Variable Definition
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▼ To Customize a Discovery Request

You can specify limits for the New Discover Request window through the

Preferences and Filters tabs. You can also schedule the new discovery request to run

periodically through the Scheduling tab.

1. Click the Preferences tab.

The New Discover Request Preferences window is displayed (FIGURE 6-4).

Filters

Criteria

Select Filter Criteria

Host Names

Operating System

Platform Type

Filter by host name, operating system, or platform type. Filtering uses the

grep command to search for the supplied value.

Filters This field remains blank until you select a filter criteria. The contents of

this field vary according to your selection(s). You can choose to include or

exclude values in the filtering process. For host names, you specify names

and wildcard characters. For operating systems and platform types, you

select from pull-down menus.

Scheduling

Scheduling

Discover new hosts periodically? If selected, then the specified discovery request is scheduled to run at the

specified start time and frequency.

Settings

Start Time (hh:mm) Specify the time (between 00:00 and 23:59) when discovery should be

started.

Frequency In the pull-down menu, select Hourly, Daily, Weekly, or Monthly.

Day of Week In the pull-down menu, select the day when discovery should run.

Day of Month (1..28) Specify the (numerical) day of the month when discovery should run. You

cannot enter a day unless you have selected Monthly as the frequency.

TABLE 6-3 Summary of Discovery Variables (Continued)

Variable Definition
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FIGURE 6-4 New Discover Request Preferences Window

2. Type your selections in the Logging, PING, SNMP, and General fields.

TABLE 6-3 lists the variables in the New Discover Request Preferences window.
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3. Click the Filters tab.

The New Discover Request Filters window is displayed (FIGURE 6-5).

FIGURE 6-5 New Discover Request Filters Window
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4. Click one or more boxes for host names, operating system, or platform type.

By default, the Filters area is blank. As you select each box, the Filters area adds new

fields. These fields enable you to include or exclude items in the discover search, and

to specify the host names, operating systems, and platform types to be included or

excluded.

Note – If you use a filter, the discovery finds only hosts running the Sun

Management Center agent.

5. Click the Scheduling tab.

The New Discover Request Scheduling window is displayed (FIGURE 6-6).
Chapter 6 Discovery Manager 113



FIGURE 6-6 New Discover Request Scheduling Window

6. If you want to schedule automatic discoveries, click the button for “Periodically
discover new hosts?” and customize the settings in the Settings area of the
window.
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7. When you have finished your edits, click OK to save the new discovery request, or
click Cancel to cancel your changes.

If you click OK and you have not selected Periodically discover new hosts in the

Scheduling tab, a pop-up dialog is displayed, offering several choices for running

the new discovery request.

■ To save the discovery request and begin running it periodically at the scheduled

times, click Yes.

■ To save the discovery request, but not schedule it to run, click No.

■ To cancel the new discovery request without saving it, click Cancel.

8. Click Close to exit the window.

Modifying a Discovery Request

If you have previously created a periodic discovery request, you can change the

search patterns for that discovery request through the Discovery Requests window

(FIGURE 6-2).

▼ To Modify a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 6-1).

The Discovery Requests window is displayed.

2. Find and select the name of the discovery request you want to modify.

3. Click the Modify button.

The Edit Discover Request window is displayed. As confirmation, the top bar of the

window displays the ID of the request and the Description field displays the name

of the request.

4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change
settings as needed.

5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.

If you click OK, a pop-up dialog is displayed, offering several choices for running

the modified discovery request.

6. Exit from the window:
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■ To start the discovery request and run it immediately, click Yes.

■ To schedule the discovery request, but not run it immediately, click No.

■ To cancel the running of the discovery request entirely, click Cancel.

Starting, Stopping, or Deleting a
Discovery Request

If you have previously created a discovery request, you can start, stop, or delete it

through the Discovery Requests window (FIGURE 6-2).

▼ To Start, Stop, or Delete a Discovery Request

1. Select Tools ➤ Discover in the main console window (FIGURE 6-1).

The Discovery Requests window is displayed.

2. Select the name of the discovery request you want to modify.

3. Click the Start, Stop, or Delete button to start, stop, or delete a request,
respectively.
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CHAPTER 7

Sun Management Center Software
Main Console Window

The Sun Management Center software main console window (FIGURE 7-1) has the

following regions:

■ Main Console Window

■ Administrative Domain View

■ Hierarchy View

■ Topology View

■ Menu Bar

■ Navigation Buttons

■ Sun Management Center Administrative Domains Pull-Down Menu

■ Administrative Domain Status Summary

Main Console Window

The main console window (FIGURE 7-1) is the primary user interface. It provides:

■ Visual representations of the managed objects (for example, hosts and networks)

■ Ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm threshold conditions).

The features shown in FIGURE 7-1 are described in this chapter.
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FIGURE 7-1 Main Console Window
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Administrative Domain View

Once you have created an administrative domain and have populated it with objects

(groups and hosts, and so forth), you can see the administrative domain and its

objects in the hierarchy (tree) view and the topology (regional) view of this

administrative domain.

The administrative domain view enables you to build collections of objects that

support your monitoring and management tasks. You can group your host sets by

buildings, subnets, or other group objects. You can selectively view all objects (such

as hosts, routers, and servers) in the administrative domain, or selected objects (such

as the servers) that support a specific function that interests you.

The Domain view shows you the objects contained in an administrative domain; the

administrative domain itself, and any groups and hosts contained in that

administrative domain.

FIGURE 7-2 illustrates an example of an administrative domain. In this example,

Headquarters represents an administrative domain that consists of all the host

machines in the headquarters office. The host machines are found in one geographic

(campus) site. The campus has two buildings, and each building contains a network,

subnet, group, and host machines.

You may choose to create a similar type of administrative domain, and you can

group your machines by subnet, rather than by building. You should create a

administrative domain and its subordinate groups in a hierarchy that best supports

your monitoring activities.

For more information on administrative domains, see Chapter 4.

The main console window (FIGURE 7-2) displays two views of an administrative

domain and its members. The left side of the administrative domain view is the

hierarchy (tree) view and the right side is the topology view.

■ Hierarchy tree

The hierarchy tree view displays the relationship between a administrative

domain and its members. Some objects in the hierarchy view contain other objects

which can be a group of objects or a single object. Some objects are both.

In FIGURE 7-2, Building B is an object contained in the administrative domain

named Headquarters, but is also a group itself. Building B contains the network

194.150.151.52, the subnet mpk12-238-n, GroupA, and hosts machineA and

machineB.

For more information, see “Hierarchy View” on page 120.
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■ Topology view

The topology view displays the member(s) of an object selected in the hierarchical

tree.

In FIGURE 7-2, the selected object in the hierarchy tree is MachineA.

For more information, see “Topology View” on page 122.

FIGURE 7-2 Main Console Window With Hierarchy and Topology Views

Hierarchy View

Two types of windows contain hierarchy views:

■ Domain view in the main console window (FIGURE 7-1)

■ Browser view in the Details window (FIGURE 14-2)

Hierarchy view
(hierarchical tree)

Topology view
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The administrative domain hierarchy view displays the administrative domain and

its members.

The Browser hierarchy view displays the host and its modules. This view is part of

the Browser Details window (Chapter 8).

Both the administrative domain hierarchy view and the Browser hierarchy view

behave in the same manner. In both windows, the hierarchy view is on the left side

of the window.

The mouse actions in the hierarchy view are summarized in TABLE 7-1.

▼ To Obtain Specific Information About the Hierarchy View

If an object has an expansion/compression next to it, there are additional levels of

information that are hidden. You can obtain more information about the object by

examining its subordinate objects. To obtain specific information about subordinate

objects, complete the step in one of the following methods.

Method 1

● Click on the expansion/compression icon next to the object to “unroll” the tree
branch.

The icon changes to a darker color, and the subordinate objects are displayed.

TABLE 7-1 Mouse Actions in the Hierarchy View

Mouse Action Result

Click with left or right mouse button on the

expansion/compression icon next to the object

“Expands” (opens) details or “collapses” (closes)

details of the selected object.

Double-click with the left mouse button on an object

icon

For a host object, starts the Details window or moves

the Details window to the foreground if it is already

open. For an administrative domain or group object,

unrolls or rolls details of the selected object. Also, the

topology view is updated with the members of the

selected object.

Click with the left mouse button on object icon Displays the members of the selected object in the

topology view. However, if the object icon is a host

(in the main console window), then the Details

window is displayed.

Click with the right mouse button and hold on the

object label

Pop-up menu is displayed. See “Pop-up Menu” on

page 124 for more information.
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Method 2

● Double-click with the left mouse button on the object icon or the label.

▼ To Obtain General Information About the Hierarchy View

If an object has a compression icon next to it, lower levels of the hierarchy are

currently displayed (in most cases). You can obtain information about the container

object by “rolling up” (hiding) the lower levels. To obtain general information about

a container object, complete the step in one of the following methods.

Method 1

● Click on the expansion/compression icon next to the object to “roll up” the tree
branch.

The group (container) object is displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

Topology View

The topology view displays the members of the object selected in the hierarchy view.

There are two types of windows that contain topology views:

■ Domain view in the main console window (FIGURE 7-1).

■ Browser contents view in the Details window (Chapter 8).

Both the administrative domain and browser contents views behave in the same

manner.
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The mouse actions in the topology view are summarized in TABLE 7-2.

Tool Tip

As you move the mouse over various areas in the main console window, tool tips are

displayed momentarily. A tool tip is a description of the selected object or a

description of a property and value column of any data property table (Chapter 9).

Property tables provide information about the monitored property and are described

in Appendix C and Appendix D.

▼ To See a Tool Tip

● Place your mouse over an object.

After a brief delay, a tool tip is displayed that provides a short description of that

object (FIGURE 7-3).

TABLE 7-2 Mouse Actions in the Topology View

Mouse Action Result

Double-click with the left mouse

button on the icon

Opens details about the selected object. However, if the object is a

host (in the main console window), then the Details window is

displayed.

Click with the left mouse button on the

icon

Selects icon.

Click with the right mouse button and

hold on the icon

Pop-up menu is displayed. See “Pop-up Menu” on page 124 for

more information.
Chapter 7 Sun Management Center Software Main Console Window 123



FIGURE 7-3 Tool Tip

Pop-up Menu

Pop-up menus are available for all objects in the hierarchy and topology views. The

contents of a menu vary according to the capability of the object selected.

▼ To Access a Pop-Up Menu

1. Click the right mouse button on the object.

The pop-up menu is displayed.

Tool tip
124 Sun Management Center 2.1 Software User’s Guide • November 1999



2. Click the left button to select a menu item (TABLE 7-3).

The following table lists common items in the approximate order in which they are

displayed in the pop-up menus. Some items are not displayed in all menus.

Note – Depending on the object you selected, all the pop-up menu items listed in

TABLE 7-3 may not be displayed.

Menu Bar

The menu bar is at the top of the main console window (FIGURE 7-4).

FIGURE 7-4 Menu Bar

TABLE 7-3 Common Pop-Up Menu Items

Menu Item Description

Cut Cuts the selected object. The cut object is enclosed in a dashed box

until it is pasted into a new location. To cancel the cut operation,

click on the object.

Copy Copies the selected object.

Rename Displays the Rename Object window.

Modify Displays the Modify Object window.

Attribute Editor Displays the Attribute Editor. For information about editing an

administrative domain, see Chapter 4. For information about

editing a host, see Chapter 10. For information about editing a

module, see Chapter 12. For information about editing security, see

Chapter 15.

Load Module Displays the Load Module dialog. For more information on the

Load Module dialog, see “To Load a Module” on page 229.

Details Displays the Details window. For more information on the Details

window, see Chapter 14.

Menu bar
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Select (highlight) an object by clicking it in the hierarchy or topology view, then click

a menu name (File, Edit, View, Go, or Tools). If a menu name is grayed out, that

option is not available for the object that you have selected.

▼ To Use the Main Console Window Menu Bar

The menus are of the pull-down style.

1. Click an entry in the menu bar to display a pull-down menu.

2. Click an entry in the pull-down menu to initiate that action.

The menus in the menu bar are described below.
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File Menu Options

Edit Menu Options

TABLE 7-4 Options for the File Menu

Option Description

Domain Manager The Domain manager enables you to create your

administrative domain(s). For more information on Domain

Manager, see Chapter 4.

Remote Domain Manager For more information on Remote Domain Manager, see

Chapter 4.

Set Home Domain Sets your home administrative domain.

Sun Management Center-

Console Messages

Opens the Sun Management Center-Console Messages

window. The window displays messages generated by the

Sun Management Center application, but does not include

general UNIX messages.

Exit Exits the current console session and all related Sun

Management Center windows. A pop-up dialog asks you to

confirm the exit request.

TABLE 7-5 Options for the Edit Menu

Option Description

Create an Object Creates a group, a composite object, a node, or a network

segment in the administrative domain that is currently

highlighted in the console window. See Chapter 5.

Create a Connection Connects two objects in the topology view. You may choose the

type of connection to be General, RS-232, T1, or T3. The

connection is represented by a line between the objects.

Delete Object/Connection Deletes the highlighted object or connection. A dialog asks you

to confirm the deletion request.

Rename Enables you to rename the highlighted object. Displays a dialog

for you to enter the new name.

Modify Brings up the Modify Object menu. For more information on

the Modify Object menu, see “Modifying Objects” on page 94.

Cut Displays a dashed line around the selected object. The object is

not removed until you paste it into a new location.

Copy Copies the selected object into a temporary buffer.
Chapter 7 Sun Management Center Software Main Console Window 127



View Menu Options

Paste Pastes the cut or copied object into the administrative domain

or group that is currently displayed in the hierarchy or the

topology view.

Paste Into Pastes the cut or copied object into the selected administrative

domain or group.

Select All Selects all objects in the topology view.

TABLE 7-6 Options for View

Option Description

Topology Layouts Enables you to change the style of display in the topology view. The

styles are:

Network,

Grid (square grid pattern),

List (single vertical list),

Bus,

Star (equidistant lines connected to a center),

Spoked Ring (equidistant lines in a circle).

Set Topology

Background

Displays the Set Topology Background window. You can add a

background image to a topology view by selecting from a list of

graphics files. (The list may not be in alphabetical order.) You can

also use this window to remove a background image by clicking the

Unset button.

TABLE 7-5 Options for the Edit Menu (Continued)

Option Description
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Go Menu Options

Tools Menu Options

TABLE 7-7 Go Menu Items

Menu Item Action

Back Takes you to the previous console view.

Forward Takes you to the next console view (if applicable).

Home Takes you to the top of your home administrative domain in the

hierarchy view.

Up Takes you up one level in the hierarchy view.

History Lists recent locations that you have viewed in the current console

session. Select an entry to return to that location.

Search Opens the Topology Search window to search for the object label

that you specify. If one or more objects are found, the full path or

paths are displayed.

TABLE 7-8 Tools Menu Items

Menu Item Action

Details Enables you to see detailed information (if available) for a selected

object. For more information about the Browser Details window, see

Chapter 8. For more information about the Details Alarm window,

see Chapter 13. For more information about the remaining

categories in the Details window, see Chapter 14.

Attribute Editor Displays the Attribute Editor. For information about editing an

administrative domain, see Chapter 4. For information about

editing a host, see Chapter 10. For information about editing a

module, see Chapter 12. For information about editing security, see

Chapter 15.

Graph Displays the Open Graph window. You can select from a list of

saved graphs. For information on the graphing function, see

Chapter 9.
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Navigation Buttons

As you move through different administrative domains and through different levels

within the administrative domains, the administrative domain views are stored in

memory. The navigation buttons (FIGURE 7-5) in the main console window help you

move back and forth between these views.

FIGURE 7-5 Navigation Buttons

Discover Enables you to search for objects in a geographical location. For

information about the Discovery Requests window, see Chapter 6.

Load Module Enables you to load a Sun Management Center module for a

selected object. For information about the Load Module window,

see Chapter 12.

External User

Applications

If you have installed external user applications such as Telnet or File

Transfer Protocol (FTP), they are displayed as a menu item on the

Tools Menu, and can be launched from this menu. The selected

application is displayed in a separate window. The application has

no further interaction with the Sun Management Center software

(except that you are able to launch it from within the Sun

Management Center software for your convenience.)

TABLE 7-8 Tools Menu Items

Menu Item Action

Back button

Forward
button

Home
button

Up
button

Search
button

Help button
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Note – The navigation buttons perform the same function as the Go menu items.

▼ To Search For a Name

1. Click on the search button (FIGURE 7-5).

The Topology Search window is displayed (FIGURE 7-6).

2. Type the name or part of the name in the Object Label: field and click the Search
button.

A list of matching names is displayed in the Objects Found section.

3. Highlight the appropriate name and click on the Go To button.

The topology view of the main console window is updated and the object with the

selected name is highlighted.

TABLE 7-9 Navigation Buttons

Button Description

Back Button The back button is represented by an arrow facing left (FIGURE 7-5).

Clicking this button displays the previous screen.

Forward Button The forward button is represented by an arrow pointing right

(FIGURE 7-5). Clicking this button displays the next screen.

Home Button The home button is represented by a house (FIGURE 7-5). Clicking

on this button returns you to the highest level of the administrative

domain.

Up Button Clicking the up button enables you to navigate up one level in the

topology view.

Search Button The search button enables you to search for a text string in the

current domain.

Help Button Clicking the Help button (FIGURE 7-5) displays the online Sun

Management Center 2.1 Software User’s Guide.
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FIGURE 7-6 Topology Search Window

Sun Management Center Administrative
Domains Pull-Down Menu

The Sun Management Center Administrative Domains pull-down menu is shown in

FIGURE 7-7. This menu displays the current list of administrative domains and

enables you to switch from one administrative domain to another. Clicking on the

administrative domain updates and displays the selected administrative domain.
132 Sun Management Center 2.1 Software User’s Guide • November 1999



The default administrative domain is the administrative domain that is always

displayed whenever the main console is started.

FIGURE 7-7 Administrative Domains Pull-Down Menu

▼ To View the Current List of Administrative

Domains

1. In the main console window, click the Sun Management Center Administrative
Domains button.

The pull-down menu with the current list of administrative domains is displayed.

2. Click the administrative domain that you want to view.

The main console window is updated and displays the selected administrative

domain. The Sun Management Center Administrative Domains button changes to

display the name of the administrative domain you have selected.
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Administrative Domain Status Summary

The administrative domain status summary displays the number of managed objects

that have unacknowledged open alarms, by level of severity, in the selected

Administrative Domain. (FIGURE 7-8).

Note – If a host has multiple alarms at several different severity levels, the host is

represented at only one severity level (the highest severity level for that host).

For more information on the administrative domain status summary, see “Seeing

Alarms in Domain Status Summary” on page 258.

FIGURE 7-8 Domain Status Summary
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CHAPTER 8

Browser

This chapter covers the following topics:

■ To Start the Details Window

■ To Set Security for a Host or Module

Details View

The details view is a subset of the Domain view. The highest hierarchical object in a

details view is the host machine or module object. For more information on module

objects, see “To Create a Module Object” on page 79. Unlike the administrative

domain view, the details view enables you to see modules and the various

monitored properties and statistics contained in the modules.

Using the Details Window

You can start the Details window from the main console window.

The Details window provides you with detailed information about that individual

host. This window has several tab buttons, that may include the following:

■ Info

■ Browser

■ Alarms

■ View Log

■ Applications

■ Hardware
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Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. In addition, the Hardware tab is missing if the

Config-Reader module is not supported on your system. For additional information

on the tabs for your specific hardware object, see your supplement.

Each tab button, as described in the following table, updates the window with a new

panel consisting of information represented by that tab button.

For more information on these buttons, see Chapter 14.

▼ To Start the Details Window

● Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Details from the

pop-up menu in the hierarchy view (FIGURE 8-1) or the topology view.

■ With your left mouse button, double-click on the selected host icon in the

hierarchy view or the topology view.

TABLE 8-1 Details Window—Common Tab Buttons

Tab Button Description

Info Provides general information about the host including host name,

IP address, polling type, and so on. This information is collected at

the time the object is created.

Browser Enables you to navigate through the hierarchy and contents views

of the host, set alarm thresholds, and view and graph monitored

data properties. This is the default view when the Details window

opens.

Alarms Displays the alarms for this host. Enables you to acknowledge or

delete alarms.

View Log Displays informational messages, including error messages, about

your host. Enables you to search, monitor, and examine system and

EntDiag log messages.

Applications Displays a list of applications. These applications include the

processes running on the host (if the Solaris Process Details module

is loaded) and other applications installed by the user.

Hardware Displays hardware configuration information about your host for

selected hardware platforms. Configuration information may

include the physical and logical view of your host. If the hardware

platform is not supported by the Config-Reader module, this tab

button is missing in the Details window.
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■ In the main console window, select the object then select Tools ➤ Details

(FIGURE 8-2).

Be sure to select a managed object, not a administrative domain, as the Details

window is not available for administrative domains.

The Details window (with the browser tab pre-selected) is displayed.

FIGURE 8-1 Opening the Details Window from the Pop-Up Menu
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FIGURE 8-2 Opening the Details Window from the Tools Menu

▼ To Exit the Details Window

● Click the Close button located at the bottom of the Details window.
138 Sun Management Center 2.1 Software User’s Guide • November 1999



Browser Tab

The host contains four subordinate groups: hardware, operating system, local

applications, and remote systems. The Sun Management Center modules belong to

one of these four categories.

Sun Management Center software monitors hosts by using modules. Modules are

software components that monitor data pertaining to the health indicators and

resources of systems, applications, and network devices.

FIGURE 8-3 is an example of the host view for MachineA . The left side of the host

view is the hierarchy (tree) view and the right side is the contents view. The host

hierarchy view displays the relationship between the host and its modules. In this

example, the loaded operating system modules are the MIB-II Instrumentation and

the Kernel Reader modules.

By using the Browser Details window, you can set alarm thresholds and view and

graph monitored data properties for your host.
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1

FIGURE 8-3 Browser Details Window

The Browser tab (FIGURE 8-3) contains the hierarchy and contents view for a host.

Hierarchy view

Contents view
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FIGURE 8-4 Click a Compressed Icon to “Unroll” Additional Levels of Detail

Tip – You may be able to see more information by holding the mouse pointer over

the object for several seconds. A pop-up balloon (tool tip) is displayed, showing

additional information about the object. These tool tips are also displayed for data

property table cells and are useful if information in a table cell is too long to display

completely.

Expanded
icon

Compressed
icon
Chapter 8 Browser 141



Tip – The hierarchy can be expanded or compressed, depending on the position of

the expansion/compression icon (FIGURE 8-4). The icon is compressed when the

“handle” is pointing right. The icon is expanded when the “handle” is pointing

down.

Each host contains categories for Hardware, Operating System, Local Applications,

and Remote Systems. For more information on modules, see Appendix C and

Appendix D.

Hardware

The Hardware category consists of the Config-Reader module, which monitors the

host configuration, including information and status for power supplies, keyswitch,

fans, remote console, the system in general, and so on.

There are different Config-Reader modules for different hardware platforms. If your

system is supported by a Config-Reader module, it is automatically loaded during

installation.

For more information on the Config-Reader module for your hardware platform,

refer to your supplement.

Operating System

The Operating System category includes modules that monitor the operating

environment of the host:

■ Directory Size Monitoring

■ File Monitoring

■ Kernel Reader

■ MIB-II Instrumentation

■ NFS File Systems

■ NFS Statistics

■ Simple MIB-II

■ Solaris Process Details
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Local Applications

The Local Applications category includes modules that monitor the local

applications on the host:

■ Agent Statistics

■ Data Logging Registry

■ Dynamic Reconfiguration

■ File Scanning

■ Health Monitor

■ Print Spooler

■ Process Monitoring

Remote Systems

The Remote Systems category includes modules that monitor remote systems:

■ MIB-II Proxy Monitoring module

■ HP JetDirect module (monitors HP printers equipped with a JetDirect card)

Browser Buttons

The Browser Details window includes a row of buttons at the top of the panel. The

Module and Options buttons enable you to select one of several choices. The

Attributes, Graph, Probe, and Refresh Now buttons serve a single purpose. The

buttons and their functions are described in the following table.

TABLE 8-2 Browser Buttons

Menu Item Definition

Module Available selections for the Module button (FIGURE 8-5) are Load

Module, Edit Module, Enable Module, Disable Module, and Unload

Module, as described below.

Load Module Enables you to add a module to the host. The host must be selected

or this option is grayed out. For more information, see “To Load a

Module” on page 229.

Edit Module Enables you to edit module parameters. The module must be

selected or this option is grayed out. For more information, see “To

Edit Module Parameters” on page 239.

Enable Module Enables you to enable a module. The module must be selected or

this option is grayed out. For more information, see “To Enable a

Module” on page 242.
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Note – The browser buttons are grayed out when the command is not appropriate

for the selected object.

Disable Module Enables you to disable a module. The module must be selected or

this option is grayed out. For more information, see “To Disable a

Module” on page 241.

Unload Module Enables you to unload a module from the host. The module must be

selected or this option is grayed out. For more information, see “To

Unload a Module” on page 242.

Options Available selections for the Options button (FIGURE 8-6) are Copy,

Copy to Graph Clipboard, Add Row, Enable Row, Disable Row, Edit

Row, and Delete Row, as described below.

Copy Enables you to copy a module. You may paste the copied module in

the topology or hierarchy view of the main console. This enables

you to monitor the module properties without having the Details

window open. For more information, see “To Create a Module

Object” on page 79.

Copy To Graph

Clipboard

Enables you to add another data property (with the same units) to

an existing graph. Used with Add From Graph Clipboard menu

item in graphing window. See “To Graph Two Data Properties” on

page 165.

Add Row Adds a row to a data property table. See “To Add a Row (for the

File Monitoring, File Scanning, and Process Monitoring Modules)”

on page 153.

Enable Row Enables a row (that has been disabled) in a data property table.

Disable Row Disables a row in a data property table.

Edit Row Enables you to edit information for a row in a data property table.

Delete Row Deletes a row in a data property table.

Attributes Displays the attribute editor for the selected object. The Attribute

Editor provides additional information about the selected object

and the rules governing its behavior. Use the Attribute Editor to

edit information about the object.

Graph Graphs the selected monitored data property.

Probe Enables you to run selected commands on the monitored data

property.

Refresh Now Refreshes the information in the displayed data property table.

TABLE 8-2 Browser Buttons (Continued)

Menu Item Definition
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FIGURE 8-5 Module Menu Options in Details Window

FIGURE 8-6 Options Menu Options in Details Window
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Host Security

In the Details window, Sun Management Center software offers security at two

levels: the host itself and at the module level. You may also set security at the host

level only. In this case, anyone with the appropriate security can load modules, set

alarm thresholds, acknowledge alarms, and so on.

You may also set security permissions at the module level. In this case, only those

users with the appropriate module permissions can perform actions on the module.

Module security can be used as a “subset” of host security.

For example, at the host level, you can set security permissions so that users A, B,

and C can load modules and create alarm thresholds. User A loads the Health

Monitor module and creates customized alarm thresholds. However, users B and C

can change user A’s work unless security permissions have also been set at the

Health Monitor module level, enabling only user A to set alarm thresholds.

Note – In the case where security is set at both levels, the security permissions at

the module level take precedence over the security permissions at the host level.

Consequently, only user A can create alarm thresholds for the Health Monitor

module.

For more information on security, see Chapter 15.
146 Sun Management Center 2.1 Software User’s Guide • November 1999



FIGURE 8-7 Attribute Editor for a Host or Module
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▼ To Set Security for a Host or Module

1. Open the Attribute Editor for a host or module by proceeding with one of the
following:

■ Click the right mouse button on the host or module and highlight Attribute

Editor from the pop-up menu.

■ Click the Attributes button.

2. Click the Security tab (FIGURE 8-7).

3. Type the name(s) of user and administrator groups in the appropriate fields.

For more information on the security fields, see Chapter 15.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request and close the window.
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CHAPTER 9

Monitoring and Graphing Data
Properties

This chapter covers the following topics:

■ To Display a Data Property

■ To Add a Row (for the File Monitoring, File Scanning, and Process Monitoring

Modules)

■ To Refresh Displayed Data

■ To Probe a Property

■ To Graph A Monitored Data Property

■ To Graph Two Data Properties

■ To Save Graphing Parameters

■ To Open a Graph

■ To Apply a Graph Template

Monitoring Data Properties

Using your mouse, you can navigate through the hierarchy (tree) view in the Details

window to view the monitored properties.

The lowest-level object in the host hierarchy is the monitored property. The software

provides both tabular and graphical information about a monitored property.

Once the data has been displayed, you can refresh the data. In addition, you can

graph up to five data properties simultaneously. These actions are described in the

following sections.
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▼ To Display a Data Property

Note – The following example uses the Kernel Reader module.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Kernel Reader icon in the contents view or single click in the
expansion/compression icon next to the Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

3. Double-click on the System Load Statistics icon in either the hierarchy or the
contents view (FIGURE 9-1).

The monitored properties are displayed in a property table.
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FIGURE 9-1 System Load Statistics
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Working with Rows

For selected modules, the software enables you to add, delete, enable, or disable

rows for the data property tables (TABLE 9-1). When these modules are initially

loaded, the data property tables are empty (except the Directory Size Monitoring

and Print Spooler modules). For the File Monitoring, File Scanning, and Process

Monitoring modules, you must “add a row” to monitor the data property.

For more information on the directory size monitoring and file monitoring modules,

see Appendix C. For more information on the file scanning, print spooler, and

process monitoring modules, see Appendix D.

▼ To Define a Directory

The following example procedure uses the Directory Size Monitoring module. If this

module is not loaded, see “To Load a Module” on page 229.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the expansion/compression icon next to the Directory Size Monitoring
icon in the hierarchy view.

The Directory Size Monitoring Status folder is displayed.

TABLE 9-1 Sun Management Center Modules That Enable You to Add Rows

Module Name Description

Directory Size

Monitoring

Each added row enables you to define another directory for

monitoring.

File Monitoring Each added row defines the monitored “file”.

File Scanning Each added row defines the “pattern” that must be matched within

the monitored file.

Print Spooler Each added row enables you to define another printer for spooler

monitoring.

Process Monitoring Each added row defines the “pattern” that must be matched from

all the processes that are running on the agent object.
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3. Double-click on the Directory Size Monitoring Status folder in either the
hierarchy or the contents view.

The Directory Monitoring property table is displayed.

FIGURE 9-2 Directory Size Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu.

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed.

5. Type the appropriate information in the text fields.

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view.

▼ To Add a Row (for the File Monitoring, File

Scanning, and Process Monitoring Modules)

The following example procedure uses the File Monitoring module. If this module is

not loaded, see “To Load a Module” on page 229.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.
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2. Double-click on the File Monitoring icon in the contents view or single click in
the expansion/compression icon next to the File Monitoring icon in the hierarchy
view.

The File Monitoring Status folder is displayed.

3. Double-click on the File Monitoring Status folder in either the hierarchy or the
contents view.

An empty property table is displayed.

FIGURE 9-3 File Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu (FIGURE 9-3).

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed (FIGURE 9-4).

5. Type the appropriate information in the text fields.
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FIGURE 9-4 Row Adder Window for the File Monitoring Module

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view (FIGURE 9-5).
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FIGURE 9-5 Updated File Monitoring Table

Note – The Row Adder window that is displayed is dependent on the selected

module. FIGURE 9-6 and FIGURE 9-7 illustrate examples of the Row Adder window for

the File Scanning and Process Monitoring modules, respectively.
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FIGURE 9-6 Row Adder Window for the File Scanning Module
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FIGURE 9-7 Row Adder Window for Process Monitoring Module

▼ To Add a Printer

The following example procedure uses the Print Spooler module. If this module is

not loaded, see “To Load a Module” on page 229.
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1. In the Browser Details window, double-click on the Print Spooler icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Print Spooler icon in the contents view or single click in the
expansion/compression icon next to the Print Spooler icon in the hierarchy view.

The Print Spooler folder is displayed.

3. Double-click on the Print Spooler folder in either the hierarchy or the contents
view.

Three property tables are displayed; these are Lpsched Status, Printer Devices Table,

and Printer Queues Table.

FIGURE 9-8 Print Spooler Property Tables

4. Proceed with one of the following:

■ Click the right mouse button in the Printer Devices table row and select the Add

Row command from the pop-up menu.

■ In the Details window, select Options ➤ Add Row.

The Row Adder window is displayed (FIGURE 9-9).

5. Type the appropriate information in the text fields.
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FIGURE 9-9 Row Adder Window for the Print Spooler Module

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view.
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▼ To Refresh Displayed Data

● Proceed with one of the following:

■ Click the right mouse button in the data property table row and select Refresh

from the pop-up menu (FIGURE 9-10).

■ Click the Refresh Now button.

In this example, the System Load Statistics table is updated with the latest

information.

Note – You may also set up a refresh interval and the Sun Management Center

software automatically updates your monitored data at your designated time

interval. For information on accomplishing this task, see “Refresh Tab in the

Attribute Editor” on page 194.

FIGURE 9-10 Monitored Data Property Pop-up Menu
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Probing Properties

On selected module properties, the software enables you to use pre-determined

UNIX commands including list files, the vmstat command, and so on. The Probe

button is not grayed out when probe commands are applicable for the selected

property.

Note – The Find All Recent Files probe commands for the Filesystem Usage

properties (Kernel Reader module) find only files that were created or modified less

than 24 hours ago. The Find All Files probe commands find all files regardless of the

date/time they were created or modified.

For more information on the Filesystem Usage, see “Filesystem Usage Table” on

page 367.

The following example procedure explains how to probe a property in the Directory

Size Monitoring module. If you have not done so already, load this module by

following the procedure “To Load a Module” on page 229.

▼ To Probe a Property

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the expansion/compression icon next to the Directory Size Monitoring
icon in the hierarchy view.

The Directory Monitoring Status folder is displayed.

3. Double-click on the Directory Monitoring Status folder icon in either the
hierarchy or the contents view.

The monitored data properties are displayed in a property table.

4. Proceed with one of the following:

■ Click the right mouse button in the Directory Monitoring table row and select the

List Files or Recursively List Files command from the pop-up menu (FIGURE 9-11).

■ Click the Probe button, select the appropriate command from the Probe Select

dialog (FIGURE 9-12), and click the OK or Cancel button.
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FIGURE 9-11 Probe Commands in the Pop-up Menu
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FIGURE 9-12 Probe Select Dialog

Graphing Properties

The software enables you to graph most monitored data properties (FIGURE 9-13).

▼ To Graph A Monitored Data Property

● Proceed with one of the following:

■ Click the right mouse button in any table cell containing a data property you

want to graph, and select Graph from the pop-up menu (FIGURE 9-10).
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■ Select (highlight) the desired data property, and then click the Graph button at the

top of the Details window.

The graphing window is opened and the values of the property are plotted as a

function of time. The plotting is dynamic and continues even if the graphing

window is iconified on the desktop. Plotting stops, however, if the window is closed.

Note – Placing your cursor and clicking with the right mouse button in a property

row or column displays the pop-up menu for that property.

FIGURE 9-13 Graph of System Load Statistics Average Over the Last Five Minutes

▼ To Graph Two Data Properties

1. Click the right mouse button in the data property table cell.

In this example, the Load Averages Over the Last 1 Minute table cell is selected.

2. Proceed with one of the following:

■ Click the right mouse button in the table cell and select the Copy to Graph

Clipboard command from the pop-up menu (FIGURE 9-14).

■ In the Details window, select Options ➤ Copy to Graph Clipboard.
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Note – The Copy to Graph Clipboard command works only when the units of the

data item are the same. Also, Copy to Graph Clipboard places the data on a

clipboard. The data is not actually placed on the graph until you complete the

following step.

3. Go to the graphing window in which you want the additional property to be
plotted. Select Graph ➤ Add From Graph Clipboard (FIGURE 9-15).

The second data property is added (FIGURE 9-16).

FIGURE 9-14 Copying Load Averages Over the Last One Minute to the Graph

Note – You may graph up to 5 datasets at one time on a single graph.
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FIGURE 9-15 Adding Load Averages Over the Last One Minute to the Graph
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FIGURE 9-16 Load Averages Over the Last One and Five Minutes

▼ To Save Graphing Parameters

1. Select Graph ➤ Save Graph Request As or Select Graph ➤ Save Template in the
Graphing window.

The Save Graph Request function (FIGURE 9-17) enables you to save the host name

and the data property or properties that have been graphed. Once saved, a graph of

this property on this host can be pulled up quickly from inside the graphing

window (as shown here) or from the main console window under the Tools menu. A

newly opened graph starts plotting fresh data.

The Save Template function (FIGURE 9-18) enables you to save any custom features

you have added to your graph including axis labeling, headers, footers, legend, and

so on. (For more information see “Graphing Menus” on page 171.)

2. Type the name in the Enter Graph Name or Enter Template Name fields.

3. Click the Save button to save your graph request (template) or click the Cancel
button to cancel your request.
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FIGURE 9-17 Save Graph Request Dialog
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FIGURE 9-18 Save Template Dialog

▼ To Open a Graph

1. Select Graph ➤ Open Saved Graph in the Graphing window.

The Open Graph dialog is displayed (FIGURE 9-19).

FIGURE 9-19 Open Graph Dialog

2. Select (highlight) a saved graph from the list.

3. Click the OK button to open the graph or the Cancel button to cancel your
request.
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▼ To Apply a Graph Template

1. Select Graph ➤ Apply Template in the Graphing window.

The Apply Template dialog is displayed (FIGURE 9-20). This dialog enables you to

apply saved custom features to the current graph.

FIGURE 9-20 Apply Template Dialog

2. Select (highlight) a saved template from the list.

3. Click the OK button to apply the template to the current graph or the Cancel
button to cancel your request.

Graphing Menus

There are five Graphing window menu items:

■ Graph

■ Edit

■ View

■ Tools

■ Help
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Graph Menu Items

TABLE 9-2 Graph Menu Items

Menu Item Description

Save Graph Request

as

Saves the host name and data property (properties) that are plotted.

Open Saved Graph Opens a previously saved graph.

Delete Deletes a previously saved graph.

Save Template Saves any custom changes you make on the graph.

Apply Template Applies a saved template to the current graph.

Delete Template Deletes a previously saved graph template.

Add From Graph

Clipboard

Adds an additional dataset to an existing graph. Choose this menu

item after selecting a property to “copy to graph clipboard.”

Close Closes the graphing window.
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FIGURE 9-21 Graph Menu Items

The graph utility enables you to customize the look and feel of your graphs through

the edit menu items (TABLE 9-3).

Note – Header, Footer, Axes, and Legend changes are not visible unless the view

option corresponding to that part of the graph is toggled on (TABLE 9-4).
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Edit Menu Items

TABLE 9-3 Edit Menu Items

Menu Item Description

Chart Type Changes graph type to line, area, or bar graph.

Main Titles Changes the text, font, font style, point size, and orientation of the

header, footer, legend, x-axis or y-axis title. In addition, this dialog

enables you to select and customize the border around the title.

Axes Edits the range and the spacing of the x- and y-axes. This menu

item is suggested for advanced users only (FIGURE 9-23 and

FIGURE 9-24).

Border Determines the border type (including a no border option).
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FIGURE 9-22 Edit Menu Items

Note – Editing axes requires some care in choosing the correct values. If you should

choose values for Min and Max that are impossible to plot, the dialog, in most cases,

gives you an error message describing the problem. However, if you simply choose

values that are possible, but result in the plotted points no longer being visible, you

are not warned with an error message.

FIGURE 9-23 and FIGURE 9-24 show the axes dialog for the x-axis and y-axis,

respectively.
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FIGURE 9-23 X-Axis Editing Dialog

The software chooses appropriate default x-axis values using “Autoscaling”. If you

want to change the values, then you must turn off autoscaling by unchecking the

checkbox.

You may then change:

■ Number of minutes to be plotted

■ Positioning of ticks

■ Positioning of grid lines

Note – Ticks are the small lines that mark off intervals on an axis.
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FIGURE 9-24 Y-Axis Editing Dialog

The software chooses appropriate default y-axis values using “Autoscaling”. If you

want to change the values, then you must turn off autoscaling by unchecking the

checkbox.

You may then change:

■ Minimum and maximum values shown on the y-axis

■ Major tick positions (the interval at which numerical labels are shown)

■ Minor tick positions (showing smaller intervals)

■ Grid spacing
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View Menu Items

TABLE 9-4 View Menu Items

Menu Item Description

Live Data Displays the monitored property (properties) data points.

Show Header Displays the header text.

Show Footer Displays the footer text.

Show Axis Titles Displays the x-and y-axes titles.

Show Axes Displays the x-and y-axes.

Show Grids Displays a grid pattern in the graphing window.

Show Legend Displays the legend text.

Rotate Graph Rotates the graph by 90, 180, or 270 degrees.

Flip Flips the graph over (x-axis flips the x-axis, y-axis flips the y-axis).

Reset View Resets rotate and flip options to the default (graph upright) setting.
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FIGURE 9-25 View Menu Items
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Tools Menu Items

FIGURE 9-26 Tools Menu Items

TABLE 9-5 Tools Menu Items

Menu Item Description

Zoom Toggle to turn on the zoom option, which focuses on a selected area

of the graph. Hold down the Shift key while dragging out a

rectangle with the mouse.

Translate Toggle to turn on the translate option, which moves the graphing

window side to side or back and forth. Hold down the Control key

while moving the mouse left-right or up-down.

Restore Removes the effects of the zoom and translate options; undo option.
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CHAPTER 10

Attribute Editor

This chapter covers the following topics:

■ To Open the Attribute Editor

■ To Create an Alarm

■ To Send an Email

■ To Define Your Own Alarm Action Script

■ To Set a Refresh Interval

■ To Set a History Interval

Attribute Editor for a Data Property

The Attribute Editor for a data property provides additional information about the

property and enables you to customize various monitoring criteria. You can use the

attribute editor to set:

■ Alarm thresholds

■ Actions when alarm conditions occur

■ The refresh interval

■ A logging schedule for historical data points

The Attribute Editor consists of a series of one or more tab buttons at the top of the

window that enables you to switch between different panels. The tab buttons for the

System Load Statistics data property are:

■ Info

■ Alarms

■ Actions

■ Refresh

■ History
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Note – Each Attribute Editor displays one or more of these tab buttons, depending

on the type of Attribute Editor. The Attribute Editor that is displayed is dependent

on the selected object.

▼ To Open the Attribute Editor

1. Click the right mouse button and select a data property table cell (FIGURE 10-1).

2. Proceed with one of the following:

■ Click the right mouse button in a table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

FIGURE 10-1 Selected Data Property
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Information Tab in the Attribute Editor

The Information panel (FIGURE 10-2) provides you with additional information about

the selected object.

FIGURE 10-2 Attribute Editor Info Tab for a Monitored Property
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Alarms Tab in the Attribute Editor

The Alarms panel (FIGURE 10-3) enables you to set alarm thresholds (TABLE 10-1) for

simple alarms only.

Simple alarms are based on thresholds. A monitored data property is greater than,

less than, not equal to, or equal to a single threshold value. By contrast, complex

alarms are based on a set of conditions becoming true. For more information on

alarm rules, see Appendix E.
184 Sun Management Center 2.1 Software User’s Guide • November 1999



FIGURE 10-3 Attribute Editor Alarms Tab for a Monitored Property
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TABLE 10-1 shows common simple alarm limits for monitored properties. The alarm

limits are also displayed in the Parameter Description field (FIGURE 10-3). You may

set thresholds for one or more of these alarm limits for selected data properties.

The software offers you the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

Note – You need the appropriate security permission to set an alarm threshold. See

Chapter 15 for more information.

TABLE 10-1 Common Simple Alarm Limits in Sun Management Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if value exceeds limit entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if value exceeds limit entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if value exceeds limit entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in this

field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in this

field.

Alarm Window Alarm occurs only during this time period. For example, if you type

day_of_week=fri , an alarm occurs only if the alarm condition exists on

a Friday. If an alarm condition exists on Tuesday, no alarm is registered.
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▼ To Create an Alarm

The following example illustrates how to create a simple alarm. This example creates

an alarm threshold in the Kernel Reader module.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click on the Alarms tab button.

The alarm rows are displayed.

8. Type a value in the Critical Threshold (>) field which is less than the current value
(FIGURE 10-3).

Entering this value enables you to create a critical alarm.

9. Complete one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

After some time, the Load Average Over the Last 1 Minute data field in the table

turns red. In addition, red alarm icons are displayed on the following folders and

icons: Operating System, Kernel Reader, and System Load Statistics (unless your

system has an open, unacknowledged severity 1 black alarm).

10. Click the Alarms tab button in the Details window.

The alarm you created should be reflected in the alarms table. See Chapter 13 for

more information on this subject.

11. Acknowledge this alarm.

For more information, see “To Acknowledge and Delete Alarms” on page 267.
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12. Create additional alarm thresholds and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Management Center software user cannot change your alarm

thresholds. For more information on security, see Chapter 15.

Note – You do not need to fill in alarm information for all alarm thresholds. For

example, you may choose to create only a critical alarm threshold.

The preceding example illustrates creating a situation where an alarm is registered if

a value exceeds the alarm limit. TABLE 10-1 lists other common alarm limits in the

software.

Actions Tab in the Attribute Editor

The Actions tab in the Attribute Editor (FIGURE 10-4) enables you to instruct the

software to perform a predetermined action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the /var/opt/
SUNWsymon/bin directory. These scripts execute with root permissions.

For example, you can enter the name of a script in the critical action field so that an

email is sent to a system administrator whenever a critical alarm is generated for the

Load Average Over the Last Five Minutes data property.

In FIGURE 10-4, you can set separate actions for different alarm conditions or one for

any alarm condition (action on any change).
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FIGURE 10-4 Attribute Editor Actions Tab for a Monitored Property
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▼ To Send an Email

The following example procedure describes how to send an email to a user when a

critical alarm occurs.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Actions tab button.

The action rows are displayed.

8. Type email username in the Critical Action field.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

The following email is sent to the user whenever an alert alarm occurs.

Date: Wed, 30 Jun 1999 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Subject: Sun Management Center - Alert Alarm Action
Mime-Version: 1.0

Sun Management Center alarm action notification ... {Alert:
machineB Kernel Reader Load Average Over The Last 5 Minutes >
0.01Jobs}
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▼ To Define Your Own Alarm Action Script

The following procedure describes how to customize an alarm action (other than an

email message as described previously) to notify a user when an alarm condition

occurs.

1. Create your custom alarm action script, using the following optional arguments:

2. At the command-line level, become superuser.

3. Install the script in the home Sun Management Center directory. The default is
the /var/opt/SUNWsymon/bin/ directory. For example:

Note – The script filename should not have a .sh extension.

4. Click the Browser tab button in the Details window.

5. Set the alarm threshold.

For more information, see “To Create an Alarm” on page 187.

6. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

7. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

8. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

TABLE 10-2 Arguments for Custom Alarm Action Script

Argument Definition

%statusfmt The alarm severity, such as Warning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. (For example:

Critical: Machine A Kernel Reader Number of User Sessions > 10)

# su

# cp custom_alarm_script /var/opt/SUNWsymon/bin/
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9. Click the left mouse button to select the table cell for Load Averages Over the Last
5 Minutes.

10. Click the Attributes button.

The Attribute Editor window is displayed.

11. Click the Actions tab button.

The action rows are displayed.

12. Type custom_alarm_script %statusstringfmt in the Critical Action field.

FIGURE 10-5 Defining Custom Script for Alarm Action in the Attribute Editor Screen
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13. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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Refresh Tab in the Attribute Editor

The Refresh panel (FIGURE 10-6) enables you to set the refresh interval for this object.

The refresh interval is the interval between the times when the Sun Management

Center agent samples the monitored property.

FIGURE 10-6 Attribute Editor Refresh Tab for a Monitored Property
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▼ To Set a Refresh Interval

The following example illustrates how to set a refresh interval in the System Load

Statistics module.

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Refresh tab button.

The refresh panel is displayed.

8. Type a value (in seconds) in the Refresh Interval field or click the Advanced
button.

In this example, type 300 in the entry field. The refresh interval is five minutes. For

more information on the Advanced button, see “Using the Time Editor” on page 201.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

Whenever the System Load Statistics table is displayed, the values in the table are

refreshed every five minutes.

Note – By increasing the refresh interval to a larger interval, then the agent uses less

CPU cycles.
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History Tab in the Attribute Editor

The history tab in the Attribute Editor enables you to save older data for a

monitored property. In FIGURE 10-7, a history of data points is recorded every 120

seconds (sample interval). This information may either be stored in a disk file or in

the memory cache.

There are two types of disk files: circular (maximum of 1000 lines) and text. These

files are located in the /var/opt/SUNWsymon/log directory.

If you select memory cache, you must also indicate how many data points should be

saved in the Max Size (sample) field.

Note – You may view this data in a graph by opening the graph for this monitored

property. If you have selected memory cache, the graph is displayed with the

historical data.
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FIGURE 10-7 Attribute Editor History Tab for a Monitored Property
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▼ To Set a History Interval

1. Click the Browser tab button in the Details window.

2. Click the expansion/compression icon next to the Operating System icon in the
hierarchy tree view.

The Operating System modules are displayed.

3. Click the expansion/compression icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the History tab button.

The history panel is displayed.

8. Type a value (in seconds) in the Sample Interval field or click on the Advanced
button.

In this example, type 120 in the entry field. A history data point is collected every

two minutes. For more information on the Advanced button, see “Using the Time

Editor” on page 201.

9. Click in the check box next to Save History as Disk File or Save History in
Memory Cache.

10. If you decided to save history as a disk file, determine the file type (circular or
text) and type the file name in the Text File Name field (text file only).

A circular disk file is automatically saved under the name history.log . If you do

not choose a file name for your text file, it is automatically saved under the name

agent_default.history .

11. If you decided to save history in memory cache, type the number of history data
points in the Max Size (sample) field.

For example, if you set this field to 1000, only the most current 1000 data points are

stored in the memory cache. Any older data points are discarded. These data points

may be graphed. See “To Graph A Monitored Data Property” on page 164 for more

information.

12. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.
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■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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CHAPTER 11

Time Editor

This chapter covers the following topics:

■ To Create a Time Expression Using the Cyclic and Comparison Tabs

■ To Create a Time Expression Using the Absolute and Cron Tabs

■ To Create an Alarm Schedule Using the Comparison Tab

Using the Time Editor

Use the Time Editor (FIGURE 11-1) to schedule monitoring activities. For example, you

may want a particular module to be operational only during business hours. Or you

may want to record the history of a monitored property only during peak activity.

You can use the Time Editor to set the schedule for a module, for alarms, for a

refresh interval, and for history data collection.

Note – The schedule (set by the Time Editor) for a module overrides the schedule

for alarms, refresh intervals, and history. If the module is not “on,” the data

properties are not monitored and the alarms, refresh, and history schedules are

meaningless.
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FIGURE 11-1 Time Editor

There are four basic types of Time Expressions:

■ Cyclic – Periodic events

■ Absolute – Starting at a particular time

■ Comparison – Allowing events at specific times

■ Cron – Allowing events at specified times using cron input format

These Time Expressions can be used separately or in combination.

Note – All four Time Expressions are valid for history sample and refresh intervals.

However, only the comparison tab is valid for alarm and module schedules.

Combining Time Expressions

The following examples illustrate combining Time Expressions to set a history

interval.
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Note – Sampling for the history interval does not occur unless the module is also on

(according to the module schedule).

▼ To Create a Time Expression Using the Cyclic

and Comparison Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 198 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Determine the frequency for the history interval (FIGURE 11-2).

In this example, the history interval is set for every hour. That is, the software checks

the System Load Average Over the Last 5 Minutes every hour.

a. Highlight the number field and click the up or down arrows until the number 1
is displayed.

b. Highlight the units field and click the up or down arrows until hours is
displayed.
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FIGURE 11-2 Setting a Cyclic Time of One Hour

5. Click the Apply button.

■ Cycle(1 hours) is displayed in the Time Editor (FIGURE 11-3).
204 Sun Management Center 2.1 Software User’s Guide • November 1999



FIGURE 11-3 Time Editor With Cyclic Time of One Hour

6. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

7. Click the Comparison tab.

The Time window is displayed with the Comparison tab selected.

8. Determine the start of the Time Range (Monday).

The time range determines the time period when the software checks the system

load average every hour. The software does not check the system load average

outside the time period specified by this window. In this example, the time range is

from Monday to Friday, inclusive.

a. Select Day of week from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select Monday from the right pull-down menu.

The time expression is displayed in the Current Time Expression field

(FIGURE 11-4).
Chapter 11 Time Editor 205



FIGURE 11-4 Setting the Start Range to Monday

9. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads

Day_of_week>=Monday. However, the Time Editor also enables you to select the Or

expression (FIGURE 11-5).
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FIGURE 11-5 Time Editor Is Updated With a Start Range of Monday

10. Determine the end of the Time Range by clicking the Insert button.

11. Click on the Comparison tab of the Time window.

The Time window is displayed with the Comparison tab selected.

12. Determine the end of the Time Range (Friday).

a. Select Day of week from the left pull-down menu.

b. Select <= from the middle pull-down menu.

c. Select Friday from the right pull-down menu.

The Time expression is displayed in the Current Time Expression field

(FIGURE 11-6).
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FIGURE 11-6 Setting the End Range to Friday

13. Click the Apply button.

The Time Editor is updated. The Time Expression fields now read Cycle(1 hours)

and Day_of_week>=Monday and Day_of_week<=Friday (FIGURE 11-7).
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FIGURE 11-7 Time Editor Showing a Cycle Time of One Hour From Monday to Friday

14. Click the Apply button.

The Sample Interval field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) at every hour, from 12:00 AM Monday

to 12:00 AM Saturday morning.
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FIGURE 11-8 Updated History Attribute Editor Showing a Cycle Time of One Hour From
Monday to Friday
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▼ To Create a Time Expression Using the Absolute

and Cron Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 198 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Cyclic tab selected.

4. Click the Absolute tab.

The Time window is displayed with the Absolute tab selected.

5. Determine the starting time and date (FIGURE 11-9).

a. Highlight the hour, minute, and if desired, the seconds fields and click the up
or down arrow until the correct time is displayed.

b. Highlight the month, date, and year fields and click the up or down arrow until
the correct date is displayed.

The starting date and time are displayed in the Current Time Expression field.

Note – Time is displayed using the 24-hour clock.
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FIGURE 11-9 Starting Time of 12:00:00 PM on August 20, 1999

6. Click the Apply button.

The starting date and time are displayed in the Time Editor (FIGURE 11-10).
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FIGURE 11-10 Time Editor With Starting Time of 12:00:00 PM August 20, 1999

7. Click the Insert button.

8. Click the Cron tab.

The Time window is displayed with the Cron tab selected.

9. Select the time when the history interval is active.

The software does not check the system load average outside the time specified by

this window. In this example, the condition is at 3:00 AM every Monday through

Friday.

a. Select 0 from the Minute pull-down menu.

b. Select 3rd from the hour pull-down menu.

These first two pull-down menus set the time at 3:00 AM.

c. Select Every from the Day of month pull-down menu.

d. Select Every from the Month pull-down menu.

These two pull-down menus set the date for every day.

e. Select Monday from the final pull-down menu.

The Current Time Expression field reads Cron(03**1). This expression states that

the history window is only active at 3:00 AM every Monday (FIGURE 11-11).
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FIGURE 11-11 Cron Tab Selected With 3:00 AM Every Monday

10. Click the Apply button.

The Time Editor is updated. The Time Expression now states Cron(03**1)

(FIGURE 11-12).
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FIGURE 11-12 Time Editor Selected With Starting Date/Time 12:00:00 PM, August 20, 1999,
and History Interval Start Time of 3:00 AM Every Monday
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11. Place the cursor in the Cron field on the Time Editor screen. Backspace using the
left arrow key until the cursor is between the ending parenthesis and the number
1. Type -5, so that the value in this field now reads Cron(03**1-5).

This expression states that the history interval is only active at 3:00 AM every

Monday through Friday (FIGURE 11-13).

FIGURE 11-13 Time Editor With Starting Date/Time of 12:00:00 PM, August 20, 1999 and
History Interval of 3:00 AM Every Monday Through Friday

12. Click the Apply button.

The Time Editor is updated. In this example, the history window is active at 3:00 AM

every Monday through Friday after the starting date and time of 12:00 PM August

20, 1999 (FIGURE 11-14).

Edit this field to
select a range
of days for the
refresh interval
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FIGURE 11-14 History Interval With Starting Time of 12:00 PM August 20, 1999 and 3:00
AM Every Monday Through Friday
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▼ To Create an Alarm Schedule Using the

Comparison Tab

Note – This procedure is also valid for a module schedule.

1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data
property.

See “To Create an Alarm” on page 187 for more information.

The Time Editor is displayed (FIGURE 11-1).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Time window is displayed with the Comparison tab selected.

4. Determine the start of the Time Range (9:00 AM).

The time range determines the time period when the software checks the system

load average. The software does not check the system load average outside the time

period specified by this window. In this example, the time range is from 9:00 AM to

5:00 PM every day.

a. Select Hour from the left pull-down menu.

b. Select >= from the middle pull-down menu.

c. Select 9 from the right pull-down menu.

The Time expression Hour>=9 is displayed in the Current Time Expression field

(FIGURE 11-15).
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FIGURE 11-15 Comparison Tab With Greater Than or Equal to 9:00 AM

5. Click the Apply button.

The Time Editor is updated. The Current Time Expression now reads Hour>=9. In

this example, both conditions should occur in the alarm window time range.

However, the Time Editor also enables you to select the Or expression (FIGURE 11-16).
Chapter 11 Time Editor 219



FIGURE 11-16 Time Editor With Greater Than or Equal to 9:00 AM

6. Determine the end of the Time Range by clicking the Insert button.

The Time window is displayed with the Comparison tab selected.

7. Determine the end of the Time Range (Friday).

a. Select Hour from the left pull-down menu.

b. Select <= from the middle pull-down menu.

c. Select 17 from the right pull-down menu.

The Time expression Hour<=17 is displayed in the Current Time Expression field

(FIGURE 11-17).
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FIGURE 11-17 Comparison Tab With Less Than or Equal to 5:00 PM

8. Click the Apply button.

The Time Editor is updated. The Time expression now reads Hour>=9 And

Hour<=17 (FIGURE 11-18).
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FIGURE 11-18 Time Editor With Time Interval Between 9:00 AM and 5:00 PM

9. Click the Apply button.

The alarm window field in the Attribute Editor is updated. The software will check

the system load average (over five minutes) from 9:00 AM Monday to 5:00 PM

Friday (FIGURE 11-19).
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FIGURE 11-19 Alarms Attribute Editor With Alarm Window From 9:00 AM to 5:00 PM
Every Day
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CHAPTER 12

Managing Modules

This chapter briefly describes the Sun Management Center modules and explains

how to manage them.

The following topics are covered:

■ Default Modules

■ To Load a Module

■ To Edit Module Parameters

■ To Disable a Module

■ To Enable a Module

■ To Unload a Module

■ To Set a Module Schedule

■ To Set Security Permissions for a Module

Sun Management Center Modules

Sun Management Center modules are responsible for collecting data from specific

monitored resources. These modules can be dynamically loaded, enabled, disabled,

and unloaded into a Sun Management Center agent.

■ Loading a module adds the module icon to the Browser Details window, defines

the managed object and data properties, and starts data acquisition. The data

properties for the managed object are displayed in the Details window. The data

display is periodically refreshed.

■ Enabling a module restarts data acquisition if the module has been previously

disabled. The data display for the managed object is periodically refreshed in the

Details window.
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■ Disabling a module temporarily stops data acquisition for the managed object

until the module is enabled. While a module is disabled, the data is not refreshed.

Also, it also does not trigger an alarm (even if you do a manual refresh). Alarms

are not triggered until the module is re-enabled.

■ Unloading a module stops data acquisition for the managed object. The managed

object and data properties are undefined and the module icon is removed from

the Browser Details window.

Default Modules

Some or all of the following modules are loaded by default when you install the

software.

■ Agent Statistics

■ File Scanning

■ Kernel Reader

■ Config-Reader (for supported hardware platforms)

■ Simple MIB-II

Module List

TABLE 12-1 lists generic modules that you can load and use. The list of modules that

is displayed for your system is dependent on the type of platform you have. See

your supplement for more information on platform-specific modules, including the

Config-Reader and Dynamic Reconfiguration module. For information on the other

Sun Management Center modules, see Appendix C and Appendix D.

TABLE 12-1 Sun Management Center Modules

Module
Module Version
Number Description

Agent Statistics 2.0 Provides information about the health of the agent

installed on a host by monitoring the objects,

processes and execution of processes by the agent.

Config-Reader 1.0 Provides the hardware configuration of the host.

Both the physical view and the logical view require

that this module be loaded.

Data Logging

Registry

2.0 Provides information about data logging in agents

including log destination, module name, logging

interval, and buffer length. Multiple copies of this

module can be loaded.
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Directory Size

Monitoring

2.0 Enables you to isolate and monitor the size of any

directory and its subdirectories on a host where a

Sun Management Center agent is installed.

Multiple copies of this module can be loaded, or

you can add additional directories for monitoring

by adding a row in the properties table.

Dynamic

Reconfiguration

2.0 Enables Sun Management Center software users to

perform dynamic reconfiguration operations on

DR-enabled monitored hosts.

File Monitoring 2.0 Monitors selected files on a host. Monitored

parameters include file size and timestamps.

Multiple copies of this module can be loaded. This

module requires you to add rows in the data

property table. For more information, see “To Add

a Row (for the File Monitoring, File Scanning, and

Process Monitoring Modules)” on page 153.

File Scanning 2.0 Scans files on a host for specified patterns. Multiple

copies of this module can be loaded. This module

requires you to add rows in the data property table.

For more information, see “To Add a Row (for the

File Monitoring, File Scanning, and Process

Monitoring Modules)” on page 153.

HP JetDirect 2.0 Monitors the status of HP printers equipped with a

JetDirect card. Multiple copies of this module can

be loaded.

Health Monitor 2.0 Enables you to monitor various resources usage in

your host such as CPU, disk, NFS, and SMNP.

Kernel Reader 2.0 Provides kernel statistics, such as CPU details,

system call, faults, streams, disk information, and

page information.

MIB-II

Instrumentation

1.0 Provides the system, interfaces, IP, ICMP (internet

control message protocol), TCP (transmission

control protocol), and UDP (user datagram

protocol) MIB-II (management information base)

group information of the monitored host.

MIB-II Proxy

Monitoring

2.0 Provides proxy management of hosts that are

running non-Sun Management Center MIB-II

SNMP agents. Multiple copies of this module can

be loaded.

TABLE 12-1 Sun Management Center Modules (Continued)

Module
Module Version
Number Description
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For more information on modules, see Appendix C.

Note – The Config-Reader and Dynamic Reconfiguration modules are supported

only on specific hardware platforms. For more information, refer to your

supplement.

NFS File Systems 2.0 Provides information about the NFS file systems on

monitored hosts by monitoring the amount of disk

space occupied by mounted or unmounted file

systems and the amount of used and available

space as well as the file system’s remaining total

capacity.

NFS Statistics 2.0 Monitors the number of NFS calls and RPC (remote

procedure calls) received by the server as well as

the status of the transaction activity on the

monitored host. Multiple copies of this module can

be loaded.

Print Spooler 3.0 Monitors the status of the printer daemon and print

queue on the monitored host as well as the printer

devices installed on it.

Process

Monitoring

2.0 Monitors one or more processes on the host.

Specifies monitored processes by matching

patterns. Multiple copies of this module can be

loaded. This module requires you to add rows in

the data property table. For more information, see

“To Add a Row (for the File Monitoring, File

Scanning, and Process Monitoring Modules)” on

page 153.

Solaris Process

Details

2.0 Displays detailed information of Solaris processes

running on a host where the Sun Management

Center agent has been installed. The Process Details

window requires that this module be loaded.

Simple MIB-II 1.0 Provides the system Group, interfaces Group, IP

Forwarding, IP Route Table information of the

standard MIB-II (Management Information Base)

group information of the monitored host. This is a

scaled-down version of the MIB-II Instrumentation

module.

TABLE 12-1 Sun Management Center Modules (Continued)

Module
Module Version
Number Description
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Note – Depending on your system hardware, additional modules may be

supported. For more information, refer to the Sun Management Center web site:

http://www.sun.com/sunmanagementcenter .

Loading Modules

To load a module, follow these steps.

▼ To Load a Module

1. Select the host machine on which the module will be loaded by clicking on the
host machine icon.

Note – If you haven’t selected a host before attempting to load a module, the Load

Module option in the Tools pull-down menu is gray and cannot be used.

2. Open the Load Module dialog by doing one of the following:

■ Click the right mouse button on the selected host icon and highlight Load Module

from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology view

(FIGURE 12-2).

■ In the main console window, select Tools ➤ Load Module (FIGURE 12-3).

■ In the Details window, select host name and then Module ➤ Load Module

(FIGURE 12-4).
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FIGURE 12-1 Load Module Pop-Up Menu in Hierarchy View
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FIGURE 12-2 Load Module Pop-Up Menu in Topology View
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FIGURE 12-3 Tools Menu in Main Console Window

FIGURE 12-4 Load Module Menu in Details Window

The Load Module dialog is displayed (FIGURE 12-5).
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FIGURE 12-5 Load Module Dialog

The Load Module dialog lists all Sun Management Center modules. If a number

appears next to the module name, for example as shown above for the File Scanning

Module, the number indicates the number of existing instances of that module on

your host. An instance is a single word or alpha-character string that is used

internally within the Sun Management Center agent to identify uniquely a particular

module or a row within a module.
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Note – Some modules can have multiple instances loaded on a host.

Note – You must specify a unique name for each instance when multiple instances

of the same module are loaded.

3. Click the name of the module you want to load.

4. Click the OK button.

The Module Loader dialog is displayed. The contents of the dialog varies with the

module that is selected. FIGURE 12-6 and FIGURE 12-7 show possible examples of the

dialog.
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FIGURE 12-6 Module Loader Dialog For Directory Size Monitoring
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FIGURE 12-7 Module Loader Dialog for Process Monitoring

5. If necessary, type the relevant information into any editable name fields.

For example, the Directory Size Monitoring module requires you to enter the name

of the instance and a description. (An instance is a single word or alpha-character

string that is used internally within the Sun Management Center agent to identify

uniquely a particular module or a row within a module.)

If you do not type in information for a necessary field, the software responds with

an error message and the module is not loaded.
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6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this dialog.

■ Click Reset to undo your changes.

■ Click Cancel to cancel your request.

Note – You can also double-click a module name in the Load Module dialog to load

that module.

Editing Modules

The Sun Management Center software enables you to edit modules by changing

module parameters and enabling or disabling modules.

FIGURE 12-8 Edit Module Pop-Up Menu in Hierarchy View
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FIGURE 12-9 Edit Module Pop-Up Menu in Contents View
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FIGURE 12-10 Edit Module Menu in Details Window

▼ To Edit Module Parameters

1. Select the selected module.

2. Proceed with one of the following:

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view (FIGURE 12-8) or the Contents view (FIGURE 12-9).

■ In the Details window, select Module ➤ Edit Module (FIGURE 12-10).

The Module Parameters Editor is displayed.

3. Type the relevant information into the editable fields.

FIGURE 12-11 shows an example. The actual display varies with the module that is

selected.
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FIGURE 12-11 Module Parameter Editor

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the module to the default parameters.

■ Click Cancel to cancel your request.
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▼ To Disable a Module

● Click the right mouse button on the selected module and highlight Disable
Module from the pop-up menu in the hierarchy (FIGURE 12-8) or Contents view
(FIGURE 12-9).

OR

● In the Details window, select Module ➤ Disable Module (FIGURE 12-10).

When the module has been disabled (turned off), the following message is displayed

at the bottom of the Details window (FIGURE 12-12).

FIGURE 12-12 MIB-II Instrumentation Module Is Disabled

If the disabled module is the Solaris Process Details module, the following message

is displayed at the bottom of the Details window.

Caution – Because data is not being refreshed for a disabled module, the data will

not trigger an alarm until you re-enable the module (even if you manually refresh

the data).

Module successfully disabled.

Solaris Process Details module disabled. Process data may not be
current.

This icon indicates the module is disabled
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▼ To Enable a Module

● Click the right mouse button on the selected module and highlight Enable
Module from the pop-up menu in the hierarchy (FIGURE 12-8) or Contents view
(FIGURE 12-9).

OR

● In the Details window, select Module ➤ Enable Module (FIGURE 12-10).

When the module has been enabled (turned on), the following message is displayed

at the bottom of the Details window.

▼ To Unload a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected module and select Unload Module

from the pop-up menu in the hierarchy view (FIGURE 12-8) or the contents view

(FIGURE 12-9).

■ In the Details window, select Module ➤ Unload Module (FIGURE 12-10).

The Confirm Module Unload dialog is displayed (FIGURE 12-13).

FIGURE 12-13 Unload Module Dialog

2. Click the Unload button to remove the module or the Cancel button to cancel this
request.

Module successfully enabled.
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Monitoring Modules

Tip – If you want to monitor one type of module on a number of hosts, you can

create module objects for each host and place all of the objects in a common location

(that is, in the same group or administrative domain). To create a module object, see

“To Create a Module Object” on page 79.

Attribute Editor for a Module

The Attribute Editor for a module provides additional information about the module

and enables you to customize various monitoring criteria. You can use the module

Attribute Editor to set:

■ Module schedules

■ Security permissions

Note – The Attribute Editor consists of a series of one or more tab buttons at the top

of the window that enables you to switch between different panels. The buttons that

are displayed are dependent on the selected object.

Setting a Module Schedule

You may determine when a module should be active and when it should be inactive

by setting a schedule. For example, you can schedule a module to run between

8:00 AM and 5:00 PM every day. At all other times, the module is inactive, whether

or not an alarm condition exists.

▼ To Set a Module Schedule

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected module icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology

view (FIGURE 12-2).
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■ In the Details window, click the Attributes button.

2. Click the Schedule tab (FIGURE 12-14).

3. Click the Advanced button and set the module schedule.

See “To Create an Alarm Schedule Using the Comparison Tab” on page 218 for

details.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 12-14 Setting a Module Schedule
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Setting Security Permissions for a Module

You can set security permissions for an individual module.

The security permissions for a module override the default security permissions for

its parent object or host. For example, if a user has administrator privileges for a

module, but only general privileges for the host, the user still retains administrator

privileges for the module. For further information on privileges, see Chapter 15.

▼ To Set Security Permissions for a Module

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected host icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 12-1) or the topology

view (FIGURE 12-2).

■ In the Details window, click the Attributes button.

2. Click the Security tab (FIGURE 12-15).

3. Type the name(s) of user and administrator groups in the appropriate fields.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 12-15 Setting Module Security in the Attribute Editor
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CHAPTER 13

Alarms

This chapter provides details on alarms.

The Sun Management Center software monitors your hardware and software and

notifies you, through alarms, when abnormal conditions occur. These alarms are

triggered by conditions falling outside of predetermined ranges, or by Sun

Management Center rules. Default alarm conditions and rules are included in the

modules. In addition, you may also set up your own alarm thresholds. For a list of

Sun Management Center rules, see Appendix E.

This chapter explains alarms with the following topics:

■ Sun Management Center Alarms

■ Types of Alarms

■ Notifying Users That a Host or Agent is Down

■ To Set Up User Notification for Down Host or Agent

■ Creating Alarms

■ Viewing Alarm Information

■ Colored Alarm Icons

■ Seeing Alarms in Domain Status Summary

■ To Access Alarms from the Main Console Window

■ Information on Alarms

■ To Access Alarms from the Alarms Tab in the Details Window

■ Alarm Categories

■ Alarm States

■ To View Alarm Categories

■ Alarm Severities

■ To Sort Alarms

■ To Reset the Alarm Table

■ Acknowledging and Deleting Alarms

■ To Acknowledge and Delete Alarms

■ Creating Alarm Conditions

■ To Create Alarm Conditions To Monitor Hosts
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Note – The messages displayed in the Alarms tab of the Details window are always

in English. They are not translated in other languages.

Sun Management Center Alarms

The software displays alarm information for managed objects. To access information

on alarms for an object, access the Alarms Details window. This window displays

alarms for a particular object.

Note – The Sun Management Center agent is configured so that only one server

receives alarm information from that agent.

You can acknowledge, delete, and manage the alarms on an object in an

administrative domain by using the Alarms Details window. For more information,

see “To Access Alarms from the Alarms Tab in the Details Window” on page 261.

Types of Alarms

Managed object status is displayed in the Domain Status Summary from the main

console window (FIGURE 13-1).

FIGURE 13-1 Domain Status Summary in the Main Console Window

Domain Status Summary buttons
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The numbers next to the alarm icons indicate the number of managed objects whose

highest severity open, unacknowledged alarm is represented by the icon. For

example, a number 1 next to the yellow alarm icon indicates that there is a managed

object whose highest severity alarm is yellow (alert). The severity of alarms are

designated by icons (FIGURE 13-2).

FIGURE 13-2 Alarm Icons

Down Alarms

A down alarm (the black alarm icon with a down arrow in FIGURE 13-11) indicates

that a service-affecting condition has occurred and an immediate corrective action is

required. An example of this condition is when a resource defined by a managed

object has gone out of service and that resource is required; for example, a module

has gone down (exited).

Critical Alarms

A critical alarm (the red alarm icon in FIGURE 13-11) indicates that a service-affecting

condition has developed and an urgent corrective action is required. An example of

this condition is when a severe degradation in the capability of an object has

occurred and the object needs to be restored to full capability.

Alert Alarms

An alert alarm (The yellow alarm icon in FIGURE 13-11) indicates that a non-service-

affecting condition has developed and a corrective action should be taken in order to

prevent a more serious fault.
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Caution Alarms

A caution alarm (the blue alarm icon in FIGURE 13-11) indicates the detection of a

potential or an impending service-affecting fault, before any significant effects have

occurred. Action should be taken to diagnose further (if necessary) and correct the

problem in order to prevent it from becoming a more serious service-affecting fault.

Off/Disabled Alarms

A disabled alarm (the white alarm icon with an ‘X’ in FIGURE 13-11) indicates that a

resource for a managed object has been disabled; for example, a module is disabled.

Note – Objects with black star icons, that may look like a “splat” on your screen, are

objects with indeterminate states, not to be confused with alarms.

If the black star or splat icon shows up in the main console window, it indicates that

the object is in an indeterminate state. This means that there has been a data

acquisition failure on that object. The failure does not come out of a rule so there is

no alarm associated with it.

An example of this is presented in FIGURE 13-3.

FIGURE 13-3 Objects with Indeterminate States Identified by Black Star or “Splat” Icon

Black splat
icons
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Note – When you view the data property table for the object, a row colored pink is

another indication that you have an indeterminate state for the object.

Notifying Users That a Host or Agent is
Down

You can configure the Sun Management Center software to send you an email

notification if a host or agent is down. You can notify:

■ yourself only

■ several people, or

■ all email recipients linked to the group to which the host or agent belongs

▼ To Set Up User Notification for Down Host or

Agent

1. In the main console window, select the host or group of hosts that you want to
receive notification about if the host or agent is down.
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2. Click the right mouse button to display the pop-up menu, and select Alarm Action
(FIGURE 13-4).

FIGURE 13-4 Pop-Up Menu in Hierarchy View

The Alarm Action version of the Attribute Editor is displayed (FIGURE 13-5).

3. Enter the email address and username to be notified for the host down, and agent
down condition.

To notify more than one person, use the format email username1, username2,
and so on.

4. To include any email users who are linked to the down host or agent group, click
“yes” in the Include Group Actions - Host Down or Agent Down fields. When you
have made all the changes, click Apply.

For example, MachineA is selected as the object for which notification is to be

received in FIGURE 13-4. MachineA belongs to the group mpk12. Any user monitoring

a machine in group mpk12 would be included in a group notification for MachineA.
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FIGURE 13-5 Attribute Editor - Alarm Action

5. Click OK to close the Attribute Editor - Alarm Action screen.
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Creating Alarms

The software offers the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

For more information on creating alarms, see “To Create an Alarm” on page 187.

Viewing Alarm Information

Sun Management Center software uses five methods (FIGURE 13-6) to alert you that

an unacknowledged open alarm condition exists:

■ Relevant row or column is colored in the property table (contents view)

■ Colored icons in the hierarchy (tree) view

■ Colored icons in the contents view

■ Colored icons in the topology view

■ Alarms in Domain Status Summary

Colored Alarm Icons

The type of alarm icon determines the severity of the alarm. For example, a red

alarm icon indicates a critical condition has developed and corrective action is

required right away. By contrast, a blue alarm icon indicates a potential or an

impending service-affecting fault.

In FIGURE 13-6, there is an unacknowledged, open critical alarm in the Swap Statistics

properties table, in the Used KB row. The row is shaded red, which corresponds to

the color of a critical alarm.

The following illustration presents alarms in the Details window.
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FIGURE 13-6 Alarms in the Details Window

The colored alarm icons are propagated up the hierarchy tree view, from the

individual module up to the host. For example, in FIGURE 13-6, there is an

unacknowledged, open error condition (critical alarm) in the Swap Statistics icon.

You see this same red alarm icon on the Swap Statistics icon, on the Kernel Reader

icon module, on the Operating System icon, and the host icon.

In addition, you also see a red alarm icon on the corresponding host, group (if any),

or administrative domain in the main console window unless an unacknowledged

open black alarm (of higher severity) exists.

Note – Unacknowledged alarms take precedence over acknowledged alarms. If

there are two or more types of alarms in the hierarchy, the color of the more severe

unacknowledged alarm is propagated up the tree. For example, if there is a yellow

unacknowledged alarm in CPU usage, and a red unacknowledged alarm in Disk

Statistics, only the red colored alarm icon is propagated. However, if there is a

yellow unacknowledged alarm in CPU usage, and a red acknowledged alarm in Disk

Statistics, only the yellow colored alarm icon is propagated.
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FIGURE 13-7 Alarms in the Contents View

Seeing Alarms in Domain Status Summary

The Domain Status Summary button panel displays the number of managed objects

in the administrative domain that have at least one unacknowledged open alarm of that

severity.

Note – If there are two or more types of alarms in the host, the color of the more

severe unacknowledged open alarm is displayed in the Domain Status Summary.

If the most severe alarm on one host is critical (red) and the most severe alarm on

another host is alert (yellow), then you see the number 1 next to both the red-colored

alarm icon and the yellow-colored alarm icon.
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FIGURE 13-8 Domain Status Summary Buttons

▼ To Access Alarms from the Main Console

Window

1. Click on one of the Domain Status Summary buttons in the main console window.
(FIGURE 13-8).

A list of objects which have at least one open, unacknowledged alarm, whose

highest severity is that of the icon on the button, is displayed in the Domain Status

Details window (FIGURE 13-9).

For example, if you click on the button with the yellow alarm icon (alert alarms), the

Domain Status Details window displays a list of objects whose highest severity,

unacknowledged, open alarms are yellow (alert). The number of objects displayed is

equal to the number on the button (within approximately a five second delay

period).

2. Complete this procedure with one of the following actions:

■ Double click on the row in the table.

■ Single click on the row to select it, and then click the Details button.

The Alarms Details window is displayed (FIGURE 13-10).
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FIGURE 13-9 Domain Status Details Window

Information on Alarms

The Alarms tab in the Details window presents a table that contains the statistical

summary of all alarm data for a given managed object.

Note – If the object is a platform, see your supplement for more information.
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▼ To Access Alarms from the Alarms Tab in the

Details Window

1. Click with your right mouse button on the selected host icon in the main console
window and highlight Details from the pop-up menu.

The Details window is displayed.

2. Click on the Alarms tab button.

The Alarms Details window is displayed (FIGURE 13-10).

FIGURE 13-10 Alarms Tab Data from the Details Window
Chapter 13 Alarms 261



Alarm Categories

The Alarms tab presents different categories of detailed alarm information. Some of

this information is always displayed in the alarms table (TABLE 13-1) while additional

information is displayed when an alarm row is highlighted (TABLE 13-2).

Note – Acknowledged alarms are indicated with a green check in the Severity

column.

Alarm Severities

The Show Specific Alarms dialog box (FIGURE 13-11) lists the alarms in order of

severity, from most (black) to least (white) severe.

TABLE 13-1 Alarm Categories Displayed in Table

Category Description

Severity Graphic indicator whose color indicates the severity of the alarm;

black is most severe and white is least severe

Start time Time the alarm first occurred

State Open or closed

Message Abbreviated message that indicates the type of alarm

TABLE 13-2 Additional Alarm Information Displayed When a Single Row is Selected

Category Description

Condition began on Date/Time the alarm condition has started

Condition ended on Date/Time the alarm condition has been fixed

Acknowledged on Date/Time the alarm was acknowledged by a particular user

Rule Name that identifies the rule file which caused the alarm (for

example, a rule number). For non-rule based alarms, the name

rCompare is used.
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FIGURE 13-11 Alarm Severities

Alarm States

There are also two different alarm states:

■ Open

■ Closed

An Open alarm is one in which the condition which caused the alarm still exists. A

Closed alarm means the condition no longer exists. Open alarms are “ringing” while

closed alarms are “silent” (FIGURE 13-12).
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FIGURE 13-12 Open and Closed Alarms

▼ To View Alarm Categories

The Alarm Details window has an option that enables you to filter on an alarm

category and show a subset of the alarms.

1. Click on the Show button below the Table actions field.

The Show Specific Alarms window (FIGURE 13-12) is displayed.

2. Click on the appropriate tab to filter your alarm request.

The selected tab is darkened.

Note – If you want to see all the alarms in the alarms table, simply click the Show

All button.

3. Click on the Severity tab (FIGURE 13-11).

The Severity tab enables you to show alarms of the selected severity.
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4. Click on the check box next to a severity to show alarms of that severity.

The selected severity has a check in the check box next to its name.

Note – You may select one or more types of severity to show in the alarms table.

5. Click on the State tab (FIGURE 13-12).

The State tab enables you to show open and closed alarms.

6. Click on Open or Closed to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select open, closed, or both to show in the alarms table.

7. Click on the Acknowledge tab.

The Acknowledge tab enables you to show acknowledged and unacknowledged

alarms.

8. Click on Acknowledged or Unacknowledged to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select acknowledged, unacknowledged, or both to show in the

alarms table.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Sort Alarms

You can sort the alarm rows in the table (FIGURE 13-13).
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FIGURE 13-13 Sort Alarm Table

1. Click on the Sort button below the Table actions field.

The Sort Alarm Table window is displayed.

2. Select your sort feature by clicking in the circle next to your selection.

You may sort by starting time (from the newest alarm to the oldest alarm), by

severity (from the most severe to the least severe), or by state (with open alarms

listed first, followed by closed alarms).

The selected sort feature has a darkened circle next to its name.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Reset the Alarm Table

● Click the Reset button.

The alarm table is dynamically updated as new alarms are displayed and some

existing ones close. These updates are displayed, regardless of what is selected as the

Show button viewing options. As these conditions occur over time, the table may no

longer reflect the current Show settings. Clicking the Reset button will update the

table to reflect the current Show settings once again.
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Acknowledging and Deleting Alarms

You may update information about alarms in the Alarms Details window.

▼ To Acknowledge and Delete Alarms

1. Select the alarms you want to update by clicking the selected row(s) in the table.

Clicking the selected row(s) displays additional information associated with that

alarm. The additional information consists of the starting time of the alarm, the

ending time of the alarm, the acknowledgment time and the user who

acknowledged the alarm, and the rule.

Note – You may select several rows at once by holding down your mouse button

and moving the mouse over the selected rows. If, after you selected several rows,

you want to skip a few rows and select other rows, simply hold down the Control

key and select the additional rows.

2. Click the appropriate button under the Alarm actions field.

You may perform the actions listed in TABLE 13-3.

Note – You can delete open alarms, but the potential exists for alarm information in

the Alarms windows to differ from alarm information in the hierarchy view and the

topology view. That is, the alarms are deleted from the alarms table, but the alarm

icons may still be present in the hierarchy and topology views. An example of when

this action may be required would be in the case of an unloaded module. Orphaned

alarms may remain in view and may need to be manually deleted.

TABLE 13-3 User Actions That Can Be Performed on Alarms

User Action Description

Acknowledge User and time of acknowledgment is registered. When an alarm is

acknowledged, the alarm icon in the Severity column has a green

check mark beside it.

Delete Deletes all the selected alarms from the table. The deleted alarm(s)

is saved into an archive file on the server.

Delete all Deletes all the closed alarms from the table. The deleted alarm(s) is

saved into an archive file on the server.
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Caution – You should only delete open alarms when there is no other method to

remove these alarms.

Creating Alarm Conditions

Sun Management Center software enables you to create alarm conditions that help

you to monitor the hosts in your administrative domain. The main purpose of this

section is to help you create alarm conditions and familiarize yourself with their

operation. This will help you control alarm conditions.

▼ To Create Alarm Conditions To Monitor Hosts

1. Navigate through the Operating System modules until you see the User Statistics
icon (part of the Kernel Reader module).

2. Select Attribute Editor from the pop-up menu.

The Attribute Editor enables you to edit information about this property.

3. Create an alarm condition by following the procedure in “To Create an Alarm” on
page 187.

4. Click on the Alarms tab button in the Details window.

The alarm you created should be reflected in the Alarms table.

5. Acknowledge, then delete this alarm if the alarm is closed.

6. Create additional alarm conditions and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another Sun Management Center user cannot change your alarm thresholds. For

information on accomplishing this task, see Chapter 15.
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CHAPTER 14

Details

The Sun Management Center Details window provides detailed information about a

selected object.

The following topics are covered in this chapter unless noted otherwise:

■ Navigating the Details Window

■ Info Tab

■ Browser Tab (covered in Chapter 8)

■ Alarms Tab (covered in Chapter 13)

■ View Log Tab

■ Filtering Your Messages

■ Finding Specific Log Messages

■ Applications Tab

■ View Processes

■ Hardware Tab

■ Resources

■ Physical View

■ Logical View

The Details window displays several tab buttons. The commonly seen buttons are

shown in TABLE 14-1.

Clicking a tab button updates the window with the panel for that tab.
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Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. For example, the Hardware tab is missing if the Config-

Reader module is not supported on your system. For additional information on the

tabs for your specific hardware object, see your supplement.

TABLE 14-1 Common Details Window Tab Buttons

Tab Button Description

Info Provides general information such as host name, IP address, and

polling type.

Browser Enables you to navigate through the hierarchy and contents views

of the hardware, operating system, local applications, and remote

systems (for navigation purposes). (The Browser is covered

separately in Chapter 8.)

Alarms Displays alarm status messages and the alarm controls for the host

or node. Enables you to acknowledge or delete alarms. (Alarms are

covered separately in Chapter 13.)

View Log Displays entries from host log files (such as system message logs).

Applications View Processes - Displays information about processes running in

the host. This is the default selected for the Applications tab.

Other applications - If you have installed custom or third-party

applications, the entries for the application(s) display below the

View Processes entry. Select an application and the application is

displayed in the right side of the window.

Hardware Displays configuration information (resources, physical view,

logical view, and dynamic reconfiguration status and controls), if

available, for a host.
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Navigating the Details Window

▼ To Start the Details Window

1. Double click the left mouse button on an object icon in either the hierarchy view
or the topology view.

Be sure to select an object, not a administrative domain, as the Details window is not

available for administrative domains.

The Details window is displayed (FIGURE 14-1).

FIGURE 14-1 Details Window for a Selected Object
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2. Click a tab to view detailed information for that category.

Tip – Some tabs have the ability to display many levels of detail. Double-click icons

in the Details window to see additional levels of information. A category may have

many subcategories.

Tip – If information in a table cell is too long to be displayed in full, you may be

able to see more information by holding the mouse pointer in the cell for several

seconds. A pop-up balloon (tool tip) is displayed, showing the complete text

contained in that cell.

Tip – The hierarchy can be expanded or compressed, depending on the position of

the expansion/compression icon as shown below(FIGURE 14-2). The icon is

compressed when the “handle” is pointing right. The icon is expanded when the

“handle” is pointing down.

Click the compression icon to expand the hierarchy view (“unroll” and display more

levels of detail).
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FIGURE 14-2 Expansion/Compression Icon to Reveal or Hide Additional Levels of Detail

▼ To Close the Details Window

● Click the Close button located at the bottom of the window.

Expansion icon

Compression icon
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▼ To Display Online Documentation

● Click the Help button located at the bottom of the window.

Info Tab

Clicking the Info tab displays the Properties table.

The general properties are listed in the following table.

Browser Tab

The Browser tab displays hierarchy and contents views of the hardware, operating

system, local applications, and remote systems.

See Chapter 8 for detailed information on using the Browser tab.

TABLE 14-2 General Properties in the Info Tab of the Details Window

Property Description

Entity Desc Label that you selected when you created the node.

Entity Full Desc Optional description you entered when you created the node.

Hostname Machine name.

IP Address IP address.

Netmask Netmask associated with the host.

Operating System Operating system type and version.

Entity Family Hardware architecture.

Entity Trap Destination Host IP address of Sun Management Center server which

receives this host’s trap information.

Entity Event Destination Host IP address of Sun Management Center server which

receives this host’s events information.

Entity Polling Type Agent or SNMP.

Target Hostname Host name of the target.

Target IP Address IP address of the target.
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Alarms Tab

The Alarms Details window displays the alarms for the host.

See Chapter 13 for detailed information on using Sun Management Center alarms.

View Log Tab

The View Log tab (FIGURE 14-3) enables you to view system log messages and logged

error messages from the Sun Enterprise™ Diagnostics (EntDiag) software.
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FIGURE 14-3 View Log Tab
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Log File Type Button

You can view two types of messages:

■ System log messages stored in the /var/adm directory

■ EntDiag error messages

File names in the /var/adm directory start with the word “messages”. If the

EntDiag software is installed, it logs error messages by default to the

/var/opt/SUNWentdiag/logs/entdiag.err file.

▼ To View the Log File Messages

● Click the down arrow under the Log file type field and highlight either Syslog or
EntDiag.

The selected type of messages is displayed in the log view table.

Note – Click the Reload button to refresh the display and add the latest log

messages.

Filtering Your Messages

You can apply filters to display only those messages that match the date range and

text pattern that you specify.

▼ To Filter Your Log Request

1. Click the Filter button in the view log (FIGURE 14-3).

The Message Filter Options dialog is displayed (FIGURE 14-4).
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FIGURE 14-4 Message Filter Options Dialog

Note – If you do not want any filters applied to your log messages, click the “No

Filters” button.

2. Using the down arrows, select the starting date by highlighting the month, day,
and year for the first log message you want to view.

3. Select the starting time by using the down arrows.

Highlight the hour and minute for the first log message you want to view.

4. Select the ending date.

Highlight the month, day, and year for the last log message you want to view.

5. Select the ending time.

Highlight the hour and minute for the last log message you want to view.

6. Type the text pattern to be matched in the field marked “Text pattern to match.”
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Note – Select a text pattern that is unique to the type of message in which you are

interested.

7. Click the Advanced button if you want to refine further your filter request.
Otherwise, skip to Step 10.

The advanced Message Filter Options dialog is displayed (FIGURE 14-5).

FIGURE 14-5 Advanced Message Filter Options Dialog

8. To perform a forward or backward search through the log file, select Forward or
Backward.
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9. (Optional) Type the maximum number of log messages that should be matched in
the field marked Maximum matches to report.

If you enter zero (0), all matching messages are reported.

10. Complete this procedure with one of the following actions:

■ Click OK to filter and reload your log messages and close this window.

■ Click Apply to filter and reload your log messages without closing this window.

■ Click Reset to reset to the default parameters.

■ Click Cancel to cancel your request.

Reload Button

Click the Reload button to refresh and reload filtered messages.

Monitor Button

Monitoring enables you to view new log messages as they occur. The new messages

are displayed in the lower half of the split pane window. With your mouse button,

you can adjust the dividing bar between the upper half and the lower half of the

split pane window to view more of one half than the other. Each new message that

arrives is highlighted.

▼ To Monitor Log Messages

1. Click the Monitor button in the view log (FIGURE 14-3).

The Monitor Filter Options dialog is displayed (FIGURE 14-6).
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FIGURE 14-6 Monitor Filter Options Dialog

2. Click the appropriate circle to enable or disable log file monitoring.

The darkened circle indicates your choice.

3. To display only currently monitored log messages, click the check box to clear old
monitored messages.

The check box is displayed with a check mark.

4. Type the text pattern to be matched in the field marked Text pattern to match.

You can use a UNIX regular expression. For information about regular expressions,

refer to the regex(1F) man page.

Note – Select a text pattern that is unique to the type of message in which you are

interested.

5. Complete this procedure with one of the following actions:

■ Click OK to monitor your log messages and close this window.

■ Click Apply to monitor your log messages without closing this window.

■ Click Cancel to cancel your request.

Finding Specific Log Messages

Once a set of filter messages has been loaded into the upper half of the split pane

window, you can search for a specific character sequence within that set of messages.
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Note – Wildcard searches using an asterisk (* ) character, are not supported in the

View Log find feature.

To search for a message that contains the asterisk character, precede the character

with a backslash (\), for example, \*.

▼ To Find a Log Message

1. Type the specific character sequence (part of the log message) in the Find field
(FIGURE 14-3).

2. Click Return or the down or up arrow to search the log messages for that
sequence.

The first matching message is highlighted.

3. Click Return or the down or up arrow to continue your search and find additional
occurrences of the matching sequence.

Applications Tab

This tab enables you to view and select detailed information about processes

running on the selected host or node. If you have any custom or third-party

applications installed, this tab also enables you to view detailed information about

processes running in the selected custom applications or third-party applications.

The displays are continually updated.

● Click on the application listed in the Applications list.

The right side of the window is updated with the selected application.

Note – The View Processes application is displayed by default whenever the

Applications tab is selected.

View Processes

The View Processes application (FIGURE 14-7) enables you to view and select detailed

information about processes running on the selected host or node.
282 Sun Management Center 2.1 Software User’s Guide • November 1999



Note – The Solaris Process Details module must be loaded to use the Process

Viewer. For instructions, see “To Load a Module” on page 229.

Note – If the Solaris Process Details module is not loaded when you first click the

Applications tab, then you must load the module, close the Details Window, and

then reopen the Details window to see the processes. Thereafter, the Solaris Process

Details module is unloaded or loaded dynamically. That is, you no longer need to

close and reopen the Details window to see the processes whenever this module is

unloaded or loaded.
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FIGURE 14-7 Process Viewer
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Configuring the Process Display

▼ Selecting Columns for Viewing

1. Click the View Columns button above the Process table to display the View
Columns pull-down menu.

A pull-down menu is displayed (FIGURE 14-8) that enables you to add or remove

columns from the table.

FIGURE 14-8 View Columns Menu
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2. Highlight one or more process properties that you want to display.

The check box next to each selected property is displayed with a check mark

(FIGURE 14-8) and the right side of the Process Viewer window is updated. The new

column or columns are added to the display, to the right of the existing columns.

The total number of processes displayed is listed in the Process Summary field at the

bottom of the Details window.

TABLE 14-3 lists the properties that are available for the Processes view.

TABLE 14-3 Process Viewer Properties

Property Description

PID Process Identifier.

PPID Process ID of the parent.

UID Effective user ID number.

User Effective user login name.

EUser Effective user ID.

Group ID Group ID of the user.

EGroup Effective group ID of the user.

Session ID Process ID of the session leader.

PGroup Process ID of the process group leader.

Tty Controlling terminal for the process. A question mark (?) is printed

when there is no controlling terminal.

Start time Starting time of the process, in hours, minutes, and seconds. (The

start time for a process that is more than 24 hours old is given in

months and days.)

Time Cumulative execution time for the process.

State State of the process.

Wait Channel Address of an event for which the process is sleeping. If blank, the

process is running.

Class Scheduling class of the process.

Address Memory address of the process.

Size Size (in pages) in main memory for the image of the swappable

process.

Priority Priority of the process.

Nice Decimal value of the system scheduling priority of the process.
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Sorting Columns

You can sort the processes (rows) by the properties (column headers) in ascending or

descending order. For example, you can sort the CPU% column starting with either

the smallest or the largest value first.

▼ To Sort Columns in Ascending Order

● Click the property (table column header).

The processes (rows) are updated in ascending order for that property.

▼ To Sort Columns in Descending Order

● Click the property (table column header) while holding down the Shift key.

The processes (rows) are updated in descending order for that property.

Moving Columns

You can rearrange the order of columns.

▼ To Reorder Columns in the Table

1. Select a column by clicking and holding down the mouse button on the table
column header.

2. Drag the column to the desired position.

CPU% Ratio of CPU time used recently to CPU time available in the same

period, expressed as a percentage.

Memory% Ratio of the process’s resident set size to the physical memory on

the machine, expressed as a percentage.

Command Command name.

CommandLine Full command name and its arguments, up to a limit of 80

characters.

TABLE 14-3 Process Viewer Properties (Continued)

Property Description
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Process Statistics Window

The Output For Process ID window displays statistics for your choice of either

pmap, pstack, pfiles, or pldd for any highlighted process in the Process View

window.

Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

Custom or Third-Party Applications

Note – To develop custom applications, you will need the Sun Management Center

2.1 Developer Environment and documentation. See your Sun authorized sales

representative for more information.

Custom or third-party applications, if you have any installed on your system,

display below Applications - View Processes in the left side of the Applications

Details window. Select the application if you do not want to view process detail

information for a host or node.

After you select an application, the selected properties for the application are

displayed in the right side of the Applications Details window. The properties

shown depend on the application selected.

TABLE 14-4 Process Statistics

Statistic Description

pmap Prints the address space map of each process.

pstack Prints a stack trace for each lightweight process (lwp) in each

process.

pfiles Reports fstat(2) and fcntl(2) information for all open files in

each process.

pldd Prints dynamic libraries for the process.
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Hardware Tab

Note – The Hardware tab is missing if this feature is not supported on your system.

The Hardware Details window (FIGURE 14-9) provides three choices for system

information:

■ Resources (default view)

■ Physical View

■ Logical View

Note – For additional information on the Hardware tab for your specific hardware

object, see your supplement.
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FIGURE 14-9 Hardware Details Window
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▼ To View a Hardware Configuration

Note – If you load or unload the Config-Reader or Dynamic Reconfiguration

modules while the Details window is open you must close, and then reopen the

Details window to see the results.

● Click once to highlight the configuration in which you are interested.

The right side of the window is updated and the selected feature is displayed.

Resources

The Sun Management Center software displays a table of hardware resources of the

selected host (FIGURE 14-9). Here are some typical values displayed in the table.

Your table may appear different. The resources vary, depending on the type of object

displayed in the detail view.

TABLE 14-5 Resources

Resource Description

Total Disks Total number of disks connected to the host

Total Memory Total amount of memory connected to the host

Total Processors Total number of processors connected to the host

Total Tape Devices Total number of tape devices connected to the host
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Physical View

When you select the Physical view, the software displays a photo-realistic picture of

the selected host (FIGURE 14-10), if available. Pictures are not available for some

system types.

Note – This feature is usable only if the host is monitored by a Sun Management

Center agent.
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FIGURE 14-10 Hardware Configuration Physical View
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View Points

If a picture of the system is available, it is displayed. For some systems, you can

select alternate front, rear, and side views by selecting entries in the View Points

pull-down menu. Pictures are not available for some system types.

For some systems, pictures of components such as CPU boards and I/O boards may

also be available. As you move the mouse pointer over various parts of the system

picture, the mouse pointer changes from an arrow to a hand icon when a detailed

picture is available for an individual component. The individual component is

highlighted, and the path name of the component is displayed in the Component

field at the bottom of the window. Click a highlighted component to display the

detailed picture of the component (FIGURE 14-11).
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FIGURE 14-11 Hardware Component Physical View

The arrow buttons below the picture enable you to switch between system and

component views.
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Physical View When a Sun StorEdge Device is Connected

If a Sun StorEdge™ A5000, A5100, or A5200 is connected to the clicked component,

a pop-up menu displays, which lists the devices that are connected. The Sun

StorEdge A5000-series devices are displayed on this menu as sena(0), sena(1), and so

on, as shown in the following figure.

FIGURE 14-12 Pop-up sena Menu
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You can select and view any of these storage devices from the pop-up sena menu.

The following example shows the front view for the A5000 called sena(0). The device

details display in the right section of the physical view window.

FIGURE 14-13 sena (0) Physical View with Details

Dynamic Reconfiguration

The Dynamic Reconfiguration button is displayed in the physical and logical views

only for certain platforms. Refer to your hardware supplement for more information.
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Show/Hide Details

Clicking the Show Details button (see FIGURE 14-10) displays the Property/Value

view (FIGURE 14-14), which displays text describing the component that is selected in

the View Points view. The button toggles between Show Details and Hide Details.

Clicking the Hide Details button turns off the Property/Value view.

Refresh Details

Click Refresh to update the information immediately. Otherwise, the information

does not change from when you first opened the physical view.

Note – The Total Disks field in the Show Details properties only displays the

number of internal disks. This number does not include the disks that are part of

enclosures.
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FIGURE 14-14 Property/Value View

Logical View

The software displays a logical view configuration of a host (FIGURE 14-15) if the host

is monitored by a Sun Management Center agent. (Logical views are not available

for ping hosts.)
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FIGURE 14-15 Hardware Configuration Logical View

Search

Clicking the Search button displays the Search window (FIGURE 14-16). Use the

Search window to search for components in the Logical View window.
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FIGURE 14-16 Search Window

Tip – The Search function is case-sensitive. The error message “Node not found” is

displayed at the bottom of the Details window if the search does not locate the

component in your system.

Tip – The Search function stops at the first instance found. For example, if you enter

the word board , Search always stops at board(0) . To find board #2, enter enough

of the board name. For example, board(2) or just ard(2) are sufficient to identify

the specific target uniquely.

Dynamic Reconfiguration

The Dynamic Reconfiguration feature in the Logical View is the same as is described

in the previous section, “Physical View” on page 292.

Show Details

Clicking the Show Details button (see FIGURE 14-15) displays the Property/Value

view (FIGURE 14-14), which displays text describing the component that is selected in

the View Points view. The button toggles between Show Details and Hide Details.

Clicking the Hide Details button turns off the Property/Value view.

Note – The Total Disks field in the Show Details properties only displays the

number of internal disks. This number does not include the disks that are part of

enclosures.
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CHAPTER 15

Sun Management Center Security

Security in Sun Management Center software is based on Java™ security classes and

SNMPv2 usec (SNMP version 2, user-based security model) security standards. This

chapter discusses security features, users and groups, and their privileges.

The software offers the following layers of security:

■ Only valid Sun Management Center users can use the software.

■ The software enables you to set security permissions or access control categories

and provides control at the administrative domain, group, host, and module

levels.

■ It authenticates user login and access control for individual managed properties.

This chapter contains the following information:

■ Access Control (ACL) Categories

■ Sun Management Center Users

■ Sun Management Center Groups

■ Admin, Operator, and General Functions

■ Specifying Access Control (ACL)

■ Admin, Operator, and General Access

■ Sun Management Center Remote Server Access

■ Using Access Control (ACL)

■ To Add Sun Management Center Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Delete Sun Management Center Users

■ Default Privileges

■ Topology Manager Default Privileges

■ Other Sun Management Center Component and Module Default Privileges

■ Overriding the Default Privileges

■ To Override Default Privileges
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Access Control (ACL) Categories

The software offers the following Access Control (ACL) categories:

■ Admin, like the superuser (root ) in UNIX

■ Operator, as an operator who runs and monitors the system

■ General, like guest access with read-only viewing privileges

To understand ACL categories, we first need to understand Sun Management Center

software users and groups. The following sections explain users and groups.

Sun Management Center Users

Sun Management Center users are valid UNIX users on the server host. As such, the

system administrator has to add valid users into the following file;

/var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into the Sun Management

Center software unless the user logs in as espublic or esmaster since these two

user names are part of this file. (See the following section for more information.)

Public and Private Users

During the Sun Management Center server setup, the file /var/opt/SUNWsymon/
cfg/esusers is created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to have “general” privileges. For example, when a user tries to access

information from a session running in a different Sun Management Center server

from their own, they are given access as espublic and are able to view the

information as a guest only.

■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the software.

The administrator has to add the additional list of user IDs for all other users who

need to log into Sun Management Center software. All users in this file have

“general” access privileges, by default, unless they are given additional privileges

using the procedures described in “Using Access Control (ACL)” on page 311.
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Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

General Users

Any user who is part of the esusers file is known as a “general” user. Sun

Management Center general users can, by default, perform the following functions:

■ Log into the software

■ View the administrative domains, hosts, and modules that are created

■ View the events

■ Trigger manual refreshes

■ Run ad hoc commands

■ Graph data

Sun Management Center Superuser

Implicitly, the Sun Management Center superuser belongs to all the groups

described in the following sections. Sun Management Center superuser has “admin”

privileges as described in “Sun Management Center Administrators or esadm” on

page 306.

Sun Management Center Groups

The following groups are created by default on the server host during the Sun

Management Center server setup:

■ esops
■ esadm
■ esdomadm

In addition, all the Sun Management Center users belong to a hypothetical group,

called ANYGROUP.

The above groups must be defined on the machine where the Sun Management

Center Configuration manager is running. They do not need to be defined on other

machines. These groups are described in greater detail in the sections that follow.
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Note – The preceding groups are defined in the /etc/group file. Note that

although Sun Management Center esmaster and espublic users are configured as

members of the preceding groups, they are not explicitly mentioned in the /etc/
group file.

Sun Management Center Operators or esops

Sun Management Center software users belonging to the group esops are usually

referred to as operator users who run, monitor, and to some extent, configure some

parameters on the managed systems. As you can see in the following list, esops can

perform operations, including some that are allowed for general users:

■ Disable or enable modules

■ Set module active time window

■ Set alarm limits

■ Set rule parameters

■ Run alarm actions

■ Run adhoc commands

■ Set refresh interval

■ Acknowledge, delete, or fix events

■ Enable or disable history logging

■ Set logging history parameters

Sun Management Center Administrators or esadm

Software users belonging to the group esadm can perform “admin” operations,

which are a superset of the operations that can be performed by operator users as

described in “Sun Management Center Operators or esops ” on page 305. In

addition to all the operations that “operator” users (esops ) can perform, these

“admin” users (esadms) can perform the following operations:

■ Load or unload modules

■ Set ACL users and groups

■ View administrative domains, hosts, or modules

Sun Management Center Domain Administrators or
esdomadm

The users belonging to the group esdomadm can perform the following “domain

administrator” operations:

■ Create administrative domains

■ Create groups within administrative domains
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■ Add objects to groups or administrative domains

■ View administrative domains, hosts, or modules

Note – Other than the privileges listed above, a user belonging to “esdomadm” is

just a “general” user, unless configured otherwise.

Admin, Operator, and General Functions

TABLE 15-1 contains the different types of functions users can do by default.

This table is general in nature and applies to all modules. Individual modules may

also have specific restrictions, which are under the control of the module.

TABLE 15-1 Domain Admin, Admin, Operator, and General Functions

Function Domain Admin Admin Operator General

Load modules x

Unload modules x

Create administrative domains x

Create groups within

administrative domains

x x

Add objects to groups or

administrative domains

x x

View administrative domains,

hosts or modules

x x x x

Set ACL users or groups x

Disable or enable modules x x

Set module active time

window

x x

Set alarm limits x x

Set rule parameters x x

Run alarm actions x x

Run adhoc commands x x

Set refresh interval x x

Manually trigger a refresh x x x

Enable or disable history

logging

x x
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In Sun Management Center software, the above categories maintain inclusive
relationships or privileges. This means that, by default, a user who has esadm
privileges can do anything that a user who has esops privileges can. But an

administrator has the option to change the default permissions so that a user who

has esops privileges can do more than a esadm user. Inclusive relationships means

that these three groups, esops , esadm, and esdomadm, do not have any code

enforcement behind them which makes one group more powerful than the other.

For more information on how to override default privileges, see “Overriding the

Default Privileges” on page 318.

Specifying Access Control (ACL)

The administrators (esadm group) can specify ACL features for users and groups for

the following:

■ Administrative domains

■ Groups within administrative domains

■ Hosts

■ Modules

Admin, Operator, and General Access

An ACL specification consists of establishing or defining one or more of the

following:

■ Administrator users and administrator groups

A list of users and groups who can perform administrator operations. By default,

they are esadm or esdomadm, wherever applicable.

■ Operator users and operator groups

A list of users and groups who can perform operator operations. By default, they

are esops .

Set logging history parameters x x

Acknowledge, delete, or fix

events

x x

View events x x x

TABLE 15-1 Domain Admin, Admin, Operator, and General Functions (Continued)

Function Domain Admin Admin Operator General
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■ General users and general groups

A list of users and groups who can perform general operations. By default, this is

a hypothetical group called ANYGROUP.

■ Communities for administrators (SNMP)

A list of SNMP communities that can perform admin operations using SNMP

protocol.

■ Communities for operators (SNMP)

A list of SNMP communities that can perform operator operations using SNMP

protocol.

■ Communities for general (SNMP)

A list of SNMP communities that can perform general operations using SNMP

protocol.

Sun Management Center Remote Server Access

Users can access and view data from sessions running on remote Sun Management

Center servers. When a user tries to gain access to such information, that user is

provided access as espublic (guest) with read-only privileges. The behavior of Sun

Management Center sessions running on different servers is defined in terms of each

session’s server context. See “Sun Management Center Server Context” on page 309

for more information.

As a user, you can access and set up a different server context for a variety of

reasons:

■ To provide for separate security access privileges so that each server context

could have different users and administrators and yet be accessible to each other

■ To allow for physical separation between elements, as in the context of a wide

area network (WAN)

■ To increase performance since this would allow many hosts to be handled by one

set of central components

By linking to a different server context, you can view the top level status of the

objects in the other server context.

Sun Management Center Server Context

A server context is defined as agents running on many hosts, all sharing a single set

of the following central components:

■ Sun Management Center server

■ Topology manager

■ Event manager

■ Trap handler
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■ Configuration manager

A server context is defined as a collection of Sun Management Center agents and the

particular server layer to which the console is connected. Agents within the same

server context can talk to each other. Agents in remote server contexts can talk using

read-only privileges.

Every Sun Management Center component or agent is configured at installation to

know the location of its Trap handlers and Event managers. Sun Management

Center software identifies the Trap handlers and the Event managers by their IP or

port addresses. This means that if you want to determine if you are within your

server context or are accessing information from another server context, you need to

know the respective IP or port addresses of the servers that you access. Different

server contexts have different port numbers.

A remote server context refers to a collection of agents and a particular server layer

with which the remote agents are associated.

FIGURE 15-1 Remote Server Context

An agent gets its security configuration from the server layer. For example:

■ Agents within the same server context can talk to each other.

■ Agents in remote server contexts can talk remotely using read-only privileges.

■ Requests to agents in remote servers are performed as the Sun Management

Center espublic user. This allows successful requests across servers, as long as

Sun Management Center sessions on both servers have the same password for

user espublic .

Console

 Server

Agent Agent Agent

Server

Server context 1 Server context 2
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■ Each Sun Management Center server maintains a list of agent IP or port address,

to distinguish objects in its own context from objects on a different Sun

Management Center server.

Limitations While Crossing Servers

Some security restrictions apply when a user tries to communicate across server

contexts.

In the current Sun Management Center environment, you can access information

from another server with a few limitations:

■ If you try to access a different or remote server context, the server give you access

with espublic user privileges. Thus you can access data but cannot modify or

use the objects within the different server. You are restricted only to viewing the

remote server objects. Therefore, the following consequences apply:

■ You can access other server contexts as long as the espublic user password is

the same in all contexts.

■ You can view data in another context as user espublic , but you cannot

perform control actions, such as setting alarm thresholds, and other similar

functions.

■ Edit functions work differently in a remote server. For example, you can copy and
paste between contexts but cannot cut and paste between contexts.

Note – From a graphical user interface perspective, it is important to note that it

may not be obvious that you are accessing a different server context. To identify if

you are accessing a different server, check the server’s IP port number or address in

the Info tab of the Details window.

Using Access Control (ACL)

The following sections describe how to perform the following key ACL functions:

■ To Add Sun Management Center Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Grant a User esadm, esops , or esdomadm Privileges

■ To Delete Sun Management Center Users
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▼ To Add Sun Management Center Users

1. Become superuser (on the Sun Management Center server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.

Note – By adding a user to the users list, the user has default privileges. See

“Default Privileges” on page 317 and “Overriding the Default Privileges” on

page 318 for more information.

▼ To Access ACL on a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Attribute Editor

from the pop-up menu.

■ Select Tools ➤ Attribute Editor in the main console window.

The Attribute Editor is displayed. The buttons at the bottom of the window are

grayed out, with the exception of the Cancel and Help buttons. The remaining

buttons become active if you modify any field in the window.

2. Select the Security tab within the Attribute Editor window (FIGURE 15-2).

3. Change the values as required.

For example, you may enter data as follows:
312 Sun Management Center 2.1 Software User’s Guide • November 1999



FIGURE 15-2 Example of Security Fields in the Attribute Editor

Note – Use spaces or commas between multiple entries as illustrated in the entries

for “Operator” under “Users.”
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The preceding example of the Attribute Editor with the Security tab selected

contains the following field entries:

Note – For more information on security privileges, see “Access Control (ACL)

Categories” on page 304.

TABLE 15-2 Security Attributes

Attribute Description

Administrator Users A list of users. jim is a user who can perform administrator

operations

Operator Users A list of operators. john and others are users who can perform

operator operations. Note that their entries are separated by one or

more spaces

General Users A list of general users. Here, nick and richie are users who can

perform general operations

Administrator

Groups

All the users belonging to esadm and administrators can perform

administrator operations. By default, they are esadm or esdomadm,

as applicable

Operator Groups All users belonging to esops can perform operator operations

General User Groups ANYGROUPis a hypothetical group that can perform general

operations. All Sun Management Center users belong to this

hypothetical group

Communities for

Administrators

This field is empty denoting that there is no SNMP community that

can perform admin operations using the SNMP protocol

Communities for

Operators

This field is empty denoting that there is no SNMP community that

can perform operator operations using the SNMP protocol

Communities for

General Users

public is an SNMP community that can perform general

operations using the SNMP protocol
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▼ To Add a User-Defined Group to an ACL

1. Become superuser.

2. Create a group:

3. Add users to the newly created group:

a. Edit the /etc/group file.

b. Add users to the group.

c. Save the file and exit the editor.

4. Add the new group to the ACL of interest.

See “To Access ACL on a Module” on page 312 for more information.

▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid Sun Management Center user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.

# /usr/sbin/groupadd groupname
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▼ To Delete Sun Management Center Users

1. Become superuser on the Sun Management Center server host.

2. Edit the file /var/opt/SUNWsymon/cfg/esusers .

3. Delete the line corresponding to the user name you want to delete.

4. Save the file and exit the editor.

5. Delete the user names from additional groups.

After a user is deleted from the list of Sun Management Center users, the user can

no longer log into the Sun Management Center server. Make sure to delete that user

from all the ACLs.
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Default Privileges

Administrative domains are manipulated by the Topology manager. This section

illustrates the default privileges for the Topology manager and for other agents and

modules.

Topology Manager Default Privileges

The default privileges for Topology manager (where administrative domains are

maintained) are listed in the following table.

TABLE 15-3 Default Privileges for Topology Manager

Topology Manager Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

List of Admin Groups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP
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Other Sun Management Center Component and

Module Default Privileges

The default privileges for all other components and modules are listed in the

following table.

The keyword ANYGROUPis not a true UNIX group, but is a special keyword that

means that “any user who can log into Sun Management Center software is given general
access to the objects.”

Overriding the Default Privileges

In Sun Management Center software, only administrators can override default

privileges using the Attribute Editor to modify the ACL lists for that particular

object.

The following section illustrates how to override default list privileges.

TABLE 15-4 Sun Management Center Component and Module Default Privileges

Components/Modules Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin Groups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public
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▼ To Override Default Privileges

● Create the following override files in the /var/opt/SUNWsymon/cfg directory:

■ agent-acls-d.dat

■ topology-acls-d.dat

■ event-acls-d.dat

■ cfgserver-acls-d.dat

■ trap-acls-d.dat

The following example creates an admin group wheel for the agent instead of the

esadm. By default, it makes user 1, margot, and user 2, helen , admin users for

that agent.

Note that the lists of names are separated by spaces, such as, helen and margot .

The lines beginning with a pound sign (#) are comment lines and you may ignore

them. They are presented here for reference purposes only.

Note – Remember to create similar files for each component or machine.

For platform-specific information about security, see your supplement.

#   File:    agent-acls-d.dat
#   Version: %I% %E% %U%
#
#   Copyright (c) 1993-1997 Halcyon Inc.
#
#   e.g.
#       adminUsers =
#       operatorUsers =
#       generalUsers =
#       adminCommunities =
#       operatorCommunities =
#       generalCommunities =
#       adminGroups =
#       operatorGroups =
#       generalGroups =
#
       adminUsers = helen margot
       adminGroups = wheel
       operatorGroups = esops
       generalGroups = ANYGROUP
       generalCommunities = public
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APPENDIX A

Getting Started With Sun
Management Center Software

TABLE A-1 is an example of how you can use the Sun Management Center software.

This table includes a summary of some typical tasks and the order in which they

should be done. Each task is referenced to another section in the manual, which

provides detailed, step-by-step directions.

The tasks and the order in which they are included in this table is based on the

assumption that you will explore and learn the software before setting up your

actual monitoring environment.

TABLE A-1 Example Use of Sun Management Center Software

Task For More Information, Go to

Create an administrative domain. “To Create Administrative Domains” on

page 60

Populate the administrative domain by creating objects. Chapter 5

Populate the administrative domain with the Discovery

manager.

Chapter 6

Familiarize yourself with the console window. Chapter 7

Navigate through Sun Management Center software using the

hierarchy (tree view).

“Hierarchy View” on page 120

Navigate through Sun Management Center software using the

topology view.

“Topology View” on page 122

Open the Details window. “To Start the Details Window” on page 136

Load other modules. “To Load a Module” on page 229

Disable some modules “To Disable a Module” on page 241

Unload some modules. “To Unload a Module” on page 242
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Note – For additional information specific to your hardware, see your supplement.

Monitor your system using the modules. Appendix C and Appendix D

Explore the different modules. “Browser Tab” on page 139

Explore the processes view. “View Processes” on page 282

Explore the view log function. “View Log Tab” on page 275

Explore the physical view. “Hardware Tab” on page 289

Explore the logical view. “Hardware Tab” on page 289

View a property table. “Monitoring Data Properties” on page 149

View a graph of a property table. “To Graph A Monitored Data Property” on

page 164

Create an alarm. “To Create an Alarm” on page 187

Watch the alarm go up the hierarchy (tree) view. “To Create an Alarm” on page 187

View the alarm through the Details window. “Viewing Alarm Information” on page 256

View the alarm through the administrative domain status

summary.

“To Access Alarms from the Main Console

Window” on page 259

Sort the alarms and become familiar with the Alarms window. “Information on Alarms” on page 260

Acknowledge the alarm. “Acknowledging and Deleting Alarms” on

page 267

Delete the alarm. “Acknowledging and Deleting Alarms” on

page 267

Create alarm conditions. “To Create an Alarm” on page 187

Set the refresh interval. “Refresh Tab in the Attribute Editor” on

page 194

Set security. Chapter 15

TABLE A-1 Example Use of Sun Management Center Software (Continued)

Task For More Information, Go to
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APPENDIX B

Miscellaneous Sun Management
Center Procedures

This appendix documents the following procedures:

■ To Regenerate the Security Keys

■ To Configure a Legacy SNMP Agent as a Subagent of a Sun Management Center

Agent

■ To Increase Agent Memory Size

■ To Determine if a Port Is Used

■ To Reconfigure Sun Management Center Software to Use Nondefault Port

Addresses

■ To Reconfigure Sun Management Center SNMP Port Addresses

■ To Reconfigure Sun Management Center RMI Port Address

■ To Create a Server Component as a Monitored Object

■ To Increase the Critical Threshold for the Virtual Size Data Property.

■ To Change the Default Values for Smart Delete in the Event Manager

■ To Use ccat to Read Sun Management Center Log Files

■ To Use ctail to Read Sun Management Center Log Files

■ To Resolve a Hanging Main Console Window

■ To Customize the Tools Menu

■ How to Use the Sun Management Center SNMP MIBs in a Third Party

Management Station

■ How to Access the Modules with Multiple Instances

Regenerating Security Keys

The Sun Management Center setup generates the security keys for Sun Management

Center components using the following default settings:

■ Valid Sun Management Center users are espublic and esmaster
■ Sun Management Center superuser is esmaster
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Note – The software uses an 8-character string as a seed to make the generated key

unique. During setup, you have the option to use the default Sun Management

Center seed or to use one that you create. The same seed must be used for all server

and agent setups in a given server context. For more information on server context,

see Chapter 15.

Sun Management Center setup does not create UNIX accounts for the special users

espublic and esmaster . You should not need to log into the Sun Management

Center console using these user IDs because they are reserved for internal

communication between processes. However, some troubleshooting activities may

require you to log in using one of these user IDs. If so, you have to create it and

assign a password using the normal UNIX commands useradd and passwd .

The esmaster user ID bypasses normal permission checks, so use it with care. For

normal operation, use an existing login account. Setup provides an opportunity to

specify an existing user as a Sun Management Center administrator. This user ID is

added to the esadm and esdomadm groups as well as the esusers file. For more

information on security and the Sun Management Center superuser, see Chapter 15.

The security keys for the components need to be regenerated if one or more of the

following is true:

■ UDP ports of any of the Sun Management Center agents are changed.

■ Host names or IP addresses of the Sun Management Center agent host change.

Note – Changing the host name or the IP address of the Sun Management Center

server is not supported.
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▼ To Regenerate the Security Keys

Note – In these examples, shared_secret stands for a secret string of up to eight

characters that is common to all machines in a server context. It is required as an

argument to the script base-usm-seed.sh . A default (maplesyr ) is provided by

the software, but you can specify your own password if desired. This secret string or

password is used to generate keys for communication between processes.

-u public is needed to respond to external SNMP requests with public
communities.

1. Log in as root .

2. Depending on your installation, type one of the following.

■ If you installed only the agent layer, type:

■ If you installed only the server layer, type:

■ If you installed both the agent and server layers on one host, type:

3. Restart the Sun Management Center server.

See “To Start the Sun Management Center Software” on page 46.

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c agent -u public

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c topology -u public
# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c trap event
cfgserver servers

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -u public
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Configuring a Legacy SNMP Agent as a
Subagent of a Sun Management Center
Agent

A legacy SNMP agent is a SNMP agent that is not part of the Sun Management

Center agent framework. In real world situations, you may need to configure one or

more legacy agents as subagents of a Sun Management Center agent.

Any legacy SNMP agent can be configured as a subagent of a Sun Management

Center Agent provided that:

■ The legacy agent can run on a port other than 161.

■ The legacy agent configuration supports running that agent as a non-daemon

process.

■ You have the legacy agent MIB definition file.

▼ To Configure a Legacy SNMP Agent as a

Subagent of a Sun Management Center Agent

1. Log in as root.

2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist,
copy it from the /opt/SUNWsymon/base/cfg directory:

3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x , find the block
that is similar to the following.

# cp /opt/SUNWsymon/base/cfg/subagent-registry-d.x /var/opt/SUNWsymon/cfg/
326 Sun Management Center 2.1 Software User’s Guide • November 1999



4. Remove the comment symbol at the beginning of the line (#) so that the code now
looks like the following.

5. Modify the lines as follows:

a. Change sa2 to the unique subagent name for the agent.

b. type is legacy .

# sa2 = {
#    type             = legacy
#    persist          = false
#    snmpPort         = "20001"
#    errorAction      = restart
#    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
#    stopCommand      = "kill -9 %pid"
#    pollInterval     = 60
#    pollHoldoff      = 60
#    oidTrees         = 1.3.6.1.2.1
#    snmpVersion      = SNMPv1
#    securityLevel    = noauth
#    securityName     = espublic
# }

sa2 = {
    type             = legacy
    persist          = false
    snmpPort         = "20001"
    errorAction      = restart
    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
    stopCommand      = "kill -9 %pid"
    pollInterval     = 60
    pollHoldoff      = 60
    managedTrees     = "mib-2 sun"
#    oidTrees        = 1.3.6.1.2.1
    snmpVersion      = SNMPv1
    securityLevel    = noauth
    securityName     = espublic
 }
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c. persist is false if the subagent is stopped when the Sun Management
Center agent exits. If this value is true , then the Sun Management Center
agent does not stop the subagent when the Sun Management Center agent
exits.

d. snmpPort is the UDP port number on which you want to run the subagent.

e. errorAction can be restart , ignore , or kill . If the restart option is
used, then the Sun Management Center agent tries to restart if it encounters an
error when communicating with the subagent. The other options result in the
respective behaviors.

f. startCommand is the mandatory command to start the subagent. This
command should contain %port , which is replaced by the value given in
snmpPort .

g. stopCommand is the command to stop the process. %pid can be used to
represent the process ID (PID) of the subagent process.

h. pollInterval defines the time (in seconds) in which the Sun Management
Center agent polls the subagent.

i. pollHoldoff is the time (in seconds) after which the first poll is done on the
subagent after the latter is started by the Sun Management Center agent.

j. oidTrees gives the space-separated list of SNMP OIDs managed by the
subagent.

k. snmpVersion can take values SNMPv1and SNMPv2.

l. securityLevel can be priv , auth , or noauth.

m. securityName is the SNMPv1 community name or SNMPv2 security name to
use.

For more details, refer to the descriptions in the subagent-registry-d.x file.

6. Stop then restart the agent:

# /opt/SUNWsymon/sbin/es-stop -a
# /opt/SUNWsymon/sbin/es-start -a
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Agent Exits During Startup

The Sun Management Center agent has the ability to monitor itself and restrict it’s

memory usage. To do this, there are some predefined limits that have been set for

the memory usage of the agent process. These limits are highly dependent on:

■ The number of modules loaded

■ The type of modules loaded

■ The type of the system being managed

On rare occasions, the default memory usage limit is exceeded during the agent

startup and the agent stops running. This is an indication that the default limits set

for the agent memory size are not enough for your configuration.

To confirm that memory usage is the cause, look in the /var/opt/SUNWsymon/
log/agent.log file for one of the following messages:

or

If you see one of these messages during the agent startup, reconfigure the memory

usage limits on the agent host using the following procedure.

▼ To Increase Agent Memory Size

1. Become superuser on the agent host.

2. Copy the file agent-stats-d.def to /var/opt/SUNWsymon .

Excessive Virtual Memory Use

Excessive Physical Memory Use

# su

# cp /opt/SUNWsymon/modules/cfg/agent-stats-d.def /var/opt/SUNWsymon/cfg/
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3. Edit the file as shown in the following example:

4. To increase the agent memory size, increase the alarmlimit:error-gt to the
desired value in the following code segment. (The value is in Kbytes.)

5. Save the file and restart the agent.

Configuring Sun Management Center
Software to Use Different Port Addresses

This section describes how to configure Sun Management Center software when

there is potential conflict for port addresses.

▼ To Determine if a Port Is Used

● To determine if a specific port number is used in your system, type:

The Sun Management Center server communicates with the Sun Management

Center agents and the other server components (Topology manager, Configuration

manager, Event manager, and Trap handler) using SNMP. By contrast, the server

communicates with the Sun Management Center consoles using remote method

invocation (RMI).

# vi /var/opt/SUNWsymon/cfg/agent-stats-d.def

 procstats = {
        size = {
            statusActions(error-gt)     = abort
            statusService(abort)        = _internal
            statusCommand(abort)        = abort "Excessive Virtual Memory Use"

            alarmlimit:error-gt = 70000
            alarmlimit:warning-gt = 60000
            alarmlimit:info-gt =
        }
     .....
     }

# /bin/netstat -an|grep port_number
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Several components require the use of network ports, as shown in the following

table.

Note – The SNMP port definitions for Sun Management Center components are

found in two files: the /var/opt/SUNWsymon/cfg/domain-config.x file, which

exists in every machine running any Sun Management Center component, and the

/var/opt/SUNWsymon/cfg/server-config.x file, which exists on machines

that have the Sun Management Center server component installed.

In the domain-config.x file, there is one configuration block for each of the

SNMP-based Sun Management Center agents. In each configuration block there is

(at least) one line which defines the port address for the corresponding agent. The

default port definition for the Sun Management Center server is in the

server-config.x file.

Setup scripts automatically configure the components by using the default port

addresses. However, if any of the default ports are being used, then you must take

action to avoid such conflicts in network port addresses.

▼ To Reconfigure Sun Management Center

Software to Use Nondefault Port Addresses

1. Run the es-setup script to create the domain-config.x and server-config.x
(server configuration setup) files.

2. Edit these files with the new port numbers.

See the next section and “To Reconfigure Sun Management Center RMI Port

Address” on page 332 for more information.

TABLE B-1 Sun Management Center Default Port Addresses

Layer Component Default Port Number

Agent agent 161

Server Trap handler 162

Server Event manager 163

Server Topology manager 164

Server Configuration manager 165

Server server 2099
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▼ To Reconfigure Sun Management Center SNMP

Port Addresses

1. Log in as root.

2. Edit the domain-config.x file and change the address port to an unused port.

This example illustrates changing the agent default port address from 161 to 1161 .

Before:

After:

3. Save the file.

Note – Hosts with Sun Management Center agents using port addresses other than

161 can be added to the administrative domain manually by using the Create

Topology Object window or can be discovered automatically by specifying the port

number in the discovery parameters. (For more information on the Create Topology

Object window, see Chapter 5. For more information on how hosts are discovered

automatically, see Chapter 6). Since you can only specify one port number in

addition to port 161, it is best to select an alternate port number and use that number

for all agent installations.

▼ To Reconfigure Sun Management Center RMI

Port Address

1. Log in as superuser.

2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.

agent = {
      snmpPort = 161

agent = {
      snmpPort = 1161
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3. Search for the block which starts with rmiReceptor .

For example:

4. Uncomment the line that reads property:rmiPort = 2099 by deleting the
pound (#) character.

5. Change the address port to a new unused port number.

For example:

This example illustrates changing the server default port address from 2099 to

1199 .

6. Save the file.

rmiReceptor = {
    [ use RECEPTORS.RMI ]

#    property:rmiPort = 2099
#    property:rmiHost = localhost

    # 0 means user authentication is disabled
    # 1 means user authentication is enabled
    # property:securityFlag = 1

    # -1 means no limit
    # 0 means make a guess at a limit (base on # of fd's)
    # >0 specifies the exact limit
#
}

property:rmiPort = 1199
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Monitoring Topology Manager and
Event Manager

There are five components in the server layer:

■ Sun Management Center server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

With the exception of the server, the other four components are Sun Management

Center agents loaded with specialized modules.

You may want to monitor the Topology manager, Trap handler, Configuration

manager, and Event manager to determine their status. See the next section for more

information.

The Configuration manager and the Trap handler are configured so that you do not

need to perform any maintenance procedures. In addition, the default configurations

of both the Topology manager and the Event manager work for most user

environments. However, you can modify the default configurations for specialized

environments.

The default configuration for the Topology manager and the Event manager (and all

other Sun Management Center agents) is defined by the Agent Statistics module. See

“Agent Statistics Module Version 2.0” on page 387 for more information about this

module.

This module includes features that guard against errors that may bring down the

host. The default action is for the software to terminate the Topology manager

process if predefined thresholds are exceeded.
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▼ To Create a Server Component as a Monitored

Object

1. In the main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Group.

For more information, see “To Create a Node” on page 74.

2. Click the Node tab.

The window changes to display settings available for nodes.

3. Click the Monitor Via button to see the pull-down menu, then select Sun
Management Center Agent - Host.

4. Type the name of the server component in the Node Label field.

5. (Optional) Enter a description of the node.

6. Enter the name of the Sun Management Center server in the Hostname field.

7. Type the port number for the server component in the Port field (FIGURE B-1).

See the table entitled “Sun Management Center Default Port Addresses” on page 331

for the default port values for each of the server components.

8. Complete this procedure with one of the following actions:

■ Click OK to create the server component object and close this window.

■ Click Apply to create the server component object without closing this window.

■ Click Cancel to cancel your request.
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FIGURE B-1 Creating a Server Component as a Monitored Object
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Topology Manager

The Topology manager enables the main console window to present logical objects

in a topology view. It also provides the ability to create a logical object (such as a

group) whose status summarizes the statuses of managed objects residing on

multiple hosts.

Managed objects include networks, hosts, hardware components, and software

components. The total number of objects and the contents of these objects determine

the system resource requirement (for example, Virtual Size) for the Topology

manager. This requirement must be less than the defaults set for the Topology

manager.

If the Virtual Size of the Topology manager exceeds the default value, then the

Topology manager exits with the error message, “error excessive virtual memory

use.” To solve this error, you need to increase the default virtual size by completing

the following procedure after you have carefully evaluated the situation.

▼ To Increase the Critical Threshold for the Virtual

Size Data Property.

1. Create the Topology manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 335.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Topology manager object icon and highlight

Details from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Topology manager icon in the hierarchy

view or the topology view.

■ Select the Topology manager icon in the main console window, then select Tools

➤ Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Double-click on the Agent Statistics icon in the contents view or single click in
the expansion/compression icon next to the Agent Statistics icon in the hierarchy
view.

The Agent Statistics folders are displayed.

5. Double-click on the PA Process Statistics folder icon in either the hierarchy or the
contents view.

The monitored properties are displayed in a property table (FIGURE B-2).
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FIGURE B-2 PA Process Statistics Property Table

6. Select the Virtual Size table cell, then proceed with one of the following:

■ Click the right mouse button in the table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

7. Click on the Alarms tab button.

The alarm rows are displayed (FIGURE B-3).

8. Type the desired value in the Critical Threshold (>) field.

9. Complete this procedure with one of the following actions:

■ Click OK to create a new Critical Threshold value and close this window.

■ Click Apply to create a new Critical Threshold value without closing this

window.

■ Click Cancel to cancel your request.
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FIGURE B-3 Alarms Tab for the Virtual Size Property in the Topology Manager Object
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Event Manager

The Event manager communicates with other server components through SNMP

using the default port 163. Similar to the Topology manager, the Event manager is

also loaded with the Agent Statistics module. In addition, the Event manager is

automatically loaded with a specialized Event Management module which is

displayed in the Browser Details window in the Local Applications category.

The Event Management module is responsible for the overall maintenance of the

event database. Its responsibilities include purging deleted events, renaming the

trash file, and “smart delete” (FIGURE B-4).

FIGURE B-4 Event Management Module Data Properties

Smart delete means that Sun Management Center software automatically deletes

closed, fixed, and open events from the event database after a set period of time. By

default, the closed or fixed events are removed from the database after seven days

and the open events are removed after 30 days. You can change these defaults with

the following procedure.

▼ To Change the Default Values for Smart Delete

in the Event Manager

1. Create the Event manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 335.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Event manager icon and highlight Details

from the pop-up menu in the hierarchy view or the topology view.
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■ Double-click the left mouse button on the Event manager icon in the hierarchy

view or the topology view.

■ Select the Event manager icon in the main console window then select Tools ➤

Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Select the Event Management module and proceed with one of the following:

For more information, see “To Edit Module Parameters” on page 239.

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view or the contents view.

■ In the Details window, select Module ➤ Edit Module.

The Module Parameters Editor is displayed.

5. Type the new time values into the editable fields.

The default time values are displayed in FIGURE B-5.

6. Alternately, you may turn off “smart delete” by selecting Disabled in the
pull-down menu next to the Smart Delete Enabled Switch field.

7. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the Module Parameter Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE B-5 Module Parameter Editor for the Event Management Module
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Reading Sun Management Center Log
Files

The server and agents write to various log files in the directory,

/var/opt/SUNWsymon/log .

These files are “circular log files.” A circular log file does not grow in size after a

certain limit. As new messages are logged into the file, the oldest messages are

removed.

Use the es-run interface with the ctail and ccat commands to view these log

files. The es-run interface sets up the proper environment to run Sun Management

Center utilities. The utilities ccat and ctail display only the relevant data, after

sorting the data in chronological order. The ccat and ctail commands are similar

to the UNIX cat and tail commands, but are intended for use with Sun

Management Center circular log files.

▼ To Use ccat to Read Sun Management Center

Log Files

The ccat command reads the specified log file, sorts the messages in

chronologically ascending order, and writes to the standard output. The ccat
command takes one argument, which is the full path to the circular log file.

● Use the es-run interface with the ccat command:

▼ To Use ctail to Read Sun Management Center

Log Files

The ctail command reads the circular log file and by default writes the last 15 lines

of the file to standard output.

# /opt/SUNWsymon/sbin/es-run ccat path_to_file/filename
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The ctail command takes four arguments: filename and the -f , -l , and -n options

where:

The filename argument is the full path name to the circular log file. The filename
argument is mandatory.

-f option is used to monitor the growth of the log file. As the log file grows, the

messages appended to the file are also written to the standard output. The ctail
-f option is similar to the -f option for the UNIX tail command.

-l option is used to print the absolute line number at the beginning of each

message.

-n NumOfLines option is used to change the number of lines displayed. By default

only the last 15 lines are printed.

● Use the es-run interface with the ctail command:

Sun Management Center Server Issues

This section discusses how the main console window hangs when users are

attempting to start a new console window and connect to the Sun Management

Center server. However, existing console window connections encounter no

problems.

Hanging Main Console Window

This problem occurs because:

■ The server memory is used up - Threads that are reading from a socket can hang

when there is a large discrepancy between the read and write rates at either end

of a socket. The memory problem occurs when the Sun Management Center

server has a large amount of buffered data waiting to be sent to its clients. This

buffered data is so large that the server runs out of memory while trying to write

to the socket. Once this happens, the server does not recover.

Note – If you are monitoring the server log file, use the following command:

/opt/SUNWsymon/sbin/es-run ctail -f /var/opt/SUNWsymon/log/server.log.

You may see one or several messages that the server is out of memory.

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] path_to_file_filename
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■ The console memory for the console process is used up - If that is the case, you may be

able to confirm this by selecting the Sun Management Center Console Messages

option under the File Menu on the main console window. The Sun Management

Center Console Messages window may display one or several messages that the

console is out of memory.

▼ To Resolve a Hanging Main Console Window

● If the server memory is used up, increase the memory available to the server
process. The default size is 64 Mbytes.

For example, to double the default memory from 64 Mbytes to 128 Mbytes.:

Note – If your server is invoked using the es-start -A command, or by

rebooting, customize the default memory size by changing -Xmx64m to the desired

size in the /opt/SUNWsymon/classes/base/server/bin/es-server.sh file.

● If the console memory is used up, the solution is to restart the console with a
bigger memory size.

Here is an example of increasing the memory to 100 Mbytes:

This process allocates more memory to the console for this one session.

Note – To allocate more memory without having to re-enter the option

-- -Xmx<size> for every session, change the default memory size from -Xmx64m
to the desired size in the /opt/SUNWsymon/classes/base/console/bin/
es-console.sh file

# es-start -s -- -Xmx128m

# es-start -c -- -Xmx100m
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Adding Customized Menu Items

Sun Management Center software enables you to customize the Tools menu by

adding external, stand-alone applications that can be launched from the main

console window. The application must be written in Java, although non-Java

applications are accommodated by the ExampleSystemCommand Java wrapper class

that executes another program or shell script in a separate process. The application

does not require a selected host object, and it has no further interaction with Sun

Management Center once it has been launched.

The name of the application (as specified in the console-tools.cfg file) is added

to the Tools menu in the main console window below the standard menu items

provided by the Sun Management Center software. The application that is launched

is displayed in a separate window.

The console-tools.cfg file is a plain text file which resides on the Sun

Management Center server host. The file may be modified at any time (including

while the console is running), but changes introduced by editing the files will not

take effect until the es-tool script is executed and the console is restarted. The file

consists of a series of lines, each of which describes an application; blank lines and

lines beginning with the pound sign ‘#’ are ignored. Fields within each line are

separated by commas ‘,’.

▼ To Customize the Tools Menu

1. Using a standard text editor, add the following line to the
/var/opt/SUNWsymon/cfg/console-tools.cfg file.

Each application implemented as a shell script or an executable binary is defined by

a line with the following format:

where:

■ menu label — the string that is displayed in the Tools menu. The string can be

either unlocalized or localized text. Unlocalized text can contain embedded spaces.

Localized text must be specified as a property_file:key pair, where property_file is the

name of the file containing the localizable messages for a particular locale, and key
is the identifier used to locate the string that is displayed in the Tools menu in the

property file. Note that spaces are not allowed in the key.

■ class — the fully qualified Java class name.

menu_label,class [args]
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■ args — the list of arguments to the class.

For example, the following file shows entries for three applications to be added to

the Tools menu: Example GUI , telnet , and ftp .

Caution – Each entry must be specified on a single line, even though the text is

shown wrapped in the example.

Note – The Java wrapper class SMSystemCommand enables you to execute an

arbitrary shell command. This class takes two arguments. The first argument is the

shell command to execute:

- If a program name is specified, give a full path name.

- If there are embedded spaces, enclose the entire shell command in double quotes.

The second argument is the command to run on a Microsoft Windows client. For

example: com.sun.symon.base.client.console.SystemCommand "<shell
command>" "<windows command>"
In this case, the first argument is ignored.

Variable substitution is performed on the arguments if special variable references are

present. The allowed variables are:

$host (replaced with the currently selected agent host name)

$port (replaced with the currently selected port number)

2. Place the Java class files for the applications in the /opt/SUNWsymon/apps/
classes directory.

3. Run the es-tool update script on the Sun Management Center server host.

# Format:
# menu_label, class arguments

Example GUI,exampleApp.ExampleGUITool

Telnet,com.sun.symon.base.client.console.SMSystemCommand
“/usr/openwin/bin/xterm -e telnet $ host " "start telnet $ host "

exampleApp.ExampleSystemCommand:ftp,exampleApp.ExampleSystemCommand
"/usr/openwin/bin/xterm -e ftp $host " "start ftp $host "

# /opt/SUNWsymon/sbin/es-tool /var/opt/SUNWsymon/cfg/console-tools.cfg
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4. Stop the console by selecting File ➤ Exit from the menu bar on the main console
window.

5. Click the Exit button to exit the application.

6. Restart the console for the application to be added to the Tools menu.

Note – Depending upon your site’s configuration, it may also be necessary to restart

the Sun Management Center server.

SNMP MIBs for Sun Management Center
Modules

Sun Management Center 2.1 software publishes the Simple Network Management

Protocol Management Information Bases (SNMP MIBs) for the modules. The MIB

file is an Abstract Syntax Notation (ASN.1) specification of the data that is modeled

(in this case, by the Sun Management Center module). These MIBs can be used as

the data definition by third party SNMP-based management stations (for example

HP OpenView and Unicenter TNG). Sun Management Center has MIBs for the

following modules:

■ file-scan.mib
■ health-monitor-mib.mib
■ kernel-reader-mib.mib
■ nfsmon-mib.mib
■ nfsstat-mib.mib
■ print-spool-mib.mib
■ process-details-mib.mib
■ process-monitor.mib
■ trap-mib.mib

The above MIBs are installed by default, in the /opt/SUNWsymon/util/cfg
directory by the Sun Management Center software during installation of the agent

layer. (Depending on your installation, your base directory may be different.)

# /opt/SUNWsymon/sbin/es-start -c
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▼ How to Use the Sun Management Center SNMP

MIBs in a Third Party Management Station

1. Preprocess the MIBs.

Some SNMP management stations can read the ASN.1 MIBs. Others require the

ASN.1 MIBs to be converted to some other format in order to be read. For example,

you may need to convert the MIB to a Guidelines for the Description of Managed

Objects (GDMO) format or use a MIB compiler to generate another intermediate

format.

2. Load the MIB.

Load the ASN.1 MIB or a preprocessed format of that MIB into the third party

management station. You are informing the third party management station about

the layout and composition of the data that is modeled by the MIB.

3. Use the MIB information to talk to the Sun Management Center agent.

Once the MIB is successfully loaded into the third party SNMP agent, you can

communicate with the Sun Management Center agent and get the data from the

MIB. However, the module must be loaded and enabled in the Sun Management

Center agent.

For example, you can start issuing the SNMP Get commands on some of the

variables in the MIB.

Note – By default, the Sun Management Center modules are enabled for SNMP Get
commands by using the SNMPv1 community ’public’ and SNMPv2 username

’public’. However, if the Sun Management Center module has different settings, then

you need to use the right community and username to communicate with the Sun

Management Center agent.

Note – Since Sun Management Center agents operate with SNMPv2usec-based

security, SNMP Set commands on the agent are involved. Refer to the SNMPv2usec

related Request For Comments (RFCs) for more information.
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▼ How to Access the Modules with Multiple

Instances

SNMPv2 uses the term ’context’ for the MIBs that can have multiple instances of the

module loaded on the agent. If you are using a SNMPv2-based third party

management station to communicate with this type of agent, then be sure you are

using the right context information. However, if you are using a SNMPv1-based

management station, then complete the following step.

● Add the context information to the SNMP community as follows:

Adding this context information enables you to access data from multiple instances

of the same module running on an agent.

community:context
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APPENDIX C

Sun Management Center Software -
Operating System Modules

The Sun Management Center software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 12 and presents them in their respective categories.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, see the next appendix,

your supplement, or go to the Sun Management Center web site:

http://www.sun.com/sunmanagementcenter .

■ Operating System

■ Directory Size Monitoring Module Version 2.0

■ File Monitoring Module

■ MIB-II Instrumentation Module 1.0

■ Kernel Reader Module 2.0

■ NFS Statistics Module Version 2.0

■ Solaris Process Details Module Version 2.0

■ Simple MIB-II Module Version 1.0

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 12.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.
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The following table lists the modules described in this appendix alphabetically and

provides details on those modules that are automatically loaded and those that can

be loaded multiple times. It also points out those modules that utilize the Add Row

utility.

Operating System

The following modules, when loaded, are found under the operating system icon:

■ Directory Size Monitoring Module Version 2.0

■ File Monitoring Module

■ MIB-II Instrumentation Module 1.0

■ Kernel Reader Module 2.0

■ NFS Statistics Module Version 2.0

■ Solaris Process Details Module Version 2.0

TABLE C-1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Config-Reader Module1

1. Refer to your platform-specific supplement for more information on the Config-Reader module.

X

Directory Size Monitoring Module

Version 2.0

X X

Dynamic Reconfiguration

Module2

2. Refer to your platform-specific supplement for more information on the Dynamic Reconfiguration module.

File Monitoring Module X X3

3. Each added row defines what file to monitor.

Kernel Reader Module 2.0 X

MIB-II Instrumentation Module

1.0

NFS File Systems Module Version

2.0

NFS Statistics Module Version 2.0

Solaris Process Details Module

Version 2.0

Simple MIB-II Module Version 1.0 X
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■ NFS File Systems Module Version 2.0

■ Simple MIB-II Module Version 1.0

These modules monitor the operating system on your host.

Directory Size Monitoring Module Version 2.0

This module enables you to isolate and monitor the size of any directory and its

subdirectories on a host on which an agent is installed. The subdirectories and links

may be viewed recursively using a window accessible from the modules pop-up

menu.

Note – Any number of directories may be monitored individually by loading

multiple instances of the Directory Size Monitoring module, or by adding rows for

additional directories in the properties table. See “To Define a Directory” on

page 152 for more information.

Directory Monitoring Status Table

The following table provides a brief description of the properties for Directory Size

Monitoring:

File Monitoring Module

This module enables you to monitor the files on a host. Any file or number of tiles

may be isolated and monitored individually by loading multiple instances of the File

Monitoring module. This module requires you to add rows for the data property

tables. For more information, see “Working with Rows” on page 152.

TABLE C-2 Directory Size Monitoring Properties

Property Description

Instance Name Single word or alpha-character string that is used internally within

the Sun Management Center agent to identify uniquely a particular

module or a row within a module

Directory Name Name of the directory being monitored

Directory Size (KB) Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second
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File Monitoring Status Table

The following table lists the File Monitoring Status properties and their descriptions:

MIB-II Instrumentation Module 1.0

This section presents information on the MIB-II Instrumentation module. It describes

the property tables that belong to the following MIB-II groups:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

MIB-II System Group Table

The following table provides a brief description of the properties for MIB-II System

Group:

TABLE C-3 File Monitoring Properties

Property Description

Name Name of the file being monitored

Description Descriptive name provided for this file when added

Filename File being monitored

Last Modified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second

TABLE C-4 MIB-II System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-

write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is Up Time in microseconds since the system is up

System Contact The contact name for this system
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MIB-II Interfaces Group Tables

The following tables provide a brief description of the properties for the MIB-II

Interface group:

■ MIB-II Interfaces Group Table

■ MIB-II Interface Table

MIB-II Interfaces Group Table

The following table provides a brief description of the properties for MIB-II

Interfaces Group:

MIB-II Interface Table

The following table provides a brief description of the properties for MIB-II

Interfaces:

System Name The qualified host name on which the agent is running (read-

write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily

offered

TABLE C-5 MIB-II Interfaces Group Properties

Property Description

Number of

Interfaces

Number of interfaces to the machine, including the loopback

TABLE C-6 MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

TABLE C-4 MIB-II System Group Properties (Continued)

Property Description
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MIB-II IP Group Table

The following tables provide a brief description of the properties for MIB-II IP:

■ MIB-II Group Table

■ IP Address Table

■ IP Route Table

■ IP NetToMedia Table

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In NonUnicast

Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown

Protos

Number of packets with unsupported protocol that were received

on the interface

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast

Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue

Length

Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE C-6 MIB-II Interface Properties (Continued)

Property Description
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MIB-II Group Table

The following table provides a brief description of the properties for MIB-II IP

Group:

TABLE C-7 MIB-II Group Properties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IP Default TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP In Header Errors Number of input datagrams discarded because of errors in IP

headers

IP In Address Errors Number of input datagrams discarded because of errors in

destination IP address

IP Forwarded

Datagrams

Number of forwarded datagrams

IP In Unknown

Protos

Number of locally addressed datagrams that were discarded

because of unsupported protocols

IP In Discards Number of input datagrams that were discarded

IP In Delivers Number of input datagrams that were successfully delivered

IP Out Requests Number of datagrams that were supplied to IP for transmission

IP Out Discards Number of output IP datagrams that were discarded

IP Out No Routes Number of output IP datagrams that were discarded because no

route destination was found

IP Reassemble

Timeouts

Maximum time in seconds for which the received fragments were

held for reassembly

IP Reassemble

Requireds

Number of IP fragments received that required reassembly

IP Reassemble OKs Number of IP datagrams that were successfully reassembled

IP Reassemble Fails Number of failures detected by the reassembly algorithm

IP Fragmentation

OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation

Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation

Creates

Number of IP datagram fragments that were generated due to

fragmentation

IP Routing Discards Number of routing entries that were chosen to be discarded
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IP Address Table

The following table provides a brief description of the properties for IP Addresses:

IP Route Table

The following table provides a brief description of the properties for IP Route:

TABLE C-8 IP Addresses Properties

Property Description

IP Address Table IP Address Table

IPAT IP Address IP Address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

IPAT Net Mask Subnet mask associated with the IP address

IPAT Broadcast

Address

Value of the least significant bit in the IP broadcast address

IPAT Reassemble

Max Size

Size of the largest IP datagram which can be reassembled by this

entity

TABLE C-9 IP Route Properties

Property Description

IP Route Table Entity’s IP routing table

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned
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IP NetToMedia Table

The following table provides a brief description of the properties for IP NetToMedia:

MIB-II ICMP Group Table

The following table provides a brief description of the properties for MIB-II ICMP

Group:

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

TABLE C-10 IP NetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s

equivalence is effective

IPN2M

PhysAddress

Media-dependent physical address

IPN2M NetAddress IP address corresponding to the physical address

IPN2M Type Type of mapping

TABLE C-11 MIB-II ICMP Group Properties

Property Description

ICMP In Messages Number of ICMP messages received

ICMP In Errors Number of ICMP messages received with errors

ICMP In Dest

Unreachs

Number of ICMP destination unreachable messages received

ICMP In Time

Exceeds

Number of ICMP time exceeded messages received

TABLE C-9 IP Route Properties (Continued)

Property Description
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ICMP In Parameter

Problems

Number of ICMP parameter problem messages received

ICMP In Src

Quenchs

Number of ICMP source quench messages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of ICMP echo request messages received

ICMP In Echo Reps Number of ICMP echo reply messages received

ICMP In

Timestamps

Number of ICMP timestamp request messages received

ICMP In Timestamp

Reps

Number of ICMP timestamp reply messages received

ICMP In Address

Masks

Number of ICMP address mask request messages received

ICMP In Address

Mask Reps

Number of ICMP address mask reply messages received

ICMP Out Messages Number of ICMP messages that were attempted to send

ICMP Out Errors Number of ICMP messages that were not send due to problems

ICMP Out Dest

Unreachs

Number of ICMP destination unreachable messages sent

ICMP Out Time

Exceeds

Number of ICMP time exceeded messages sent

ICMP Out

Parameter Problems

Number of ICMP parameter problem messages sent

ICMP Out Src

Quenchs

Number of ICMP source quench messages sent

ICMP Out Redirects Number of ICMP redirect messages sent

ICMP Out Echos Number of ICMP echo request messages sent

ICMP Out Echo

Reps

Number of ICMP echo reply messages sent

ICMP Out

Timestamps

Number of ICMP timestamp request messages sent

TABLE C-11 MIB-II ICMP Group Properties (Continued)

Property Description
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MIB-II TCP Group Tables

The following tables provide a brief description of the properties for MIB-II TCP:

■ MIB-II TCP Group Table

■ TCP Connections Table

MIB-II TCP Group Table

The following table provides a brief description of the properties for MIB-II TCP

Group:

ICMP Out

Timestamp Reps

Number of ICMP timestamp reply messages sent

ICMP Out Address

Masks

Number of ICMP address mask request messages sent

ICMP Out Address

Mask Reps

Number of ICMP address mask reply messages sent

TABLE C-12 MIB-II TCP Group Properties

Property Description

TCP Retransmission

Algorithm

Algorithm used to determine the timeout value used for

retransmitting unacknowledged octets

TCP Retransmit Min

Timeout

Minimum value permitted by TCP implementation for the

retransmission timeout

TCP Retransmit

Max Timeout

Maximum value permitted by TCP implementation for the

retransmission timeout

TCP Max

Connections

Limit on the number of TCP connections

TCP Active Opens Number of times TCP connections have transitioned to SYN-SENT

from CLOSED state

TCP Passive Opens Number of times TCP connections have transitioned to SYN-RCVD

from LISTEN state

TCP Attempt Fails Number of times TCP connections have transitioned from SYN-

SENT or SYN-RCVD to COLSED state and from SYN-RCVD to

LISTEN state

TABLE C-11 MIB-II ICMP Group Properties (Continued)

Property Description
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TCP Connections Table

The following table provides a brief description of the properties for TCP

Connections:

MIB-II UDP Group Tables

The following tables provide a brief description of the properties for MIB-II UDP:

■ MIB-II UDP Group Table

■ UDP Table

TCP Established-to-

Resets

Number of times TCP connections have transitioned from

ESTABLISHED or CLOSE-WAIT to CLOSED state

TCP Current

Established

Number of TCP connections for which the current state is

ESTABLISHED or CLOSE-WAIT

TCP In Segments Number of segments received

TCP Out Segments Number of segments sent

TCP Retransmitted

Segments

Number of segments retransmitted

TCP In Errors Number of segments received in error

TCP Out With Reset

Flag

Number of segments sent containing the RST flag

TABLE C-13 TCP Connections Properties

Property Description

TcpConn State State of this TCP Connection

TcpConn Local Address Local IP address for this TCP connection

TcpConn Local Port Local port number for this TCP connection

TcpConn Remote Address Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

TABLE C-12 MIB-II TCP Group Properties (Continued)

Property Description
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MIB-II UDP Group Table

The following table provides a brief description of the properties for MIB-II UDP

Group:

UDP Table

The following table provides a brief description of the properties for UDP:

Kernel Reader Module 2.0

The Kernel Reader module monitors kernel statistics and all kernel information

including CPU statistics, system load statistics, disk statistics, file system usage, and

so on. This section includes properties and their descriptions for all Kernel Reader

managed objects:

■ User Statistics Table

■ System Load Statistics Table

■ Disk Statistics Managed Objects Tables

■ Filesystem Usage Table

■ CPU Statistics Managed Object Tables

■ Memory Usage Statistics Table

■ Swap Statistics Table

■ Streams Statistics Managed Objects Table

■ Software Rules Table

TABLE C-14 MIB-II UDP Group Properties

Property Description

UDP In Datagrams Number of UDP datagrams delivered to UDP users

UDP No Port

Datagrams

Number of received UDP datagrams for which there is no

application at the destination port

UDP In Errors Number of received UDP datagrams that could not be delivered

UDP Out Datagrams Number of UDP datagrams sent

TABLE C-15 UDP Properties

Property Description

UDP Local Address The local IP address for this UDP listener

UDP Local Port The local port number for this UDP listener
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The Kernel Reader module generates a warning alarm if it finds any disk with an

increasing wait queue while busy.

A warning alarm occurs when the disk is over 75% busy and the average queue

length is over 10 with an increasing wait queue. The warning alarm is on until the

disk is not over 70% busy and the average queue length is no longer than 8.

Similarly, this module generates a warning alarm if 90% of swap space is in use. The

alarm remains open until the swap space in use is less than 80% of the total swap

space.

The following table provides default alarm thresholds for applicable Kernel Reader

modules:

User Statistics Table

The following table provides a brief description of the properties for User Statistics:

TABLE C-16 Kernel Reader Alarm Thresholds

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

TABLE C-17 User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Primary User Login name of the primary user
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System Load Statistics Table

The following table provides a brief description of the properties for System Load

Statistics:

Disk Statistics Managed Objects Tables

The following tables provide a brief description of the properties for Disk Statistics:

■ Disk Details Table

■ Disk Service Time Table

The following table provides a brief explanation of what these tables contain:

Disk Details Table

The following table provides a brief description of the properties for Disk Details:

TABLE C-18 System Load Statistics Properties

Property Description

1 Min Load Average Load average over the last 1 minute

5 Min Load Average Load average over the last 5 minutes

15 Min Load Average Load average over the last 15 minutes

TABLE C-19 Disk Statistics Parameters

Property Description

Disk Details Details that pertain to the disk

Disk Service Time Average time with relation to the processing of a transaction

TABLE C-20 Disk Details Properties

Property Description

Disk Name Name of the disk (sd0 and so on)

Disk Alias Name of the disk (c0t0d0 and so on)

Read Operation Per Sec Read operation per sec

Writes Operation Per Sec Writes operation per sec
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Disk Service Time Table

The following table provides a brief description of the properties for Disk Service

Time:

Operation Per Sec (read +

write)

Operation per sec (read and write)

Number Of Bytes Read Number of bytes read

Number Of Bytes Written Number of bytes written

Number Of Bytes

Transferred (read + write)

Number of bytes transferred (read and write)

Average Number Of

Transactions Waiting

Average number of transactions waiting

Average Number Of

Transactions Running

Average number of transactions running

TABLE C-21 Disk Service Time Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Percentage Of Time

There Is A Transaction

Waiting For Service

Percentage of time there is a transaction waiting for service

(wait queue length)

Percentage Of Time The

Disk Is Busy

Percentage of time the disk is busy (transaction running)

Average Wait Service

Time

Average wait service time

Average Run Service

Time

Average run service time

Average Service Time Average service time

TABLE C-20 Disk Details Properties (Continued)

Property Description
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Filesystem Usage Table

The following table provides a brief description of the properties for Filesystem

Usage:

Note – The Find All Recent Files (>2 or >10Meg) probe commands for the UFS

Filesystem Usage and VXFS Filesystem Usage folders only find files that were

created or modified less than 24 hours ago. The Find All Files (>2 or >10Meg) probe

commands for UFS Filesystem Usage and VXFS Filesystem Usage find all files

(FIGURE C-1) regardless of the date/time they were created or modified.

For more information on the probe command, see “To Probe a Property” on

page 162.

TABLE C-22 Filesystem Usage Properties

Property Description

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/... )

Size (KB) Total size of the filesystem in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of Disk Space Used

Total Inodes Total size of the filesystem in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of Inodes Used
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FIGURE C-1 Probe Commands for Filesystem Usage

CPU Statistics Managed Object Tables

The following tables provide a brief description of the properties for CPU Statistics

managed objects:

■ CPU Utilization Table

■ CPU Process Table

■ CPU I/O Table

■ CPU Interrupts Table

■ CPU Syscalls Table

■ CPU Misc Table

■ CPU Regwindow Table

■ CPU Pageinfo Table

■ CPU Faults Table
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CPU Utilization Table

The following table provides a brief description of the properties for CPU

Utilization:

CPU Process Table

The following table provides a brief description of the properties for CPU processes:

TABLE C-23 CPU Usage Properties

Property Description

CPU Number CPU number

% CPU Idle Time Percentage of time spent by CPU on idle mode

% CPU User Time Percentage of time spent by CPU on user mode

% CPU Kernel Time Percentage of time spent by CPU on kernel mode

% CPU Wait Time Percentage of time spent by CPU on wait mode

% CPU Wait Time On I/O Percentage of time spent by CPU on wait mode for I/O

% CPU Wait Time On

Swap

Percentage of time spent by CPU on wait mode for swap

% CPU Wait Time On Pio Percentage of time spent by CPU on wait mode for Pio

Times Idle Thread

Scheduled

Percentage of idle time spent by CPU on threads scheduled

TABLE C-24 CPU Process Table

Property Description

Processes in Run
Queue

Processes in run queue

Processes Waiting Waiting processes

Processes Swapped Swapped processes

Total Number of CPUs Total number of CPUs
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CPU I/O Table

The following table provides a brief description of the properties for CPU I/O:

CPU Interrupts Table

The following table provides a brief description of the properties for CPU Interrupts:

TABLE C-25 CPU I/O Properties

Property Description

CPU Number Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical Block Writes Number of physical block writes

Logical Block Reads Number of logical block reads

Logical Block Writes Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/O Writes Number of raw I/O writes

Bytes Read By Rdwr() Number of bytes read by Rdwr()

Bytes Written By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In

Canonical Mode

Number of chars handled in canonical mode

Terminal Output

Characters

Number of terminal output characters

Physical Block Writes Number of physical block writes

Procs Waiting For Block

I/O

Number of processes waiting for block I/O

TABLE C-26 CPU Interrupts Properties

Property Description

CPU Number CPU number

Context Switches Number of context switches

Traps Number of traps
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CPU Syscalls Table

The following table provides a brief description of the properties for CPU system

calls:

Device Interrupts Number of device interrupts

Interrupts As Threads Number of interrupts as threads

Interrupts Blocked/

Preempted/Released

Number of interrupts blocked, pre-empted or released

TABLE C-27 CPU System Call Properties

Property Description

CPU Number CPU number

System Calls Number of system calls

Read+Readv System Calls Number of read+ready system calls

Write+Writev System Calls Number of Write+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget() Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes Taken With Attached

Pages

Number of indexes taken with attached pages

Inodes Taken With No

Attached Pages

Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

TABLE C-26 CPU Interrupts Properties

Property Description
Appendix C Sun Management Center Software - Operating System Modules 371



CPU Misc Table

The following table provides a brief description of the properties for CPU

Miscellaneous:

CPU Regwindow Table

The following table provides a brief description of the properties for CPU

Regwindow:

TABLE C-28 CPU Miscellaneous Properties

Property Description

CPU Number CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

Cpu Migrations By Threads Number of CPU migrations by threads

Xcalls To Other Cpus Number of Xcalls to other CPUs

Failed Mutex Enters

(adaptive)

Number of failed mutex enters (adaptive)

Rw Reader Failures Number of read/write reader failures

Rw Write Failures Number of read/write write failures

Loadable Module Loaded Number of loadable module loaded

Loadable Module Unloaded Number of loadable module unloaded

Tries To Acquire RW Lock Number of tries to acquire read/write lock

TABLE C-29 CPU Regwindow Properties

Property Description

CPU Number CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

System Overflows Number of system overflows

System Underflows Number of system underflows

System User Overflows Number of system user overflows
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CPU Pageinfo Table

The following table provides a brief description of the properties for CPU Pageinfo:

TABLE C-30 CPU Pageinfo Properties

Property Description

CPU Number CPU number

Reclaims Number of reclaims

Reclaims From Free List Number of reclaims from free list

Pageins Number of pageins

Pages Paged In Number of pages paged in

Pageouts Number of pageouts

Pages Paged Out Number of pages paged out

Swapins Number of swap ins

Pages Swapped In Number of pages swapped in

Swapouts Number of swap outs

Pages Swapped Out Number of pages swapped out

Pages Zero Filled On Demand Number of pages zero filled on demand

Pages Freed By Daemon Number of pages fixed by daemon

Pages Examined By Pageout

Daemon

Number of pages examined by the pageout daemon

Revolutions Of The Page

Daemon Hand

Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled
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CPU Faults Table

The following table provides a brief description of the properties for CPU Faults:

Memory Usage Statistics Table

The following table provides a brief description of the properties for Memory Usage

Statistics:

TABLE C-31 CPU Faults Properties

Property Description

CPU Number CPU number

Minor Page Faults Via hat_fault() Number of minor page faults through

hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault() s In Kernel addr Space Number of in kernel addr space

TABLE C-32 Memory Usage Statistics Properties

Property Description

Physical Memory Available (MB) Physical memory available in Mbytes

Physical Memory In Use (MB) Physical memory in use in Mbytes

Percent Memory Used Percentage of memory used

Physical Memory Free (MB) Physical memory free in Mbytes

Percent Memory Free Percentage of memory free
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Swap Statistics Table

The following table provides a brief description of the properties for Swap Statistics:

Streams Statistics Managed Objects Table

The following section provides the various Streams Statistics properties for the

following managed objects:

■ Streams Head Cache

■ Queue Cache

■ Streams Messages

■ Linkinfo Cache

■ Strevent Cache

■ Synoq Cache

■ Qband Cache

The following table briefly describes the managed objects:

TABLE C-33 Swap Statistics Properties

Property Description

Available KB (Anon Memory Not Reserved) Swap available. Total reserved swap

space.

Reserved KB (Anon Memory Reserved But

Not Allocated)

Swap reserved

Allocated KB (Anon Memory Not Free) Swap allocated

Used KB Swap used

Total KB (Used + Available) Swap total

Percent Swap Used Percentage of swap used

TABLE C-34 Streams Statistics Managed Objects

Properties Description

Stream Head Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

Streams Msgs Kernel statistics for streams messages

Linkinfo Cache Kernel statistics for link information cache
Appendix C Sun Management Center Software - Operating System Modules 375



All of the preceding property tables have similar entries. These are listed in the

following table.

All of the Streams Statistics managed objects have the same properties. The

following table presents these common properties:

Software Rules Table

The following table provides a brief description of the properties for Software Rules:

NFS Statistics Module Version 2.0

This section presents property tables for NFS Statistics:

■ RPC Information Table

■ NFS Information Table

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

TABLE C-35 Streams Statistics Table Properties

Property Description

The Name Of The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

Maximum Capacity Maximum capacity of the cache

Cumulative Total Of Allocations Number of total cache allocations

Number of Allocation Failures Number of allocation failures

Percent Used Percentage of cache used

TABLE C-36 Software Rules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix E)

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix E)

TABLE C-34 Streams Statistics Managed Objects

Properties Description
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Using the NFS Statistics module, statistical information on the Remote Procedure

Calls (RPC) and Sun’s distributed computing file system (NFS) calls may be

monitored. The number of RPC and NFS calls received by the server and made by

the client are monitored and displayed in the main console window along with the

status of the transaction activity on the local host. The following tables list some of

the properties monitored by this module with both the server and the client

statistics.

RPC Information Table

The following table provides a brief description of the properties for RPC

Information:

NFS Information Table

The following table provides a brief description of the properties for NFS

Information:

TABLE C-37 RPC Server and Client Information Properties

Property Description

RPC Calls Total number of RPC calls made by the host

Bad RPC Calls Total number of calls rejected by the RPC layer

Bad RPC Calls % Percentage of rejected calls compared to the total number of calls

made (bad RPC Calls/RPC calls)

RPC Call Rate Number of RPC calls made per second

TABLE C-38 NFS Server and Client Information Properties

Property Description

NFS Calls Total number of NFS calls sent by the host

Bad NFS Calls Total number of NFS calls rejected

Bad NFS Calls % Percentage of rejected NFS calls compared to the total number of

calls sent (bad NFS calls/NFS calls)

NFS Call Rate Number of NFS calls sent per second
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Solaris Process Details Module Version 2.0

The Solaris Process Details module parameters are listed in the following table. This

table is seen when you try to load the module.

The following section presents the Solaris Process property table.

Process Table

The following table provides a brief description of the properties for Solaris Process:

TABLE C-39 Solaris Process Details Parameters

Property Description

Module Name Name of the module (this is not editable)

Module Description Description of the module (this is not editable)

Version Version of the module (this is not editable)

Enterprise SNMP enterprise in which the module is loaded (this is not editable)

Module Type Type of the module (this is not editable)

Number of

Processes

Number of processes that is obtained by the module based on the

following selection criteria. One of the given numbers can be

selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For

example, the user can select the top 10 processes using this function.

TABLE C-40 Process Properties

Property Description

PS Process ID Process ID of this process

PS Parent Process ID Process ID of the parent of this process

PS User ID Login ID of the user of this process

PS User Name Login name of the user of this process

PS Effective User ID Effective user ID of this process

PS Group ID Real group ID of this process

PS Effective Group

ID

Effective group ID of this process

PS Session ID Process ID of the session leader of this process
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NFS File Systems Module Version 2.0

The NFS File Systems module enables you to monitor the NFS file systems on hosts

running the Solaris 2 and Solaris 7 operating environments. The NFS File Systems

module monitors the amount of disk space occupied by mounted or unmounted file

systems: the amount of used and available space as well as the remaining total

capacity.

When loading the NFS File Systems module, you may define which file systems you

want to monitor by using pattern matching. Patterns may be used to filter which

NFS file systems are monitored by file system or mount point.

PS Process Group ID Process ID of the process group leader of this process

PS TTY Controlling terminal for this process

PS Start Time Starting time of this process

PS Time Cumulative execution time of this process

PS State State of this process

PS Wait Channel Address of an event for which this process is waiting

PS Scheduling Class Scheduling class of this process

PS Address Memory address of this process

PS Size Total size of this process in virtual memory

PS Priority Priority of this process

PS Nice Nice value of this process, which is used for priority computation

PS Percent CPU

Time

Percent CPU time

PS Percent Memory Percent memory

PS Command Base name of the executable file for this process

PS Command Line Full command name of this process, including the arguments

TABLE C-40 Process Properties (Continued)

Property Description
Appendix C Sun Management Center Software - Operating System Modules 379



File System Usage Table

The following table provides a brief description of the properties for NFS Filesystem

Usage:

Simple MIB-II Module Version 1.0

The following tables provide a brief description of the properties for Simple MIB-II

managed objects:

■ System Group

■ Interfaces Group

■ IP Group

System Group

The following table provides a brief description of the properties for System Group.

TABLE C-41 Filesystem Usage Properties

Property Description

NFS Filesys Name of the NFS filesystem

Size Total size of the NFS filesystem in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

% Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS filesystem

Entry Number Entry number of the NFS filesystem

TABLE C-42 System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is
Up

Time in microseconds since the system is up

System Contact The contact name for this system
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Interfaces Group

The following tables provides a brief description of the properties for Interfaces

Group.

■ Interfaces Group

■ Interfaces Table

System Name The qualified host name on which the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered

TABLE C-43 Interfaces Group Properties

Property Description

Number of Interfaces Number of interfaces to the machine, including the loopback

TABLE C-44 Interfaces Table

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In nonUnicast Pkts Non-unicast packets received on the interface

TABLE C-42 System Group Properties(Continued)

Property Description
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IP Group

The following table provides a brief description of the properties for IP Group.

■ IP Group

■ IP Route Table

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown Protos Number of packets with unsupported protocol that were received

on the interface

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out nonUnicast
Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue Length Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE C-45 IP Group

Property Description

IP Forwarding Indicates whether this entity is a gateway

TABLE C-44 Interfaces Table(Continued)

Property Description
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TABLE C-46 IP Route Table

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol
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APPENDIX D

Sun Management Center - Local &
Remote Application Modules

The Sun Management Center software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core modules described

in Chapter 12 and presents them in their respective categories.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, see the previous

appendix, your supplement, or go to the Sun Management Center web site: http:/
/www.sun.com/sunmanagementcenter .

■ Local Applications

■ Agent Statistics Module Version 2.0

■ Data Logging Registry Module Version 2.0

■ Health Monitor Module Version 2.0

■ Print Spooler Module Version 3.0

■ Process Monitoring Module Version 2.0

■ File Scanning (System Log) Module Version 2.0

■ Remote Systems

■ MIB-II Proxy Monitoring Module Version 2.0

■ HP JetDirect Module Version 2.0

Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 12.

Also, there are modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.
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The following table lists the modules described in this appendix alphabetically and

provides details on those modules that are automatically loaded and those that can

be loaded multiple times. It also points out those modules that utilize the Add Row

utility.

Local Applications

The following modules, when loaded, are found under the local applications icon:

■ Agent Statistics Module Version 2.0

■ Data Logging Registry Module Version 2.0

■ Health Monitor Module Version 2.0

TABLE D-1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’
Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Agent Statistics Module Version

2.0

X

Config-Reader Module1

1. Refer to your platform-specific supplement for more information on the Config-Reader module.

X

Data Logging Registry Module

Version 2.0

X

Dynamic Reconfiguration

Module2

2. Refer to your platform-specific supplement for more information on the Dynamic Reconfiguration module.

File Scanning (System Log)

Module Version 2.0

X X X 3

3. Each added row defines what pattern within the monitored file to match. The row needs to be added to the
table, Scan Table.

HP JetDirect Module Version 2.0 X

Health Monitor Module Version

2.0

MIB-II Proxy Monitoring Module

Version 2.0

X

Print Spooler Module Version 3.0 X X

Process Monitoring Module

Version 2.0

X X4

4. Each row defines what pattern to match from all the processes that are running on the agent host.
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■ Print Spooler Module Version 3.0

■ Process Monitoring Module Version 2.0

■ File Scanning (System Log) Module Version 2.0

Agent Statistics Module Version 2.0

This section presents the following information on Agent Statistics:

■ Object Statistics Table

■ Commands Executed Table

■ Transactions Performed Table

■ Sun Management Center Process Statistics Table

■ Sun Management Center Total Process Statistics Table

The Agent Statistics module monitors the health of the agent installed on a host.

This module monitors the objects, processes, and execution of processes by the

agent.

TABLE D-2 Agent Statistics Main Sections

Agent Statistics Tables Description

Object Section Displays data on the objects loaded onto the agent. Status field

displays the current status of the TOE and binary objects loaded into

and used by the agent.

Execution Section Displays data on the number of Tcl or TOE commands invoked by

the agent interpreter. Also displays data on the number of

asynchronous transactions initiated by the agent. Status field

displays a brief description of the current status of the objects listed.
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The following table provides a brief description of the Agent Statistics managed

objects:

The following lists default alarm thresholds for applicable Agent Statistics modules:

TABLE D-3 Agent Statistics Section Properties

Property Description

Object Statistics TOE Count - Number of TOE objects loaded into the agent bob

Count - Number of binary object buffers used by the agent

Commands Executed Total - Total number of commands that have been executed by the

agent

Rate (#/sec) - Number of commands executed by the agent per

second

Transactions

Performed

Total - Total number of transactions performed by the agent

Rate (#/sec) - Number of transactions performed by the agent per

second

PA Process Statistics Process statistics pertaining to the PA

PA Total Process

Statistics

Total process statistics pertaining to the PA

TABLE D-4 Agent Statistics Alarm Thresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage CPU time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000
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The following sections describe the property tables for Agent Statistics.

Object Statistics Table

The Objects section displays data on the Objects loaded onto the agent. The Status

field displays the current status of the TOE and binary objects loaded into and used

by the agent.

The following table provides a brief description of the properties for Object

Statistics:

Commands Executed Table

The following table provides a brief description of the properties for Commands

Executed:

Transactions Performed Table

The following table provides a brief description of the properties for Performed

Transactions:

TABLE D-5 Object Statistics Properties

Property Description

Total TOE Objects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent

TABLE D-6 Executed Commands Properties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

TABLE D-7 Transactions Performed Properties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate

(/sec)

Number of transactions performed by the agent per second
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Sun Management Center Process Statistics Table

The software monitors the Sun Management Center process statistics. The following

table provides a brief description of the properties for Sun Management Center

Process Statistics:

TABLE D-8 Sun Management Center Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process

Resident Set Size Resident size of the process

Elapsed Time Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPU Time CPU time used by the process

Percent CPU Time Percentage of CPU time used by the process

Context Switches Context switches of the process

System Calls System calls made by the process

Command Line Command line of the process
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Sun Management Center Total Process Statistics Table

The software monitors the total Sun Management Center process statistics.

The following table provides a brief description of the properties for Total Sun

Management Center Process Statistics:

Data Logging Registry Module Version 2.0

The Data Logging Registry consists of the registry table.

Registry Table

The following table provides a brief description of the properties for Data Logging

Registry:

TABLE D-9 Total Sun Management Center Process Statistics Properties

Property Description

Number of Processes Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children

TABLE D-10 Data Logging Registry Properties

Property Description

Log Destination

State

Name of the logged file

Module Name Module name for data value (data from this module is logged in the

registry)

Instance Name Name of the instance

Property Name Property name for data value

Logging Interval Logging interval for data value

File Logging State of the log file destination

Data Cache Cache data

Cache Size (samples) Cache size samples
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Health Monitor Module Version 2.0

The Health Monitor module monitors the health of your host. When alarm

conditions occur, this module offers suggestions, if necessary, on how to improve the

performance of the system.

For example, this module monitors the swap space that is available, reserved,

allocated, and used. Sample alarm messages, from lowest to highest severity,

include:

■ No Worries: sufficient swap space available

■ There is lots of unused swap space

■ Not much swap left: perhaps add some more

■ Swap space shortage: add some more now

■ Dangerous swap space shortage: add more immediately

This section describes properties of the following Health Monitor module managed

objects:

■ Swap Table

■ Kernel Contention Table

■ NFS Table

■ CPU Table

■ Disk Table

■ RAM Table

■ Kernel Memory Table

■ Directory Cache Table

The Health Monitor module tracks the system properties for the above as described

in the following table:

TABLE D-11 Health Monitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc I/O information

RAM Random Access Memory (RAM) information

Kernel Memory Information on kernel memory

Directory Cache Cache of the directory
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Swap Table

The following table provides a brief description of the properties for Swap:

Kernel Contention Table

The following table provides a brief description of the properties for Kernel

Contention (mutex):

NFS Table

The following table provides a brief description of the properties for NFS client

information:

TABLE D-12 Swap Properties

Property Description

Swap Available KB Swap space value available

Swap Reserved KB Swap space value reserved

Swap Allocated KB Swap space value allocated

Swap Used KB Swap space value used

Swap Rule Rule for swap

TABLE D-13 Kernel Contention Properties

Property Description

Spins On Mutexes Spins on mutexes (lock not acquired on first try) - Sum for all

CPUs

Number Of CPUs Number of CPUs

Spins On Mutexes Rule Spins on mutexes (lock not acquired on first try) - Sum for all

CPUs

TABLE D-14 NFS Client Information Properties

Property Description

Calls Total number of RPC calls received

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout
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CPU Table

The following table provides a brief description of the properties for the central

processing unit (CPU):

Disk Table

The following table provides a brief description of the properties for Disk:

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response

Timer Call timed out while waiting for a reply from server

Nomem Failure to allocate memory

Can't Send Failure to send NFS/RPC rule

NFS/RPC Rule Value of the NFS/RPC rule

TABLE D-15 CPU Properties

Property Description

Processes In Run

Queue

Number of processes in run queue

Processes Waiting Number of processes blocked for resources

Processes Swapped Number of processes that can be run but swapped

CPU Power Rule CPU power rule

TABLE D-16 Disk Properties

Property Description

Disk Name Name of the disk

Disk Alias Name of the disk (for example, c0t0d0 )

Percent Disk Wait Average number of transactions waiting for service

TABLE D-14 NFS Client Information Properties (Continued)

Property Description
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RAM Table

The following table provides a brief description of the properties for random access

memory (RAM):

Kernel Memory Table

The following table provides a brief description of the properties for Kernel

Memory:

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time in milliseconds

Disk Rule Disk rule

TABLE D-17 RAM Properties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

Real Memory rule Real memory rule

TABLE D-18 Kernel Memory Properties

Property Description

Total Kernel Allocation

Fails

Value of kernel allocation failure

Physical Memory Free Value of free physical memory

Kernel Memory Rule Value of kernel memory rule

TABLE D-16 Disk Properties (Continued)

Property Description
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Directory Cache Table

The following table provides a brief description of the properties for Directory

Cache:

Print Spooler Module Version 3.0

The Print Spooler module monitors the status of the printer daemon and print queue

on the local host as well as the printer devices installed on it.

■ Printer LPsched

■ Printer Devices Table

■ Printer Queues Table

The following table describes the print spooler managed objects:

Printer LPsched

The printer daemon section displays data on the LP Request Scheduler. The

following table provides a brief description of the properties for the Line Printer’s

Schedule (LPsched):

TABLE D-19 Name Cache Statistics Properties

Property Description

Cache Hits Number of times a previously accessed page is found

Cache Misses Number of times a previously accessed page is missed

DNLC Rule DNLC (Directory Name Lookup Cache) rule

TABLE D-20 Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

TABLE D-21 Printer LPsched Properties

Property Description

LPsched state Current status of the printer.
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Printer Devices Table

The Printer Devices table lists the printers that are already added to the table (by

selecting the Add option from the pop-up menu. The pop-up menu displays when

you position the cursor in a row and click the right mouse button.)

The instance name or alias of the printer is displayed in the Name field followed by

the description of the printer displayed in the Description field, and the name of the

host on which it is installed, displayed in the Host Name field. If you are running a

console displaying data monitored by an agent on a print server host, the path name

of the printer device is displayed in the Device field. The printer state displays in the

Printer State field.

The following table provides a brief description of the properties for Printer Devices:

Printer Queues Table

The Print Queues table lists the print queues on the local host and displays the

status of each queue. The following table provides a brief description of the

properties for Printer Queues:

TABLE D-22 Printer Devices Properties

Property Description

Printer name Name of the printer device

Description Description of the printer device

Host name Name of the host to which the device is attached

Device name Alphanumeric device name

Printer state The state of the device (values are “enabled,” “disabled,” or “not

exist”)

TABLE D-23 Printer Queues Properties

Property Description

Queue Name Name of the printer queue

Queue State Current status of the printer queue (values are “accepting” and “not

accepting”)

Total Queue Jobs Total number of jobs in the queue

Current Job Number of jobs currently spooled in the queue

Queue Size Total size (in Kbytes) of the jobs currently spooled in the queue
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Process Monitoring Module Version 2.0

The following section describes the Process Monitoring module parameters and their

property descriptions. This module requires you to add rows for the data property

tables. For more information, see “Working with Rows” on page 152.

When a process “hit” is found, the %CPU and a count of the number of processes

that match is displayed. If you want to change the module parameters, you can edit

all the parameters except for the entry name by accessing the pop-up menu. See

“Pop-up Menu” on page 124 for more information.

Process Statistics Table

The following table provides a brief description of the properties for Process

Statistics:

Note – The first five row entries in TABLE D-24 must be entered by you when adding

a row to the process statistics table. See “To Add a Row (for the File Monitoring, File

Scanning, and Process Monitoring Modules)” on page 153 for more information.

TABLE D-24 Process Statistics Properties

Property Description

Entry Name Name of the entry (must be a unique name)

Name Pattern Pattern to match the name of the process that you want to monitor

Argv Pattern Pattern to match the arguments of the command which executes the

process

User Specification User name executing the command

Entry Description Description of the entry (mandatory field)

Monitoring State Toggle between on (row is enabled) and off (row is disabled). When

the row is disabled, all the entries are displayed as 0 (zero).

Process Command Name process

% CPU Usage Percentage CPU used by the processes

Virtual Size Total size of the processes

Resident Set Size Resident size of the processes

Process Count Number of the processes that matched the pattern
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File Scanning (System Log) Module Version 2.0

The File Scanning module scans files on a host for user-specified patterns. Multiple

instances of the File Scanning module may be loaded to scan multiple files. This

module requires you to add rows for the data property tables. For more information,

see “Working with Rows” on page 152.

The File Scanning module has the following managed objects:

■ File ID Table

■ File Statistics Table

■ Scan Table

The following table provides a brief description of the properties for File Scanning:

File ID Table

The following table provides a brief description of the properties for File ID:

TABLE D-25 File Scanning (System Log) Properties

Property Description

File ID Name given by you to the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name given by you to the pattern used in the file scan

TABLE D-26 File ID Properties

Property Description

Filename Full path name of the file to be scanned

Scan Mode Mode in which the file is being scanned

Start Time Time the file scan was first started
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File Statistics Table

The File Statistics table displays summary information on the file that is to be

scanned. The following table provides a brief description of the properties for File

Statistics:

Scan Table

The following table provides a brief description of the properties for Scan:

Remote Systems

The software enables you to monitor remote systems, such as HP printers equipped

with a JetDirect card.

The following modules, when loaded, are found under the local remote system icon:

■ MIB-II Proxy Monitoring Module Version 2.0

TABLE D-27 File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines contained in the file

Lines Per Second Rate at which the file is changing in lines per second

TABLE D-28 Scan Table Properties

Property Description

Pattern Name Name given by you to the pattern used in the file scan

Pattern Description Name of the pattern entry to be displayed in the name field of the

Scan Results section

Regexp Pattern Regular expression pattern to be used when scanning the file for

entries

Pattern State State of the pattern listed (on/off). The off state indicates that the

pattern listed will not be used in the file scan

Matches Number of lines that contain the pattern
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■ HP JetDirect Module Version 2.0

MIB-II Proxy Monitoring Module Version 2.0

The MIB-II Proxy Monitoring module monitors the MIB-II parameters for remote

systems. The various categories that monitor the MIB-II parameters on remote

systems are listed in the following sections, which list MIB-II group tables:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

For more information on the properties of these parameters, see “MIB-II

Instrumentation Module 1.0” on page 354, which lists the properties for local

systems. The same functionality is applied on remote systems by the MIB-II Proxy

Monitoring module. For more information on the definition of MIB-II, see the

standards documentation RFC1213 (Request For Comments 1213).

HP JetDirect Module Version 2.0

Agents can monitor HP printers equipped with a JetDirect card by proxy using the

HP JetDirect module. Multiple HP printers may be monitored by loading multiple

instances of this module.

Printer Status Table

The following table provides a brief description of the properties for Printer Status:

For platform-specific information, see your supplement.

TABLE D-29 General Printer Status Properties

Property Description

Printer Display Printer’s status
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APPENDIX E

Sun Management Center Software
Rules

This appendix lists the Sun Management Center rules for the following modules:

■ Kernel Reader

■ Health Monitor

A rule is an alarm check mechanism that allows for complex or special purpose logic

in determining the status of a monitored host or node.

There are two types of rules—simple and complex:

■ Simple rules are based on the rCompare rule, in which monitored properties are

compared to the rule. If the rule condition becomes true, an alarm is generated.

For example, a simple rule can be the percentage of disk space used. If the

percentage of disk space used equals or is greater than the percentage specified in

the rule, then an alarm is generated.

■ Complex rules are based on multiple conditions becoming true. For example, one

complex rule states that when a disk is over 75% busy and the average queue

length is over 10 and the wait queue is increasing, then an alert alarm is

generated.

Note – Any user-customized Solstice SyMON 1.x rules must be ported to the new

environment before the rules can be used in Sun Management Center 2.1 software.
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Kernel Reader

The following table lists the Kernel Reader simple rules.

TABLE E-1 Kernel Reader Simple Rules

Property Description

avg_1min Load Averages Over The Last 1 Minute

avg_5min Load Average Over The Last 5 Minutes

avg_15min Load Average Over The Last 15 Minutes

cpu_delta Difference between the previous and current time

cpu_idle CPU idle time

cpu_kernel CPU kernel time

cpu_user CPU user time

cpu_wait CPU wait time

ipctused Percent of inodes used

kpctused Percent of Kbytes used

mem-inuse Physical Memory In Use (MBytes)

numusers Number Of Users

numsessions Number Of User Sessions

swap_used Swap Used Kbytes

wait_io CPU wait time breakdown

wait_pio CPU wait time breakdown

wait_swap CPU wait time breakdown
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The following table lists the Kernel Reader complex rules.

TABLE E-2 Kernel Reader Complex Rules

Rule ID Description Type of Alarm

rknrd100 This rule covers a transitory event and generates an alert

alarm when the disk is over 75% busy, the average queue

length is over 10, and the wait queue is increasing. Alert

alarm stays on until the disk is not over 70% busy and the

average queue length is no longer than 8.

Alert

rknrd102 This rule covers a transitory event and generates an alert

alarm if 90% of swap space is in use. Event causing the alarm

stays open until swap space in use is less than 80% of the total

swap space.

Alert

rknrd103 This rule covers a transitory event and generates an alert

alarm if swapping and paging is high for a given CPU. This

indicates that a CPU may be thrashing. Alert alarm is

generated when CPU exceeds 1 swap-out, 10 page-ins, and 10

page-outs per second. Alert alarm stays on if CPU exceeds 1

swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd105 File System Full error. This rule looks for a file system full

error message in the syslog (/var/adm/message ).

Alert alarm that is

closed immediately

rknrd106 No swap space error. This rule looks for a no swap space error

message in the syslog (/var/adm/message).
Alert alarm that is

closed immediately

rknrd400 This rule checks for a continuous CPU load over 6 per CPU

for four hours.

Informational

rknrd401 This rule checks for disks being busy more than 90% of the file

for x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below 10% for

x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd403 Test for Meta CPU events. Informational

rknrd404 Test for Meta Disk events. Informational

rknrd405 Test for Meta Swap events. Informational
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Health Monitor

The following table lists the Health Monitor complex rules.

TABLE E-3 Health Monitor Complex Rules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical, Alert,

Caution

rhltm001 Each time a CPU has to wait for a lock to become free, it

wastes CPU power; and this event is counted, since the kernel

uses mutually exclusive locks to synchronize its operation and

keep multiple CPUs from concurrently accessing critical code

and data regions.

Critical, Alert,

Caution

rhltm002 This rule is based on the observation that NFS remote

procedure call timeouts may be associated with duplicate

responses after the call is retransmitted. This indicates that the

network is okay but the server is responding slowly.

Critical, Alert,

Caution

rhltm003 Here the run queue length is divided by the number of CPUs.

This is based upon the fact that every CPU takes a job off the

run queue in each time slice.

Critical, Alert,

Caution

rhltm004 A busy or slow disk reduces system throughput and increases

user response times. This rule identifies the disks that are

loaded so that the load can be rebalanced.

Critical, Alert,

Caution

rhltm005 RAM rule based on residency time for an unreferenced page.

The virtual memory system indicates that it needs more

memory when it scans looking for idle pages to reclaim for

other uses.

Critical, Alert,

Caution

rhltm006 This rule refers to the kernel memory allocation problem. It

shows up when login attempts or network connections fail

unexpectedly. There are two possible causes. Either the kernel

has reached the extent of its address space, or the free list does

not contain any pages to allocate. It is more a sign of a

problem that may otherwise be overlooked.

Critical, Alert,

Caution

rhltm007 There is a global cache of directory path name components

called the directory name lookup cache, or Directory Name

Lookup Cache Rule (DNLC). Missing a cache means that

directory entries must be read from disk and scanned to locate

the right file.

Critical, Alert,

Caution
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APPENDIX F

Internet Protocol Routing

This appendix describes:

■ Overview of IP Addressing

■ Subnetting

■ Netmasks

Overview of IP Addressing

Internet protocol (IP) addresses are 32 bits long. Thus, there is a total possibility of

approximately 4 billion addresses for the entire Internet. An IP address is expressed

as a series of octets separated by dots. For example, the address 11111111 00000001

00000101 00001010 is written as 127.1.5.10, or using hexadecimal notation, 7f.1.5.a0.

Because of this vast number of addresses, there was a need to organize the network

hierarchically into administrative domains. This need led to the definition of name

administrative domains and network classes. Since each site can vary in size, IP

addresses are divided into three main types or classes. A large site can reserve a

class A address and receive 224 individual addresses, while a small site can reserve a

class C address and receive 28 individual addresses.

Network Classes

Class A uses the first octet for the network address, and the rest for host addresses

within this network. For example, a site whose network address is 129.0.0.0 would

own the 224 addresses between 129.0.0.0 and 129.255.255.255.

Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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Class B uses two octets for the network address, and two for the host address. For

example, a site whose network address is 129.123.0.0 would own the 216 addresses

between 129.123.0.0 and 129.123.255.255.

Class C uses three octets for the network address, and one for the host address. For

example, a site whose network address is 129.123.56.0 would own the 28 addresses

between 129.123.56.0 and 129.123.56.255.

Subnetting

Subnetting is defined as dividing a network into smaller segments, or subnets,

which is imperative for Class A and B networks. Routers do not forward packets

outside a subnet if the destination address is within the same subnet. Thus, network

traffic is decreased dramatically by segmenting a large network. For example, we

have a class B network that is segmented into 255 subnets. Unless a packet

destination is a host outside the subnet, a local packet is sent to 255 hosts instead of

256,000.

Netmasks

The format of the netmask is a series of 1s followed by a series of 0s. By ANDing an

IP address with a netmask, we can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet.

For example, we have a machine with an IP address of 129.123.56.95 that is sending

an email to another machine whose IP address is 129.123.56.100. By ANDing both IP

addresses with a netmask (255.255.255.00), the result is 129.123.56.0 for both

machines. The router then concludes that both the source machine and destination

machine are in the same subnet. Therefore, the router does not forward the email to

external subnets.

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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On the other hand, if the destination address is 129.123.67.100, then the resulting

subnet address is 129.123.67.0. The router forwards the email to the external subnet

(129.123.67.0).

Note – Although some of these examples apply to Ethernet links, the principles still

apply regardless of the type of network.
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Glossary

administrative
domain An arbitrary collection of hosts and networks that are monitored by the

software as a single hierarchal entity. Users may choose to divide their

enterprise into several domains, each to be managed by different users.

agent A software process, usually corresponding to a particular local managed host,

that carries out manager requests and makes local system and application

information available to remote users.

alarm An abnormal event, which may be indicative of current or impending

problems, is detected by a Sun Management Center agent. The agent passes

information about the abnormal event to the Sun Management Center server.

The server passes this information on to the user as an alarm, when the

abnormal event matches a predefined alarm threshold.

alarm
acknowledgment Sun Management Center users can acknowledge alarms, indicating that the

alarm does not represent a serious problem or that the problem is being

resolved. Acknowledged alarms take a lower priority than unacknowledged

alarms.

Attribute Editor A window which provides information about the selected object. In addition,

the Attribute Editor enables you to customize various monitoring criteria for

that object. The monitoring criteria are dependent on the type of object. There

are Attribute Editors for domains, hosts, modules, and data properties.

bus A point-to-point network component. Used by the software to represent a

network link to which many other hosts may be connected.

community A string similar to a password that is used to authenticate access to an agent’s

monitored data.

complex alarm A complex alarm is based on a set of conditions becoming true. Unlike simple

alarms, you cannot set thresholds for complex alarms.
Glossary 411



composite object Composite object refers to hardware with multiple instances of the Solaris

operating environment running inside a single chassis. They are “composites”

from the Sun Management Center point of view because they consist of several

parts shown inside a group or container; one object for each instance of the

Solaris operating environment, two objects representing an active and backup

“system controller,” and one object representing the hardware chassis and

related equipment such as fans and power supplies.

Console window A graphical user interface component of Sun Management Center software

based on Java technology that is used to view monitored hosts (and managed

objects) information and status and to interact with Sun Management Center

agents.

developer
environment A “demonstration” environment in which developers can test customized

modules designed to work with the Sun Management Center software. See the

Sun Management Center 2.1 Developer Environment Reference Manual for more

information.

Discovery A Sun Management Center tool available from the main console window that

is used to find hosts, routers, networks, and Simple Network Management

Protocol (SNMP) devices that can be reached from the Sun Management Center

server.

dynamic loadable
modules A Sun Management Center agent module that can be loaded or unloaded at

run time, enabling monitored properties to be displayed on the main console

window without having to restart the console or agent.

event A change in the state of a managed object.

file scanning The act of scanning a file (usually a log file) for certain patterns (regular

expressions) that may be indicative of problems or significant information. Sun

Management Center agents use file scanning to assist in the monitoring of

systems and applications when these components do not provide direct access

to status information.

graphical user
interface The graphical user interface, or GUI, is a window that provides the user with a

method of interacting with the computer and its special applications, usually

with a mouse or other selection device. The window usually includes such

things as windows, an intuitive method of manipulating directories and files,

and icons.

hierarchy view A window view that defines objects in a hierarchy or tree relationship to one

another. Objects are grouped depending on the rank of the object in the

hierarchy.

hop The number of routers a packet goes through before reaching its destination.
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instance A single word or alpha-character string that is used internally within the Sun

Management Center agent to identify uniquely a particular module or a row

within a module.

manage In Sun Management Center software, manage is defined as being able to

monitor, as well as manipulate the object. For example, management privileges

include acknowledging and closing alarms, loading and unloading modules,

changing alarm thresholds, and so on. Management privileges are similar to

read, write, and execute access.

MIB Management Information Base. A MIB is a hierarchical database schema

describing the data available from an agent. The MIB is used by Sun

Management Center agents to store monitored data that can be accessed

remotely.

module A software component that may be loaded dynamically to monitor data

resources of systems, applications and network devices.

monitor In Sun Management Center software, monitor is defined as being able to

observe an object, view alarms and properties. Monitoring privileges are

similar to read-only access.

node A node is a workstation or server.

object A particular resource (computer host, network interface, software process, and

so on) which is subject to monitoring or management by Sun Management

Center software. A managed object is one that you can manipulate. For

example, you can acknowledge and turn off an alarm condition for an object

that you can manage. A monitored object is one that you can observe but not

acknowledge or otherwise manage.

production
environment One of two environments in which Sun Management Center software is

deployed. The production environment is a “real” environment (as opposed to

a test environment) in which you manage and monitor your hardware.

remote server context A remote server context refers to a collection of Sun Management Center

agents and a particular server layer with which the remote agents are

associated.

request caching The Sun Management Center server consolidates duplicate outstanding

requests originating from multiple consoles and eliminates the execution of

redundant requests.

rule A rule is an alarm check mechanism that allows for complex or special purpose

logic in determining the status of a monitored host or node.

segment An object representing a “segment” of the network, and used as a basis for a

local network.
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seed The password for the Sun Management Center user group called esmaster .

The seed is an alpha-numeric string of up to 8 characters. (This is not

necessarily a UNIX password.) You can select your own seed, or accept the

default seed (maplesyr ) provided by the Sun Management Center software. If

you select your own seed, be sure to record it for later reference.

server The collection of programs and processes (SNMP-based trap, event, topology,

configuration, and Java server) that work on behalf of a Sun Management

Center user to help manage a particular set of networks, hosts and devices.

Usually sends requests to Sun Management Center agents, accepts collected

data from them, and passes the data to the main console window for display.

server context See “remote server context.”

simple alarm Simple alarms are based on one condition becoming true. You may set alarm

thresholds for simple alarms.

SNMP Simple Network Management Protocol. A simple protocol designed to allow

networked entities (hosts, routers, and so on) to exchange monitoring

information.

SNMPv2 usec SNMP version 2, user-based security model security standards.

Sun Management
Center superuser Sun Management Center superuser is a valid user on a server host. The

superuser decides what the agents are in the context of the server. By default,

the superuser password is used as a seed for security key generation.

Sun Management
Center user Sun Management Center users are the members of the symon group in the

/etc/group file.

topology view The topology view displays the members of the object selected in the hierarchy

view.

URL Uniform Resource Locator. An URL is a textual specification describing a

resource which is network-accessible.
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Index
A
A5000, A5100, A5200 physical view, 296

absolute Time Editor expression, 202, 211 to 217

access control, 304, 308

ACL, 304, 308

Actions tab, 188

adding

a row to a data property table, 152 to 153, 153 to

156, 158 to 160

from graph clipboard, 165 to 167

objects to administrative domains, 101 to 116

add-on components, 20

Address process property, 286

administrative domain

creating, 60

default, 55

definition, 7, 53

deleting, 59, 62 to 64

hierarchy examples, 54

home, 55 to 57, 60

initiating a discovery request, 105 to 108

listing, 132 to 133

members, 7

multiple, 53

populating, 61, 101 to 116

referencing, 60

remote, 65 to 69

security, 12, 59

set home administrative domain, 60

switching between, 132 to 133

advanced message filtering menu, 279

agent

health, 226

interacting with console and server, 3 to 5

port number, 331

SNMP, 10

agent down alarm notification, 253

Agent Statistics

Configuration manager, 334

Event manager, 334

Sun Management Center server, 334

Topology manager, 334

Trap handler, 334

alarm limits, 186

alarm threshold

creating, 187 to 188, 311

alarms, 191

accessing, 261

acknowledged, 257

alert, 406

alert alarm generation, 403

categories, 262

caution, 406

complex, 9

creating, 256

critical, 406

determining the severity of an alarm, 256

generation, 403

red alarm icon, 256

schedule, 201

seeing, 134

sending email when alarm occurs, 190, 191

setting schedule, 218 to 223

severities, 134

simple, 9, 184 to 186
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simple rules, 403

states, 263

threshold, 184 to 186

unacknowledged, 257

windows, 186

Alarms tab button in the Details window, 270

Alarms tab in the Attribute Editor, 184 to 186

Attribute Editor, 144

Actions tab, 188

Alarms tab, 184 to 186

definition, 181

History tab, 196

Info tab, 183

module, 243, 247

opening, 182

Refresh tab, 194

Security tab, 312

attributes

changing, 94 to 96

automatic notification of an alarm condition, 190,

191

B
Browser Details window, 135, 136

Browser tab button in the Details window, 270

buttons

Discovery Request window, 103 to 104

Domain Manager window, 59

Hide Details, 298, 301

Show Details, 298, 301

C
changing attributes about an object, 94 to 96

changing port addresses, 330 to 333

circular log files, 343

class A, B, and C networks, 407

Class process property, 286

Command process property, 287

CommandLine process property, 287

comparison Time Editor expression, 203 to 210, 218

to 223

complex alarms, 9

complex rule

alert alarm generation, 403

definition, 403

Config Reader, 136, 142, 270

special instructions for Details window, 291

Configuration manager, 5, 309

agent statistic, 334

port number, 331

configuring

Details Process display, 285 to 288

legacy agent as subagent, 326 to 328

port addresses, 330 to 333

conflict with port addresses, 330 to 333

connecting objects, 91

console, 3, 10

interacting with server and agent, 3 to 5

multiple consoles, 3

copying

data property to graph, 144

groups, 93 to 94

module, 144

objects, 92 to 94

to graph clipboard, 165 to 167

CPU thrashing, 405

CPU% process property, 287

creating

a module object, 79 to 82, 243

administrative domains, 60

alarm threshold, 187 to 188

alarms, 256

groups, 82 to 85

links between objects, 91

monitored modules, 79 to 82

nodes, 74 to 79, 86 to 88

objects with Discovery manager, 105 to 108

segments, 89 to 92

server component object, 335

critical

alarms, 406

cron Time Editor expression, 202, 211 to 217

customized menu items

adding, 346

customizing alarm actions, 191

cutting objects, 97 to 98

cyclic Time Editor expression, 202, 203 to 210
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D
data

displaying, 150

probing, 162 to 164

refreshing, 161

data property

Attribute Editor, 181

displaying, 150

graphing, 165

monitoring, 201

probing, 162

refresh interval, 195

sampling points, 198

tool tip, 123

data property table

adding row to, 152 to 153, 153 to 156, 158 to 160

default administrative domain, 55

default privileges

overriding, 318

topology manager, Sun Management Center

default security privileges, 317

deleting

administrative domains, 59, 62 to 64

discovery request, 116

events from event database, 340 to 342

objects, 99 to 100

row, 144

Details

alarms, 136

applications, 136

browser, 136

hardware, 136

Details Process display

configuring, 285 to 288

selecting columns, 285 to 287

Details window

Actions tab in the Attribute Editor, 188

Alarms tab button, 270

Alarms tab in Attribute Editor, 184 to 186

Browser tab button, 135, 270

disk total, 291

exiting, 138

Hardware information types, 289

History tab in the Attribute Editor, 196

Info tab button, 270

Info tab in Attribute Editor, 183

Info tab properties, 274

memory hardware total, 291

monitoring log messages, 280 to 281

moving columns in Process display, 287

Process Statistics window, 288

Processes tab button, 282

processors total, 291

Refresh tab in the Attribute Editor, 194

Solaris Process Details module, 283

sorting columns in Process display, 287

starting, 136, 271 to 273

tab buttons, 136

tape devices total, 291

Directory Name Lookup Cache, 406

Directory Size Monitoring module, 235

defining a directory, 152 to 153

list files, 162 to 164

disabling

a module, 144, 241

row, 144

discovery

checking part numbers, 109

deleting request, 116

filters, 110

methods of, 107, 108

modifying request, 115 to 116

request ID, 107

scheduling requests, 110

server context, 107

starting, 102 to 104

starting request, 116

status, 103 to 104

stopping request, 116

timeout, 108 to 109

Discovery Requests window, 103 to 104

disk

busy, 403, 405

complex rules, 403

load, 406

meta, 405

disks, total in Details window, 291

displaying data, 150

Domain Manager buttons, 59

domain, See administrative domain

domain-config .x file, 331

Dynamic Reconfiguration

special instructions for Details window, 291

Dynamic Reconfiguration module, 17
Index 417



E
Edit menu, 127

editing

graph axes, 175

module, 143, 237 to 240

row, 144

EGroup process property, 286

enabling

module, 143, 242

row, 144

Entity Desc property, 274

Entity Event Destination property, 274

Entity Family property, 274

Entity Full Desc property, 274

Entity Trap Destination property, 274

esadm, 40, 43, 305, 306, 308, 315

esdomadm, 40, 43, 305, 306, 315

es-lic  script, 42

esmaster , 42, 47, 304, 306, 323 to 324

esops , 40, 43, 305, 306, 315

espublic , 42, 47, 304, 306, 309, 310, 314, 323 to 324

es-start  utility, 44, 46

es-stop  utility, 49, 51

EUser process property, 286

Event manager, 5, 309, 340 to 342

agent statistic, 334

port number, 331

events

deleting from event database, 340 to 342

meta disk, 405

meta swap, 405

exiting Details window, 138

F
File menu items, 127

File Monitoring module, 152

adding row to table, 153 to 156

File Scanning module, 152, 157

file system full, 405

filtering

discovery requests, 110

log messages, 277 to 280

finding specific log messages, 282

G
general group, 82

Go menu items, 129

graph

applying template, 171

copying data property to, 144

data property, 165

editing axes, 175

historical data, 196

menu items, 172 to 180

multiple data properties, 165 to 167

opening, 170

sampling points, 198

saving, 168

Group ID process property, 286

groups, 54

copying, 93 to 94

creating, 82 to 85

general and IP-based, 82

moving, 93 to 94

pasting, 93 to 94

security, 12

users, 40

H
hand icon, 294

hardware

monitored by Sun Management Center

software, 2

pathnames displayed, 294

resources displayed, 291

supported platforms, 17

Config-Reader module, 17

views of, 292

Hardware Details window, 136

Health Monitor rules, 403

help, 131

pop-up balloon, 141

helpful hints

displaying levels of details, 142, 272

Search function is case-sensitive, 301

searching in multiple instances, 301

using tool tips, 123, 141

viewing long messages in table cells, 272

Hide Details button, 298, 301
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hierarchy view, 10, 119

mouse actions, 121

history interval

schedule, 201

setting, 198, 203 to 210, 211 to 217

History tab, 196

home administrative domain, 55 to 57, 60

host

Details window, 135

security, 12, 146

host down alarm notification, 253

Hostname property, 274

I
increasing virtual size, 337 to 339

Info tab

Entity Desc property, 274

Entity Event Destination property, 274

Entity Family property, 274

Entity Full Desc property, 274

Entity Trap Destination property, 274

Hostname property, 274

IP Address property, 274

Netmask property, 274

Operating System property, 274

properties, 274

Target Hostname property, 274

Target IP Address property, 274

Info tab button in the Details window, 270

Info tab in the Attribute Editor, 183

installation

default administrative domain, 55

minimum disk space required, 16

package location, 29

prerequisites, 21

IP Address property, 274

IP addresses within server contexts, 310

IP-based group, 82

J
Java security classes, 303

K
kernel memory allocation, 406

Kernel Reader

creating alarm, 187 to 188

displaying data, 150

rules, 403

keys, 323 to 324

regenerating, 325

L
legacy agent, 326 to 328

license, exceeding of, 41

licensing of Sun Management Center software, 41

to 42

load, 406

loading modules, 143, 229 to 237

local applications, modules relating to, 386

locations of log files, 277

log files, viewing, 277

log messages

filtering, 277 to 280

finding specific messages, 282

log view, 11, 136

M
main console window, 10

Management Information Base, See modules, MIB

masking of network addresses, 408

memory hardware, total in Details window, 291

Memory% process property, 287

Menu items, 126

Edit, 127

File, 127

Go, 129

graph, 172 to 180

Tools, 129

View, 128

menu, View Columns, 285

messages, viewing, 11

MIB

SNMP, 348

modifying objects, 94 to 96
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module object, creating, 243

modules

Agent Statistics, 226, 387

Attribute Editor, 243 to 247

Config Reader, 226

copying, 144

creating a monitored module, 79 to 82

Data Logging Registry, 226, 391

definition, 8, 139

Details window, 135

Directory Size Monitoring, 227, 235

disabling, 144, 241

dynamic, 8

Dynamic Reconfiguration, 227

editing, 143, 237 to 240

enabling, 143, 242

File Monitoring, 227

File Scanning, 157, 227, 399

Health Monitor, 227, 392

HP JetDirect, 227, 401

in alphabetical listing, 352, 386

Kernel Reader, 227, 363

loaded by default, 226

loading, 143, 229 to 237

local applications, 386

MIB, 8

MIB-II Instrumentation, 227, 354

MIB-II Proxy Monitoring, 227, 401

monitoring, 243

NFS File Systems, 228, 379

NFS Statistics, 228, 377

number of instances loaded, 233

operating system, 352

Print Spooler, 228, 396

Process Monitoring, 158, 228, 236, 398

remote systems, 400

schedule, 201, 243 to 247

security, 12, 146, 243 to 247

security permissions, 246

setting schedule, 218 to 223

Solaris Process Details, 228, 378

that load automatically, 352, 386

that load multiple times, 352, 386

unloading, 144, 242

using ’Add Row’, 352, 386

monitored hardware, 2

monitored software properties, 2, 8

monitoring

data property, 201

log messages, 280 to 281

objects, methods of, 76 to 77

server components, 335

moving columns in Details Process display, 287

moving groups, 93 to 94

N
navigating

administrative domains, 132 to 133

main console window, 130

Netmask, 108

ANDing, 408

property, 274

NFS remote procedure, 406

Nice process property, 286

node, creating, 74 to 79, 86 to 88

notifying you when a host or agent is down, 253

notifying you when an alarm occurs, 190, 191

O
objects

alarms, 134

copying, 92

creating automatically with Discovery

manager, 105 to 108

cutting and pasting, 97 to 98

delete, 99 to 100

Details window, 135

linking two objects, 91

modifying, 94 to 96

pasting, 92

octets in network addressing, 407

opening

Attribute Editor, 182

graphs, 170

operating system

modules relating to, 352

property, 274
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P
pasting

groups, 93 to 94

objects, 92 to 94, 97 to 98

permissions, security, 303

pfiles process statistic, 288

PGroup process property, 286

physical view, 11, 292

refresh details, 298

pictures of system hardware, 292

PID process property, 286

ping  command, 107, 108

pldd process statistic, 288

pmap process statistic, 288

populating administrative domains, 61, 101 to 116

pop-up balloon help, 141

port (SNMP) conflicts, 22 to 24

port addresses

changing, 330 to 333

within server contexts, 310

port numbers

discovery process, 109

starting console, 44

PPID process property, 286

Print Spooler module

adding row to table, 158 to 160

printer monitoring, 228

Priority process property, 286

probe a monitored data property, 162

Process display, configuring, 285 to 288

Process Monitoring module, 152, 158, 236

process property

Address, 286

Class, 286

Command, 287

CommandLine, 287

CPU%, 287

EGroup, 286

EUser, 286

Group ID, 286

Memory%, 287

Nice, 286

PGroup, 286

PID, 286

PPID, 286

Priority, 286

Session ID, 286

Size, 286

Start time, 286

State, 286

Time, 286

UID, 286

User, 286

Wait Channel, 286

Process Statistics window, 288

processes, 136

processes view, 11

processors, total in Details window, 291

property, See data property

pstack process statistic, 288

Q
queue length, complex rules, 403

R
rCompare  rule, 9

referencing administrative domains, 60

refresh data, 161

refresh interval

schedule, 201

setting, 195, 203 to 210, 211 to 217

Refresh tab, 194

regenerating security keys, 325

relationships, inclusive, 308

remote administrative domains, 65 to 69

remote server access, 309

remote server context, 5

remote systems, modules relating to, 400

removing Sun Management Center software, 24

rhltm000, 406

rhltm001, 406

rhltm002, 406

rhltm003, 406

rhltm004, 406

rhltm005, 406

rhltm006, 406
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rhltm007, 406

rknrd100, 405

rknrd102, 405

rknrd103, 405

rknrd105, 405

rknrd106, 405

rknrd401, 405

rknrd402, 405

rknrd403, 405

rknrd404, 405

rknrd405, 405

RMI port address, 332

router forwarding rule, 408

routing tables, 107, 108

row

adding, 152 to 153, 153 to 156, 158 to 160

deleting, 144

disabling, 144

editing, 144

enabling, 144

rule, 5, 9

complex, 403

CPU power, 406

Directory Name Lookup Cache, 406

disk busy, 405

disk loaded, 406

Health Monitor, 403, 406

kernel memory allocation, 406

Kernel Reader, 403, 404 to 405

meta disk, 405

meta swap, 405

no swap space error, 405

run queue length, 406

simple, 403

Solstice SyMON 1.x software, 403

Sun Management Center 2.1 software, 403

swap space, 405, 406

time for an unreferenced page, 406

user-customized, 403

run queue length, 406

running UNIX commands on data, 162 to 164

S
same server context, 5

sampling points for data property, 198

saving graph, 168

schedule, 201, 203 to 210, 211 to 217, 218 to 223, 243

to 247

scheduling discovery requests, 110

search pattern, 281

Search window in Details Logical view, 300

searching for specific log messages, 282

security, 12

access control (ACL) categories, 43, 304, 305

accessing on a module, 312

adding user-defined group, 315

adding users, 43, 312

deleting users, 316

granting administrator privileges, 43, 315

specifying ACL, 308

using key functions, 311

administrative domains, 59

console-to-server messages, 48

default privileges

default privileges, 317

esmaster
private, 304

espublic
public, 304

for a module, 243 to 247

functions

admin, 307

general, 307

operator, 307

host, 146

layers in Sun Management Center software, 303

module, 146

permissions, 303

remote, 65

Sun Management Center users, 42, 304

tab, 312

security keys, 323 to 324

regenerating, 325

seed for security key, 40, 324

segment creation, 89 to 92

selecting columns in Details Process display, 285 to

287

server

access, 309

context, 309

context limitations, 311
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information required, 21

interacting with console and agent, 3 to 5

interaction with agents, 5

interacts with multiple consoles, 5

port number, 48, 331

remote access, 309

server component as monitored object, 335

server context, 65

discovery process, 107

limitations, 311

server-config .x file, 331

Session ID process property, 286

setting

alarm schedule, 218 to 223

history interval, 203 to 210

refresh interval, 195, 211 to 217

schedules, 201

Show Details button, 298, 301

simple alarms thresholds, 9

simple rules

alarm generation, 403

monitored properties, 403

Size process property, 286

Smart delete, 340 to 342

SMsystemCommand, 347

SNMP, 10

MIBs for Sun Management Center Modules, 348

SNMP port

conflicts, 22 to 24

definitions, 331

SNMP subagents, 17, 326 to 328

software properties monitored by Sun

Management Center software, 2, 8

Solaris Process Details module, 283

sorting columns in Details Process display, 287

Start time process property, 286

starting

Details window, 136, 271 to 273

discovery, 102 to 104, 116

the Sun Enterprise SyMON software with

arguments, 44

State process property, 286

statistics

Detail Process Statistics window, 288

pfiles, 288

pldd, 288

pmap, 288

pstack, 288

stopping discovery request, 116

subagent, 326 to 328

subnets, 408

Sun Management Center

add-on packages, 20

component layers, 2

core packages, 19

Java security classes, 303

licensing, 41 to 42

monitoring, 76 to 77

remote access, 309

rules, 403

security layers, 303

server

context limitations, 311

server access, 309

server agent statistic, 334

server context, 309

user functions, 307

user security, 42, 304

Sun StorEdge A5000, 5100, 5200 physical view, 296

swap space, 405, 406

error, 405

in use, 405

switching between administrative domains, 132 to

133

syslog , 405

T
tape devices, total in Details window, 291

Target Hostname property, 274

Target IP Address property, 274

text pattern includes UNIX regular

expressions, 281

Time Editor, 201, 202

combining expressions, 202 to 223

Time process property, 286

timeout, discovery process, 108 to 109

tool tip, 123, 141

Tools Menu

customizing, 346

Tools menu item, 129
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Topology manager, 5, 309

agent statistic, 334

exiting, 337 to 339

function, 337

port number, 331

system resource requirement, 337

Virtual Size limit, 337

topology view, 10, 119

mouse actions, 123

Trap handler, 5, 309

agent statistic, 334

port number, 331

U
UID process property, 286

uninstalling Sun Management Center software, 24

UNIX regular expressions in text patterns, 281

unloading a module, 144, 242

User process property, 286

users, 42, 304

default functions, 307

esmaster , 304

espublic
public, 304

V
var/adm/message , 405

view

hierarchy, 10

of administrative domain, 119

topology, 10

View Columns pull-down menu, 285

View menu items, 128

viewing

error messages, 11

log files, 277

virtual size, increasing, 337 to 339

W
Wait Channel process property, 286
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	8. Check that you typed in all the information correctly in the Sun Management Center Login windo...
	9. Click the Login button in the Sun Management Center Login window to log into the Sun Managemen...
	FIGURE�3�3 Sun Management Center Main Console Window




	Exiting and Stopping the Sun Management Center Software
	TABLE�3�5 Options for es-stop Choices�
	To Exit the Sun Management Center Console
	1. Select File ‰ Exit from the menu bar on the main console window.
	2. Click the Exit button to exit the application or the Cancel button to cancel your request.
	FIGURE�3�4 Exit Sun Management Center Dialog


	To Stop the Sun Management Center Server and Agents
	4
	Using Sun Management Center Administrative Domains
	FIGURE�4�1 Example Administrative Domain



	Starting Sun Management Center Software
	FIGURE�4�2 Set Home Domain Dialog
	To Set a Home Administrative Domain
	1. Proceed with one of the following:
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	To Create Administrative Domains
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	FIGURE�4�7 Create Domain Dialog
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	Populating Administrative Domains

	Managing Administrative Domains
	Selecting Administrative Domains
	To Select an Administrative Domain
	1. Proceed with one of the following:
	FIGURE�4�8 Sun Management Center Main Console Window with a List of Current Administrative Domains

	2. Click the left mouse button on the administrative domain you want to view.
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	2. Type the name of the remote server in the Host field. If applicable, also type the appropriate...
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	3. Type the name(s) of user and administrator groups in the appropriate fields.
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	FIGURE�4�16 Attribute Editor for an Administrative Domain
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	Creating a Node
	To Create a Node
	1. In the hierarchy view of the main console window, select the administrative domain in which yo...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	FIGURE�5�1 Create Topology Object Window—Node Tab

	3. In the upper half of the Create Topology Object menu, set up the new node:
	a. Click the Monitor Via button to see the pull-down menu, then select the software or agent to m...
	TABLE�5�1 Types of Sun Management Center Monitoring�

	b. If applicable, select a type from the pull-down menu in the Type field.
	TABLE�5�2 Choices Available in the Type Pull-Down Menu

	c. If applicable, scroll and select an object in the Create Topology Object window.
	d. (Optional) Create a unique new name in the Node Label field.
	e. (Optional) Type a description of the node.

	4. In the lower half of the Create Topology Object window, type the requested information.
	5. Complete this procedure with one of the following actions:

	Creating a Monitored Module Object
	To Create a Module Object
	1. In the hierarchy view of the main console window, select the administrative domain in which yo...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	3. Select the Node tab in the Create Topology Object window.
	4. Select Sun Management Center Agent – Module in the Monitor Via field (FIGURE�5�2).
	FIGURE�5�2 Create Topology Object Window for Sun Management Center Agent – Module

	5. (Optional) Type a node label.
	6. (Optional) Type a description.
	7. Type a host name or IP address.
	8. If necessary, change the port number.
	9. Click the List Modules button to display a list of modules that are currently loaded on the host.
	FIGURE�5�3 Module List

	10. Select the module that you want to monitor and click OK.
	11. Complete this procedure with one of the following actions:


	Creating Groups
	To Create a Group
	1. In the hierarchy view of the main console window, click the administrative domain in which you...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	FIGURE�5�4 Creating an Object
	FIGURE�5�5 Creating a Group in the Create Topology Object Window

	3. In the Create Topology Object window:
	a. Click the Group tab (FIGURE�5�5).
	b. Change the Type field, if desired (General or IP-Based).
	c. Select the object type (Building, Campus, or General).
	d. Create a new group Label.
	e. (Optional) Type a description in the optional Description field.
	f. For an IP-based group, specify the IP address and the subnet mask.

	4. Complete this procedure with one of the following actions:
	5. Add components to your group:


	Creating a Composite Object
	To Create a Composite Object
	1. In the hierarchy view of the main console window, select the Sun Management Center administrat...
	2. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).
	3. Click the Composite tab in the Create Topology Object window.
	FIGURE�5�6 Create Topology Object Window—Composite Tab

	4. Select an object in the Create Topology Object window.
	5. Create a unique new name in the Label field.
	6. (Optional) Type a description of the node.
	7. In the lower half of the Create Topology Object window, type the requested information.
	8. Complete this procedure with one of the following actions:


	Creating Segments
	To Create a Segment
	1. In the main console window:
	a. In the left window, select a location in the administrative domain where the new segment shoul...
	b. In the main console window, select Edit ‰ Create an Object (FIGURE�5�4).

	2. In the Create Topology Object window:
	a. Click the Segment tab (FIGURE�5�7).
	FIGURE�5�7 Segment Tab in the Create Topology Object Window

	b. Change the Type field, if desired (Bus or Ring).
	c. Select the object type.
	d. Type a new segment label.
	e. (Optional) Type a description in the Description field.
	f. Type the IP address for this segment.
	g. Type a subnet mask for this segment.

	3. Complete this procedure with one of the following actions:

	Connecting Objects
	To Connect Objects
	1. Select two objects in the topology view.
	2. Select Edit ‰ Create a Connection.


	Copying Objects
	To Copy an Object
	1. In the main console window, select the existing object in the topology view.
	2. At the top of the main console window, select Edit ‰ Copy in the pull�down menu.
	3. Open the destination group or administrative domain.
	4. At the top of the main console window, select Edit ‰ Paste.

	To Copy a Group of Objects
	1. In the topology view, select the objects to be copied.
	a. Click the first object to select it.
	b. On the keyboard hold down the Shift key and click one or more additional objects.

	2. Select Edit ‰ Copy in the main console window menu bar.
	3. In the hierarchy view, select (highlight) the new group or administrative domain where the gro...
	4. Select Edit ‰ Paste Into in the main console window menu bar.


	Modifying Objects
	To Modify an Object
	1. Select the object in the main console window.
	2. Select Edit ‰ Modify in the main console window.
	FIGURE�5�8 Modify Object Window—Example for a Node

	3. Edit the characteristics as needed.
	4. Click OK to save your changes, or Cancel to leave the characteristics unchanged.


	Cutting and Pasting Objects
	To Cut and Paste Objects
	1. Select an existing object in the topology view.
	2. Select Edit ‰ Cut (FIGURE�5�9) in the main console window.
	FIGURE�5�9 Cut, Copy, and Paste Options

	3. Navigate to the destination location in the topology view.
	4. Select Edit ‰ Paste. The object is displayed in this location and is removed from the previous...


	Deleting Objects
	To Delete Objects
	1. Select an existing object in the topology view.
	2. Select Edit ‰ Delete Object/Connection from the top of the main console window (FIGURE�5�10).
	FIGURE�5�10 Delete Option
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	Starting the Discovery Requests Window
	To Start the Discovery Requests Window
	FIGURE�6�1 Tools Pull-down Menu
	FIGURE�6�2 Discovery Requests Window
	TABLE�6�1 Discovery Requests Window Fields
	1. New. A new request was added but has never been processed.
	2. Queued. A request has been sent to the server but processing has not yet started.
	3. Running. The request is currently being processed.
	4. Succeeded. The request has been successfully processed.
	5. Failed. Processing of the request has failed.
	6. Stopped. The user has stopped the process.
	7. 0 Host found. The request did not find any hosts that passed the filter limits.

	TABLE�6�2 Discovery Requests Window Buttons


	Initiating a Discovery Request
	To Initiate a Discovery Request
	1. Click the Add button in the Discovery Requests window.
	FIGURE�6�3 New Discover Request Window

	2. (Optional) Type a new name for your discovery request in the Request Name field.
	3. In the Discover Using field, select the method that should be used for discovering the network...
	4. Click the OK button to start the discovery process, or go to the other tabs in this window to ...
	5. If a Sun Management Center server or agent is incorrectly reported to be a ping host, create a...


	Customizing Your Discovery Request
	TABLE�6�3 Summary of Discovery Variables�
	To Customize a Discovery Request
	1. Click the Preferences tab.
	FIGURE�6�4 New Discover Request Preferences Window

	2. Type your selections in the Logging, PING, SNMP, and General fields.
	3. Click the Filters tab.
	FIGURE�6�5 New Discover Request Filters Window

	4. Click one or more boxes for host names, operating system, or platform type.
	5. Click the Scheduling tab.
	FIGURE�6�6 New Discover Request Scheduling Window

	6. If you want to schedule automatic discoveries, click the button for “Periodically discover new...
	7. When you have finished your edits, click OK to save the new discovery request, or click Cancel...
	8. Click Close to exit the window.


	Modifying a Discovery Request
	To Modify a Discovery Request
	1. Select Tools ‰ Discover in the main console window (FIGURE�6�1).
	2. Find and select the name of the discovery request you want to modify.
	3. Click the Modify button.
	4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change settings as...
	5. Complete this procedure with one of the following actions:
	6. Exit from the window:


	Starting, Stopping, or Deleting a Discovery Request
	To Start, Stop, or Delete a Discovery Request
	1. Select Tools ‰ Discover in the main console window (FIGURE�6�1).
	2. Select the name of the discovery request you want to modify.
	3. Click the Start, Stop, or Delete button to start, stop, or delete a request, respectively.
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	Administrative Domain View
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	Topology View
	TABLE�7�2 Mouse Actions in the Topology View

	Tool Tip
	To See a Tool Tip
	FIGURE�7�3 Tool Tip


	Pop-up Menu
	To Access a Pop-Up Menu
	1. Click the right mouse button on the object.
	2. Click the left button to select a menu item (TABLE�7�3).
	TABLE�7�3 Common Pop-Up Menu Items




	Menu Bar
	FIGURE�7�4 Menu Bar
	To Use the Main Console Window Menu Bar
	1. Click an entry in the menu bar to display a pull-down menu.
	2. Click an entry in the pull-down menu to initiate that action.

	File Menu Options
	TABLE�7�4 Options for the File Menu

	Edit Menu Options
	TABLE�7�5 Options for the Edit Menu�

	View Menu Options
	TABLE�7�6 Options for View

	Go Menu Options
	TABLE�7�7 Go Menu Items

	Tools Menu Options
	TABLE�7�8 Tools Menu Items


	Navigation Buttons
	FIGURE�7�5 Navigation Buttons
	TABLE�7�9 Navigation Buttons
	To Search For a Name
	1. Click on the search button (FIGURE�7�5).
	2. Type the name or part of the name in the Object Label: field and click the Search button.
	3. Highlight the appropriate name and click on the Go To button.
	FIGURE�7�6 Topology Search Window



	Sun Management Center Administrative Domains Pull�Down Menu
	FIGURE�7�7 Administrative Domains Pull-Down Menu
	To View the Current List of Administrative Domains
	1. In the main console window, click the Sun Management Center Administrative Domains button.
	2. Click the administrative domain that you want to view.


	Administrative Domain Status Summary
	FIGURE�7�8 Domain Status Summary
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	Details View
	Using the Details Window
	TABLE�8�1 Details Window—Common Tab Buttons
	To Start the Details Window
	FIGURE�8�1 Opening the Details Window from the Pop�Up Menu
	FIGURE�8�2 Opening the Details Window from the Tools Menu

	To Exit the Details Window

	Browser Tab
	FIGURE�8�3 Browser Details Window
	FIGURE�8�4 Click a Compressed Icon to “Unroll” Additional Levels of Detail
	Hardware
	Operating System
	Local Applications
	Remote Systems
	Browser Buttons
	TABLE�8�2 Browser Buttons�
	FIGURE�8�5 Module Menu Options in Details Window
	FIGURE�8�6 Options Menu Options in Details Window


	Host Security
	FIGURE�8�7 Attribute Editor for a Host or Module
	To Set Security for a Host or Module
	1. Open the Attribute Editor for a host or module by proceeding with one of the following:
	2. Click the Security tab (FIGURE�8�7).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
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	Monitoring Data Properties
	To Display a Data Property
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the Kernel Reader icon in the contents view or single click in the expansion/c...
	3. Double�click on the System Load Statistics icon in either the hierarchy or the contents view (...
	FIGURE�9�1 System Load Statistics


	Working with Rows
	TABLE�9�1 Sun Management Center Modules That Enable You to Add Rows

	To Define a Directory
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the Directory Size Monitoring icon in the contents view or single click in the...
	3. Double�click on the Directory Size Monitoring Status folder in either the hierarchy or the con...
	FIGURE�9�2 Directory Size Monitoring Table

	4. Proceed with one of the following:
	5. Type the appropriate information in the text fields.
	6. Complete this procedure with one of the following actions:

	To Add a Row (for the File Monitoring, File Scanning, and Process Monitoring Modules)
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the File Monitoring icon in the contents view or single click in the expansion...
	3. Double�click on the File Monitoring Status folder in either the hierarchy or the contents view.
	FIGURE�9�3 File Monitoring Table

	4. Proceed with one of the following:
	5. Type the appropriate information in the text fields.
	FIGURE�9�4 Row Adder Window for the File Monitoring Module

	6. Complete this procedure with one of the following actions:
	FIGURE�9�5 Updated File Monitoring Table
	FIGURE�9�6 Row Adder Window for the File Scanning Module
	FIGURE�9�7 Row Adder Window for Process Monitoring Module


	To Add a Printer
	1. In the Browser Details window, double�click on the Print Spooler icon in the hierarchy (tree) ...
	2. Double�click on the Print Spooler icon in the contents view or single click in the expansion/c...
	3. Double�click on the Print Spooler folder in either the hierarchy or the contents view.
	FIGURE�9�8 Print Spooler Property Tables

	4. Proceed with one of the following:
	5. Type the appropriate information in the text fields.
	FIGURE�9�9 Row Adder Window for the Print Spooler Module

	6. Complete this procedure with one of the following actions:

	To Refresh Displayed Data
	FIGURE�9�10 Monitored Data Property Pop�up Menu

	Probing Properties
	To Probe a Property
	1. In the Browser Details window, double�click on the Operating System icon in the hierarchy (tre...
	2. Double�click on the Directory Size Monitoring icon in the contents view or single click in the...
	3. Double�click on the Directory Monitoring Status folder icon in either the hierarchy or the con...
	4. Proceed with one of the following:
	FIGURE�9�11 Probe Commands in the Pop�up Menu
	FIGURE�9�12 Probe Select Dialog


	Graphing Properties
	To Graph A Monitored Data Property
	FIGURE�9�13 Graph of System Load Statistics Average Over the Last Five Minutes

	To Graph Two Data Properties
	1. Click the right mouse button in the data property table cell.
	2. Proceed with one of the following:
	3. Go to the graphing window in which you want the additional property to be plotted. Select Grap...
	FIGURE�9�14 Copying Load Averages Over the Last One Minute to the Graph
	FIGURE�9�15 Adding Load Averages Over the Last One Minute to the Graph
	FIGURE�9�16 Load Averages Over the Last One and Five Minutes


	To Save Graphing Parameters
	1. Select Graph ‰ Save Graph Request As or Select Graph ‰ Save Template in the Graphing window.
	2. Type the name in the Enter Graph Name or Enter Template Name fields.
	3. Click the Save button to save your graph request (template) or click the Cancel button to canc...
	FIGURE�9�17 Save Graph Request Dialog
	FIGURE�9�18 Save Template Dialog


	To Open a Graph
	1. Select Graph ‰ Open Saved Graph in the Graphing window.
	FIGURE�9�19 Open Graph Dialog

	2. Select (highlight) a saved graph from the list.
	3. Click the OK button to open the graph or the Cancel button to cancel your request.

	To Apply a Graph Template
	1. Select Graph ‰ Apply Template in the Graphing window.
	FIGURE�9�20 Apply Template Dialog

	2. Select (highlight) a saved template from the list.
	3. Click the OK button to apply the template to the current graph or the Cancel button to cancel ...

	Graphing Menus
	Graph Menu Items
	TABLE�9�2 Graph Menu Items
	FIGURE�9�21 Graph Menu Items

	Edit Menu Items
	TABLE�9�3 Edit Menu Items
	FIGURE�9�22 Edit Menu Items
	FIGURE�9�23 X-Axis Editing Dialog
	FIGURE�9�24 Y-Axis Editing Dialog

	View Menu Items
	TABLE�9�4 View Menu Items�
	FIGURE�9�25 View Menu Items

	Tools Menu Items
	TABLE�9�5 Tools Menu Items
	FIGURE�9�26 Tools Menu Items
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	Attribute Editor for a Data Property
	To Open the Attribute Editor
	1. Click the right mouse button and select a data property table cell (FIGURE�10�1).
	2. Proceed with one of the following:
	FIGURE�10�1 Selected Data Property


	Information Tab in the Attribute Editor
	FIGURE�10�2 Attribute Editor Info Tab for a Monitored Property

	Alarms Tab in the Attribute Editor
	FIGURE�10�3 Attribute Editor Alarms Tab for a Monitored Property
	TABLE�10�1 Common Simple Alarm Limits in Sun Management Center Software

	To Create an Alarm
	1. Click the Browser tab button in the Details window.
	2. Click the expansion/compression icon next to the Operating System icon in the hierarchy tree v...
	3. Click the expansion/compression icon next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click on the Alarms tab button.
	8. Type a value in the Critical Threshold (>) field which is less than the current value (FIGURE�...
	9. Complete one of the following actions:
	10. Click the Alarms tab button in the Details window.
	11. Acknowledge this alarm.
	12. Create additional alarm thresholds and familiarize yourself with their operation.

	Actions Tab in the Attribute Editor
	FIGURE�10�4 Attribute Editor Actions Tab for a Monitored Property

	To Send an Email
	1. Click the Browser tab button in the Details window.
	2. Click the expansion/compression icon next to the Operating System icon in the hierarchy tree v...
	3. Click the expansion/compression icon next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Actions tab button.
	8. Type email username in the Critical Action field.
	9. Complete this procedure with one of the following actions:

	To Define Your Own Alarm Action Script
	1. Create your custom alarm action script, using the following optional arguments:
	TABLE�10�2 Arguments for Custom Alarm Action Script

	2. At the command-line level, become superuser.
	3. Install the script in the home Sun Management Center directory. The default is the /var/opt/SU...
	4. Click the Browser tab button in the Details window.
	5. Set the alarm threshold.
	6. Click the expansion/compression icon next to the Operating System icon in the hierarchy tree v...
	7. Click the expansion/compression icon next to the Kernel Reader icon.
	8. Double�click on the System Load Statistics icon.
	9. Click the left mouse button to select the table cell for Load Averages Over the Last 5 Minutes.
	10. Click the Attributes button.
	11. Click the Actions tab button.
	12. Type custom_alarm_script %statusstringfmt in the Critical Action field.
	FIGURE�10�5 Defining Custom Script for Alarm Action in the Attribute Editor Screen

	13. Complete this procedure with one of the following actions:

	Refresh Tab in the Attribute Editor
	FIGURE�10�6 Attribute Editor Refresh Tab for a Monitored Property

	To Set a Refresh Interval
	1. Click the Browser tab button in the Details window.
	2. Click the expansion/compression icon next to the Operating System icon in the hierarchy tree v...
	3. Click the expansion/compression icon next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Refresh tab button.
	8. Type a value (in seconds) in the Refresh Interval field or click the Advanced button.
	9. Complete this procedure with one of the following actions:

	History Tab in the Attribute Editor
	FIGURE�10�7 Attribute Editor History Tab for a Monitored Property

	To Set a History Interval
	1. Click the Browser tab button in the Details window.
	2. Click the expansion/compression icon next to the Operating System icon in the hierarchy tree v...
	3. Click the expansion/compression icon next to the Kernel Reader icon.
	4. Double�click the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the History tab button.
	8. Type a value (in seconds) in the Sample Interval field or click on the Advanced button.
	9. Click in the check box next to Save History as Disk File or Save History in Memory Cache.
	10. If you decided to save history as a disk file, determine the file type (circular or text) and...
	11. If you decided to save history in memory cache, type the number of history data points in the...
	12. Complete this procedure with one of the following actions:
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	Using the Time Editor
	FIGURE�11�1 Time Editor
	Combining Time Expressions
	To Create a Time Expression Using the Cyclic and Comparison Tabs
	1. Click on the Advanced button in the History tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Determine the frequency for the history interval (FIGURE�11�2).
	a. Highlight the number field and click the up or down arrows until the number 1 is displayed.
	b. Highlight the units field and click the up or down arrows until hours is displayed.
	FIGURE�11�2 Setting a Cyclic Time of One Hour


	5. Click the Apply button.
	FIGURE�11�3 Time Editor With Cyclic Time of One Hour

	6. Click the Insert button.
	7. Click the Comparison tab.
	8. Determine the start of the Time Range (Monday).
	a. Select Day of week from the left pull�down menu.
	b. Select >= from the middle pull�down menu.
	c. Select Monday from the right pull�down menu.
	FIGURE�11�4 Setting the Start Range to Monday


	9. Click the Apply button.
	FIGURE�11�5 Time Editor Is Updated With a Start Range of Monday

	10. Determine the end of the Time Range by clicking the Insert button.
	11. Click on the Comparison tab of the Time window.
	12. Determine the end of the Time Range (Friday).
	a. Select Day of week from the left pull�down menu.
	b. Select <= from the middle pull�down menu.
	c. Select Friday from the right pull�down menu.
	FIGURE�11�6 Setting the End Range to Friday


	13. Click the Apply button.
	FIGURE�11�7 Time Editor Showing a Cycle Time of One Hour From Monday to Friday

	14. Click the Apply button.
	FIGURE�11�8 Updated History Attribute Editor Showing a Cycle Time of One Hour From Monday to Friday


	To Create a Time Expression Using the Absolute and Cron Tabs
	1. Click on the Advanced button in the History tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Click the Absolute tab.
	5. Determine the starting time and date (FIGURE�11�9).
	a. Highlight the hour, minute, and if desired, the seconds fields and click the up or down arrow ...
	b. Highlight the month, date, and year fields and click the up or down arrow until the correct da...
	FIGURE�11�9 Starting Time of 12:00:00 PM on August 20, 1999


	6. Click the Apply button.
	FIGURE�11�10 Time Editor With Starting Time of 12:00:00 PM August 20, 1999

	7. Click the Insert button.
	8. Click the Cron tab.
	9. Select the time when the history interval is active.
	a. Select 0 from the Minute pull�down menu.
	b. Select 3rd from the hour pull�down menu.
	c. Select Every from the Day of month pull�down menu.
	d. Select Every from the Month pull�down menu.
	e. Select Monday from the final pull�down menu.
	FIGURE�11�11 Cron Tab Selected With 3:00 AM Every Monday


	10. Click the Apply button.
	FIGURE�11�12 Time Editor Selected With Starting Date/Time 12:00:00 PM, August 20, 1999, and Histo...

	11. Place the cursor in the Cron field on the Time Editor screen. Backspace using the left arrow ...
	FIGURE�11�13 Time Editor With Starting Date/Time of 12:00:00 PM, August 20, 1999 and History Inte...

	12. Click the Apply button.
	FIGURE�11�14 History Interval With Starting Time of 12:00 PM August 20, 1999 and 3:00 AM Every Mo...


	To Create an Alarm Schedule Using the Comparison Tab
	1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Determine the start of the Time Range (9:00 AM).
	a. Select Hour from the left pull�down menu.
	b. Select >= from the middle pull�down menu.
	c. Select 9 from the right pull�down menu.
	FIGURE�11�15 Comparison Tab With Greater Than or Equal to 9:00 AM


	5. Click the Apply button.
	FIGURE�11�16 Time Editor With Greater Than or Equal to 9:00 AM

	6. Determine the end of the Time Range by clicking the Insert button.
	7. Determine the end of the Time Range (Friday).
	a. Select Hour from the left pull�down menu.
	b. Select <= from the middle pull�down menu.
	c. Select 17 from the right pull�down menu.
	FIGURE�11�17 Comparison Tab With Less Than or Equal to 5:00 PM


	8. Click the Apply button.
	FIGURE�11�18 Time Editor With Time Interval Between 9:00 AM and 5:00 PM

	9. Click the Apply button.
	FIGURE�11�19 Alarms Attribute Editor With Alarm Window From 9:00 AM to 5:00 PM Every Day
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	Sun Management Center Modules
	Default Modules
	Module List
	TABLE�12�1 Sun Management Center Modules�


	Loading Modules
	To Load a Module
	1. Select the host machine on which the module will be loaded by clicking on the host machine icon.
	2. Open the Load Module dialog by doing one of the following:
	FIGURE�12�1 Load Module Pop�Up Menu in Hierarchy View
	FIGURE�12�2 Load Module Pop�Up Menu in Topology View
	FIGURE�12�3 Tools Menu in Main Console Window
	FIGURE�12�4 Load Module Menu in Details Window
	FIGURE�12�5 Load Module Dialog

	3. Click the name of the module you want to load.
	4. Click the OK button.
	FIGURE�12�6 Module Loader Dialog For Directory Size Monitoring
	FIGURE�12�7 Module Loader Dialog for Process Monitoring

	5. If necessary, type the relevant information into any editable name fields.
	6. Complete this procedure with one of the following actions:


	Editing Modules
	FIGURE�12�8 Edit Module Pop�Up Menu in Hierarchy View
	FIGURE�12�9 Edit Module Pop�Up Menu in Contents View
	FIGURE�12�10 Edit Module Menu in Details Window
	To Edit Module Parameters
	1. Select the selected module.
	2. Proceed with one of the following:
	3. Type the relevant information into the editable fields.
	FIGURE�12�11 Module Parameter Editor

	4. Complete this procedure with one of the following actions:

	To Disable a Module
	FIGURE�12�12 MIB-II Instrumentation Module Is Disabled

	To Enable a Module
	To Unload a Module
	1. Proceed with one of the following:
	FIGURE�12�13 Unload Module Dialog

	2. Click the Unload button to remove the module or the Cancel button to cancel this request.


	Monitoring Modules
	Attribute Editor for a Module
	Setting a Module Schedule
	To Set a Module Schedule
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Schedule tab (FIGURE�12�14).
	3. Click the Advanced button and set the module schedule.
	4. Complete this procedure with one of the following actions:
	FIGURE�12�14 Setting a Module Schedule


	Setting Security Permissions for a Module
	To Set Security Permissions for a Module
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Security tab (FIGURE�12�15).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
	FIGURE�12�15 Setting Module Security in the Attribute Editor
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	Sun Management Center Alarms
	Types of Alarms
	FIGURE�13�1 Domain Status Summary in the Main Console Window
	FIGURE�13�2 Alarm Icons
	Down Alarms
	Critical Alarms
	Alert Alarms
	Caution Alarms
	Off/Disabled Alarms
	FIGURE�13�3 Objects with Indeterminate States Identified by Black Star or “Splat” Icon



	Notifying Users That a Host or Agent is Down
	To Set Up User Notification for Down Host or Agent
	1. In the main console window, select the host or group of hosts that you want to receive notific...
	2. Click the right mouse button to display the pop-up menu, and select Alarm Action (FIGURE�13�4).
	FIGURE�13�4 Pop�Up Menu in Hierarchy View

	3. Enter the email address and username to be notified for the host down, and agent down condition.
	4. To include any email users who are linked to the down host or agent group, click “yes” in the ...
	FIGURE�13�5 Attribute Editor - Alarm Action

	5. Click OK to close the Attribute Editor - Alarm Action screen.


	Creating Alarms
	Viewing Alarm Information
	Colored Alarm Icons
	FIGURE�13�6 Alarms in the Details Window
	FIGURE�13�7 Alarms in the Contents View

	Seeing Alarms in Domain Status Summary
	FIGURE�13�8 Domain Status Summary Buttons

	To Access Alarms from the Main Console Window
	1. Click on one of the Domain Status Summary buttons in the main console window. (FIGURE�13�8).
	2. Complete this procedure with one of the following actions:
	FIGURE�13�9 Domain Status Details Window



	Information on Alarms
	To Access Alarms from the Alarms Tab in the Details Window
	1. Click with your right mouse button on the selected host icon in the main console window and hi...
	2. Click on the Alarms tab button.
	FIGURE�13�10 Alarms Tab Data from the Details Window


	Alarm Categories
	TABLE�13�1 Alarm Categories Displayed in Table�
	TABLE�13�2 Additional Alarm Information Displayed When a Single Row is Selected

	Alarm Severities
	FIGURE�13�11 Alarm Severities

	Alarm States
	FIGURE�13�12 Open and Closed Alarms

	To View Alarm Categories
	1. Click on the Show button below the Table actions field.
	2. Click on the appropriate tab to filter your alarm request.
	3. Click on the Severity tab (FIGURE�13�11).
	4. Click on the check box next to a severity to show alarms of that severity.
	5. Click on the State tab (FIGURE�13�12).
	6. Click on Open or Closed to show these types of alarms.
	7. Click on the Acknowledge tab.
	8. Click on Acknowledged or Unacknowledged to show these types of alarms.
	9. Complete this procedure with one of the following actions:

	To Sort Alarms
	FIGURE�13�13 Sort Alarm Table
	1. Click on the Sort button below the Table actions field.
	2. Select your sort feature by clicking in the circle next to your selection.
	3. Complete this procedure with one of the following actions:

	To Reset the Alarm Table

	Acknowledging and Deleting Alarms
	To Acknowledge and Delete Alarms
	1. Select the alarms you want to update by clicking the selected row(s) in the table.
	2. Click the appropriate button under the Alarm actions field.
	TABLE�13�3 User Actions That Can Be Performed on Alarms



	Creating Alarm Conditions
	To Create Alarm Conditions To Monitor Hosts
	1. Navigate through the Operating System modules until you see the User Statistics icon (part of ...
	2. Select Attribute Editor from the pop-up menu.
	3. Create an alarm condition by following the procedure in “To Create an Alarm” on page�187.
	4. Click on the Alarms tab button in the Details window.
	5. Acknowledge, then delete this alarm if the alarm is closed.
	6. Create additional alarm conditions and familiarize yourself with their operation.
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	Details
	TABLE�14�1 Common Details Window Tab Buttons



	Navigating the Details Window
	To Start the Details Window
	1. Double click the left mouse button on an object icon in either the hierarchy view or the topol...
	FIGURE�14�1 Details Window for a Selected Object

	2. Click a tab to view detailed information for that category.
	FIGURE�14�2 Expansion/Compression Icon to Reveal or Hide Additional Levels of Detail


	To Close the Details Window
	To Display Online Documentation

	Info Tab
	TABLE�14�2 General Properties in the Info Tab of the Details Window

	Browser Tab
	Alarms Tab
	View Log Tab
	FIGURE�14�3 View Log Tab
	Log File Type Button
	To View the Log File Messages
	Filtering Your Messages
	To Filter Your Log Request
	1. Click the Filter button in the view log (FIGURE�14�3).
	FIGURE�14�4 Message Filter Options Dialog

	2. Using the down arrows, select the starting date by highlighting the month, day, and year for t...
	3. Select the starting time by using the down arrows.
	4. Select the ending date.
	5. Select the ending time.
	6. Type the text pattern to be matched in the field marked “Text pattern to match.”
	7. Click the Advanced button if you want to refine further your filter request. Otherwise, skip t...
	FIGURE�14�5 Advanced Message Filter Options Dialog

	8. To perform a forward or backward search through the log file, select Forward or Backward.
	9. (Optional) Type the maximum number of log messages that should be matched in the field marked ...
	10. Complete this procedure with one of the following actions:


	Reload Button
	Monitor Button
	To Monitor Log Messages
	1. Click the Monitor button in the view log (FIGURE�14�3).
	FIGURE�14�6 Monitor Filter Options Dialog

	2. Click the appropriate circle to enable or disable log file monitoring.
	3. To display only currently monitored log messages, click the check box to clear old monitored m...
	4. Type the text pattern to be matched in the field marked Text pattern to match.
	5. Complete this procedure with one of the following actions:


	Finding Specific Log Messages
	To Find a Log Message
	1. Type the specific character sequence (part of the log message) in the Find field (FIGURE�14�3).
	2. Click Return or the down or up arrow to search the log messages for that sequence.
	3. Click Return or the down or up arrow to continue your search and find additional occurrences o...



	Applications Tab
	View Processes
	FIGURE�14�7 Process Viewer
	Configuring the Process Display
	Selecting Columns for Viewing
	1. Click the View Columns button above the Process table to display the View Columns pull-down menu.
	FIGURE�14�8 View Columns Menu

	2. Highlight one or more process properties that you want to display.
	TABLE�14�3 Process Viewer Properties�


	Sorting Columns
	To Sort Columns in Ascending Order
	To Sort Columns in Descending Order
	Moving Columns
	To Reorder Columns in the Table
	1. Select a column by clicking and holding down the mouse button on the table column header.
	2. Drag the column to the desired position.

	Process Statistics Window
	TABLE�14�4 Process Statistics

	Process Summary Field

	Custom or Third-Party Applications

	Hardware Tab
	FIGURE�14�9 Hardware Details Window
	To View a Hardware Configuration
	Resources
	TABLE�14�5 Resources

	Physical View
	FIGURE�14�10 Hardware Configuration Physical View
	View Points
	FIGURE�14�11 Hardware Component Physical View

	Physical View When a Sun StorEdge Device is Connected
	FIGURE�14�12 Pop-up sena Menu
	FIGURE�14�13 sena (0) Physical View with Details

	Dynamic Reconfiguration
	Show/Hide Details
	Refresh Details
	FIGURE�14�14 Property/Value View


	Logical View
	FIGURE�14�15 Hardware Configuration Logical View
	Search
	FIGURE�14�16 Search Window

	Dynamic Reconfiguration
	Show Details
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	Sun Management Center Security



	Access Control (ACL) Categories
	Sun Management Center Users
	Public and Private Users
	General Users
	Sun Management Center Superuser


	Sun Management Center Groups
	Sun Management Center Operators or esops
	Sun Management Center Administrators or esadm
	Sun Management Center Domain Administrators or esdomadm

	Admin, Operator, and General Functions
	TABLE�15�1 Domain Admin, Admin, Operator, and General Functions�


	Specifying Access Control (ACL)
	Admin, Operator, and General Access
	Sun Management Center Remote Server Access
	Sun Management Center Server Context
	FIGURE�15�1 Remote Server Context

	Limitations While Crossing Servers


	Using Access Control (ACL)
	To Add Sun Management Center Users
	1. Become superuser (on the Sun Management Center server host).
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers. Make sure that the user name is that of a valid ...
	3. Add the user name on a new line.
	4. Save the file and exit the editor.

	To Access ACL on a Module
	1. Proceed with one of the following:
	2. Select the Security tab within the Attribute Editor window (FIGURE�15�2).
	3. Change the values as required.
	FIGURE�15�2 Example of Security Fields in the Attribute Editor
	TABLE�15�2 Security Attributes


	To Add a User-Defined Group to an ACL
	1. Become superuser.
	2. Create a group:
	3. Add users to the newly created group:
	a. Edit the /etc/group file.
	b. Add users to the group.
	c. Save the file and exit the editor.

	4. Add the new group to the ACL of interest.

	To Grant a User esadm, esops, or esdomadm Privileges
	1. Become superuser.
	2. Make sure that the user is a valid Sun Management Center user.
	3. Edit the /etc/group file.
	4. Add the user to one of the following lines as applicable: esadm, esops, or esdomadm.
	5. Save the file and exit the editor.

	To Delete Sun Management Center Users
	1. Become superuser on the Sun Management Center server host.
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers.
	3. Delete the line corresponding to the user name you want to delete.
	4. Save the file and exit the editor.
	5. Delete the user names from additional groups.


	Default Privileges
	Topology Manager Default Privileges
	TABLE�15�3 Default Privileges for Topology Manager

	Other Sun Management Center Component and Module Default Privileges
	TABLE�15�4 Sun Management Center Component and Module Default Privileges


	Overriding the Default Privileges
	To Override Default Privileges
	A
	Getting Started With Sun Management Center Software
	TABLE�A�1 Example Use of Sun Management Center Software�
	B

	Miscellaneous Sun Management Center Procedures


	Regenerating Security Keys
	To Regenerate the Security Keys
	1. Log in as root.
	2. Depending on your installation, type one of the following.
	3. Restart the Sun Management Center server.


	Configuring a Legacy SNMP Agent as a Subagent of a Sun Management Center Agent
	To Configure a Legacy SNMP Agent as a Subagent of a Sun Management Center Agent
	1. Log in as root.
	2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist, copy it from the /opt...
	3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x, find the block that is similar to th...
	4. Remove the comment symbol at the beginning of the line (#) so that the code now looks like the...
	5. Modify the lines as follows:
	a. Change sa2 to the unique subagent name for the agent.
	b. type is legacy.
	c. persist is false if the subagent is stopped when the Sun Management Center agent exits. If thi...
	d. snmpPort is the UDP port number on which you want to run the subagent.
	e. errorAction can be restart, ignore, or kill. If the restart option is used, then the Sun Manag...
	f. startCommand is the mandatory command to start the subagent. This command should contain %port...
	g. stopCommand is the command to stop the process. %pid can be used to represent the process ID (...
	h. pollInterval defines the time (in seconds) in which the Sun Management Center agent polls the ...
	i. pollHoldoff is the time (in seconds) after which the first poll is done on the subagent after ...
	j. oidTrees gives the space�separated list of SNMP OIDs managed by the subagent.
	k. snmpVersion can take values SNMPv1 and SNMPv2.
	l. securityLevel can be priv, auth, or noauth.
	m. securityName is the SNMPv1 community name or SNMPv2 security name to use.

	6. Stop then restart the agent:

	To Increase Agent Memory Size
	1. Become superuser on the agent host.
	2. Copy the file agent-stats-d.def to /var/opt/SUNWsymon.
	3. Edit the file as shown in the following example:
	4. To increase the agent memory size, increase the alarmlimit:error-gt to the desired value in th...
	5. Save the file and restart the agent.


	Configuring Sun Management Center Software to Use Different Port Addresses
	To Determine if a Port Is Used
	TABLE�B�1 Sun Management Center Default Port Addresses

	To Reconfigure Sun Management Center Software to Use Nondefault Port Addresses
	1. Run the es-setup script to create the domain-config.x and server�config.x (server configuratio...
	2. Edit these files with the new port numbers.

	To Reconfigure Sun Management Center SNMP Port Addresses
	1. Log in as root.
	2. Edit the domain-config.x file and change the address port to an unused port.
	3. Save the file.

	To Reconfigure Sun Management Center RMI Port Address
	1. Log in as superuser.
	2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.
	3. Search for the block which starts with rmiReceptor.
	4. Uncomment the line that reads property:rmiPort = 2099 by deleting the pound (#) character.
	5. Change the address port to a new unused port number.
	6. Save the file.


	Monitoring Topology Manager and Event Manager
	To Create a Server Component as a Monitored Object
	1. In the main console window, select Edit ‰ Create an Object.
	2. Click the Node tab.
	3. Click the Monitor Via button to see the pull-down menu, then select Sun Management Center Agen...
	4. Type the name of the server component in the Node Label field.
	5. (Optional) Enter a description of the node.
	6. Enter the name of the Sun Management Center server in the Hostname field.
	7. Type the port number for the server component in the Port field (FIGURE�B�1).
	8. Complete this procedure with one of the following actions:
	FIGURE�B�1 Creating a Server Component as a Monitored Object


	Topology Manager
	To Increase the Critical Threshold for the Virtual Size Data Property.
	1. Create the Topology manager monitored object.
	2. Open the Details window by proceeding with one of the following:
	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Double�click on the Agent Statistics icon in the contents view or single click in the expansio...
	5. Double�click on the PA Process Statistics folder icon in either the hierarchy or the contents ...
	FIGURE�B�2 PA Process Statistics Property Table

	6. Select the Virtual Size table cell, then proceed with one of the following:
	7. Click on the Alarms tab button.
	8. Type the desired value in the Critical Threshold (>) field.
	9. Complete this procedure with one of the following actions:
	FIGURE�B�3 Alarms Tab for the Virtual Size Property in the Topology Manager Object


	Event Manager
	FIGURE�B�4 Event Management Module Data Properties

	To Change the Default Values for Smart Delete in the Event Manager
	1. Create the Event manager monitored object.
	2. Open the Details window by proceeding with one of the following:
	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Select the Event Management module and proceed with one of the following:
	5. Type the new time values into the editable fields.
	6. Alternately, you may turn off “smart delete” by selecting Disabled in the pull�down menu next ...
	7. Complete this procedure with one of the following actions:
	FIGURE�B�5 Module Parameter Editor for the Event Management Module



	Reading Sun Management Center Log Files
	To Use ccat to Read Sun Management Center Log Files
	To Use ctail to Read Sun Management Center Log Files

	Sun Management Center Server Issues
	Hanging Main Console Window
	To Resolve a Hanging Main Console Window

	Adding Customized Menu Items
	To Customize the Tools Menu
	1. Using a standard text editor, add the following line to the /var/opt/SUNWsymon/cfg/console-too...
	2. Place the Java class files for the applications in the /opt/SUNWsymon/apps/ classes directory.
	3. Run the es-tool update script on the Sun Management Center server host.
	4. Stop the console by selecting File ‰ Exit from the menu bar on the main console window.
	5. Click the Exit button to exit the application.
	6. Restart the console for the application to be added to the Tools menu.


	SNMP MIBs for Sun Management Center Modules
	How to Use the Sun Management Center SNMP MIBs in a Third Party Management Station
	1. Preprocess the MIBs.
	2. Load the MIB.
	3. Use the MIB information to talk to the Sun Management Center agent.

	How to Access the Modules with Multiple Instances
	C
	Sun Management Center Software - Operating System Modules
	TABLE�C�1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’ Operation



	Operating System
	Directory Size Monitoring Module Version 2.0
	Directory Monitoring Status Table
	TABLE�C�2 Directory Size Monitoring Properties


	File Monitoring Module
	File Monitoring Status Table
	TABLE�C�3 File Monitoring Properties �


	MIB-II Instrumentation Module 1.0
	MIB-II System Group Table
	TABLE�C�4 MIB-II System Group Properties�
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	TABLE�C�5 MIB-II Interfaces Group Properties�

	MIB-II Interface Table
	TABLE�C�6 MIB-II Interface Properties�
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	MIB-II Group Table
	TABLE�C�7 MIB-II Group Properties�

	IP Address Table
	TABLE�C�8 IP Addresses Properties�

	IP Route Table
	TABLE�C�9 IP Route Properties�

	IP NetToMedia Table
	TABLE�C�10 IP NetToMedia Properties


	MIB-II ICMP Group Table
	TABLE�C�11 MIB-II ICMP Group Properties�

	MIB-II TCP Group Tables
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	TABLE�C�12 MIB-II TCP Group Properties�

	TCP Connections Table
	TABLE�C�13 TCP Connections Properties�


	MIB-II UDP Group Tables
	MIB-II UDP Group Table
	TABLE�C�14 MIB-II UDP Group Properties�

	UDP Table
	TABLE�C�15 UDP Properties



	Kernel Reader Module 2.0
	TABLE�C�16 Kernel Reader Alarm Thresholds�
	User Statistics Table
	TABLE�C�17 User Statistics Properties�

	System Load Statistics Table
	TABLE�C�18 System Load Statistics Properties

	Disk Statistics Managed Objects Tables
	TABLE�C�19 Disk Statistics Parameters�
	Disk Details Table
	TABLE�C�20 Disk Details Properties�

	Disk Service Time Table
	TABLE�C�21 Disk Service Time Properties�


	Filesystem Usage Table
	TABLE�C�22 Filesystem Usage Properties�
	FIGURE�C�1 Probe Commands for Filesystem Usage

	CPU Statistics Managed Object Tables
	CPU Utilization Table
	TABLE�C�23 CPU Usage Properties�

	CPU Process Table
	TABLE�C�24 CPU Process Table

	CPU I/O Table
	TABLE�C�25 CPU I/O Properties�

	CPU Interrupts Table
	TABLE�C�26 CPU Interrupts Properties

	CPU Syscalls Table
	TABLE�C�27 CPU System Call Properties�

	CPU Misc Table
	TABLE�C�28 CPU Miscellaneous Properties�

	CPU Regwindow Table
	TABLE�C�29 CPU Regwindow Properties

	CPU Pageinfo Table
	TABLE�C�30 CPU Pageinfo Properties�

	CPU Faults Table
	TABLE�C�31 CPU Faults Properties�


	Memory Usage Statistics Table
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	Swap Statistics Table
	TABLE�C�33 Swap Statistics Properties

	Streams Statistics Managed Objects Table
	TABLE�C�34 Streams Statistics Managed Objects
	TABLE�C�35 Streams Statistics Table Properties�

	Software Rules Table
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	NFS Statistics Module Version 2.0
	RPC Information Table
	TABLE�C�37 RPC Server and Client Information Properties

	NFS Information Table
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	Solaris Process Details Module Version 2.0
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